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1 Introduction

1.1 Outline
Using the Projector Management Application allows you to use a single computer to control diagnose and monitor
multiple projectors that are connected to the network or via an RS-232C cable.

1.2  System

The following diagram shows a typical network diagram for the Projector Management Application.

RS-232C
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LAN LAN
LAN LAN Ethernet
/ RS-232C
Converter
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» Use a UTP cable category 5 or higher for a Local Area Network cable.
» Use a cross type cable when using a RS-232C serial cable.



2 Installation

2.1 System Requirements

The following are the minimum system requirements of hardware and software to use the Projector Management
Application.

(1) Operating System
Windows 2000 Professional
Windows XP Home Edition (32-bit)
Windows XP Professional (32bit)
Windows Vista Home Basic (32-bit)
Windows Vista Home Premium (32-bit)
Windows Vista Business (32-it)
Windows Vista Ultimate (32-bit)
Windows Vista Enterprise (32-bit)
Windows 7 Starter (32-bit)
Windows 7 Home Basic (32-bit)
Windows 7 Home Premium (32-bit)
Windows 7 Professional (32-bit)
Windows 7 Ultimate (32-bit)
Windows 7 Enterprise (32-bit)

(2) CPU
Pentium3 500MHz or higher

(3) Memory
256MB or higher

(4) Hard disc
Minimum 20MB free space for installation

(5) Local Area Network port (RJ-45) or Serial port (RS-232C)



2.2  Projector Management Application Installation
The following describes the installation process for the Projector Management Application:

(1) Double click the file “Setup.exe”.

(2) Select the language (English, Japanese or Chinese [Simplified]) EEEEERTIIIELEIEES
during the installation process. And then click [OK]. g Select the language for the instalation from
i the choices below.

(3) Click [Next] Projectar Masagsment Applicatian - Instaltibietd Wirasd 3
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(4) Read “License Agreement” and select “I accept the term of the e LRIl -
license agreement” and click [Next] if you agree the license Finaun e e s e e ekl 4
agreement. Otherwise, click [Cancel] and stop the installation.
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(5) Confirm the program folder, and then click [Next]. e ———— B
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(6) Confirm the install folder and program folder again, and then click
[Next].
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(7) Click [Finish] to complete the Projector Management Application
setup wizard.
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3 Operating Instructions

3.1 Create login accounts

The Projector Management Application requires a login name and password to launch the software. The Projector
User Administration Tool helps you to create new user accounts.

3.1.1

Double Click “PJUsrEdit.exe” that is located on same folder
that you installed Projector Management Application.

It automatically launches the Projector User Administration
Tool, if no user accounts are created yet. Also Projector
Management Application has a short cut [File] - [User
Configuration] to launch Projector User Administration Tool.

How to launch

EoX)

Projector User Administration Tool
Fil=  Edit

User Mame
a Adrnin

a User

| Description | Man | Ch | Img | FTP |

Adrrinistrakar

3.1.2 How to exit

Select [File] > [Exit] from the menu or click [x] bottom of the top right corner. If the changes are made, you will be
required to confirm the changes.

3.1.3 Main Window

Eo&X

Projector User Administration Tool

Menu -File Edit
User Mame | Descriptian | Ian | Ctrl | Irng | FTP |
a Adrmin Adrninistrator
a User
User List
(1) Menu
Menu Sub Menu Description
File Save Save user data
Exit Exit
Edit Add New User Create new user
Change User Edit user account
Delete User Delete user account

(2) User List

The status in the User List is described below.

Row name Description
User Name Username (ID)
Description Comment
Man “e” shows that the user can access to the PJMan (Projector Management Application).
Ctrl “e” shows that the user can access to the PJCtrl (Projector Control Tool).
Img "e” shows that the user can access to the PJImg (Projector Image Tool).
FTP “e” shows that the user can access to the PJTransfer (Projector File Transfer Tool).




3.1.4 Creating new user account

Select [Edit] > [Add New User] or rights click on the user list and  [FFFI Ry X
select [Add New User]. The following dialog window appears. —
User Mame: |
User --- Define user name, up to 20 characters escrpton: |
Description --- Add comments, up to 50 characters _
User Rights - Define accessibility. It defines the B A EManagement Application _ 3elect Al
accessibility for the application software Cantrel Application
by each user account. The user can use EIF?:QT.:;Z?LNM sl |
allocation only marked application
software. £ 2
Select All --- Select all application software.
UnSel All --- Unselect all application software.

Press [OK] button after entering user name. The [Change
Password] dialog appears. Enter new password and confirm entered _
password. The password is up to 20 characters and case sensitive. Sl P

|

Mew Password: |

Tew
Password(Re-Type): |

Cancel

3.1.5 Edit user account

Doubile click a username on the user list or select [Edit] > [Change

User] after choosing user to open edit dialog. You can edit username,
description and accessibility (user rights). User Name: | Admin

Click the button to change password. Enter old and new password,
and re-enter new password to confirm.

Description; | Adrinistrator

User Rights:
=er Right= Management Application Select Al
[¥ ontrol Application Ursed Al
[¥ Image Tool e

File Transfer Tool

< ?

Change Password. ..
Cancel

Change Password

0ld Password: |

Mew Password: |

Mew
Password(Re-Type): |

Cancel

3.1.6 Delete user account

Select [Edit] > [Delete User] or rights click on the user list and select [Delete User]. The confirmation window will
popup.

3.1.7 Save user account

Select [File] > [Save]. The data is stored in the file, “C:\Program Files\Common Files\Projector
Tools\config\UserList”.



3.2  Start Application

Select Windows [Start] - [Program] - [Projector Tools] - [Projector
Management Application]. The login window will then appear.

Enter the username and password that was created by “Projector User
Administration Tool". After logged in, the following window will appear.

+i+ Projector Management Application

Projector Tools Login

User ID: |

Password: |

=]

Cancel |

X

File Edit ‘Wiew Control Schedule OCption Help
k7 > 7
- E Skatus
+ {2 Praojector
< >

3.3  Quit Application
Select [File] - [Exit] to quit

It is also possible to quit this software by clicking [x] on the top right corner of the window.

When the confirmation dialogue appears, select [Yes] to finish.
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3.4
(1)

Main Screen

Menu

Menus and Functions in the Main Screen are shown below.

Menu Sub Menu Function
File Import Load the projector configuration file.

Export Save the projector configuration file.

User Configuration Launch Projector User Administration Tool.

Output Report Create the report.

Log Log on / off.

Log Report Create the log data report.

Exit Quit this application

Edit Add Group Add Group.

Add Projector Add projectors which user is going to manage.

Discovery Discover projectors.

Delete Delete the projectors or groups that are selected from tree.

Edit Edit the registered information of the projectors or groups that
are chosen from tree.

Cut Cut the selected projector on the tree view.

Copy Copy the selected projector on the tree view.

Paste Paste projectors.

Alarm Time Settings Set / Edit the period of the lamp and filter hours reminder.

View Refresh Refresh the status of the projectors or groups that are chosen
from the tree

Search Edit the search query.

Schedule Select on / off for the Schedule view

Control Projector Control Control the selected group of projector, or the selected
projector.

Power ON Power ON the projectors which are selected from the tree, or
the projectors which belong to a group which is chosen from the
tree.

Power OFF Power OFF the projectors which are selected from the tree, or
the projectors which belong to a group which is chosen from the
tree.

Display Image Select e-SHOT image to display.

Execute Command Control User-defined model.

Filter Message Change filter message setting.

Schedule Edit Edit the Schedule settings.

Start Start Schedule execution.

Stop Stop Schedule execution.

Option Status Check Interval Set the Status Check Interval.

Mail Settings Configure the Mail Settings.

Send Image Transfer e-SHOT image to projectors.

Edit User-defined Model Edit User-defined model information.

Access Projector via HTML Open the internal HTML page with default Internet browser.

Send Messenger data Transfer Messenger data to projectors.

Run PJMessengerLite Launch PJMessengerLite application.

Help About Projector Displays the version of this application.

Management Application

11




(2) Toolbar
The functions of these icons correspond with the menus as follows:

Icon Menu

T [Edit]|-]Add Group]

[Edit]-[Add Projector]

[Edit]-[Delete]

[Edit]-[Edif]

[Edit]-[Cut]

[Edit]-[Copy]

[Edit]-[Paste]

[View]-[Refresh]

[Control]-[Power ON]

[Control]-[Power OFF]

[Schedule]-[Start]

[Schedule]-[Stop]

<5 m| v £ 3o B < RIE]

[Help]-[About Projector Management Application]

12



(3) Status Group
PJMan provides two pre-defined projector views, and the flexible views that are based on the search queries.

(a) All Projectors View
Shows the list of all projectors that are defined in the PJMan software.

(b) Error/ Warning View
Shows the list of projectors that are ONLY in Error or Warning state.
(c) Find Result View

Shows the multiple lists of projectors based on the given search queries (described in a later section).

41 Projector Management Application

File Edit W¥ew Control Schedule Option Help
v | "% G ?
-8B Status #| | Projector Hame Model Connection | Powwer | Input | status | Lamp Time [ Fiter Time [~
= ] i Y advanced Prese.., | ¢ or oll Lo Disconnect
k= E"Drﬂ:\’:m'”lt BfCorference P123  CP-%2510M  127.0.0.1:10.., STANDEY  Computerinl  Mormal 1083 h 2296 h
<
= ;:"D]e:::: esu B Corference P345  CP-X3010N  127.0.0.1:10... STANDBY  S-Video Mormal 1053h @33 h
-

o5 Building A jice-x1250 CP-¥1250 127.0.0.1:10.., STAMDEY  RGE Morrnal 2313 h 2199h
oy == Bjicp-xz0i0m CP-%206 127.0.0.1:10...  OM Computer!  Hormal 983 h 549 h
=] 2za Meeting Rooms

=17 Firet Floor BjiCP-42010n Dulane  CP-2010M  127.0.0.1:10...  ON S-ideo Mormal 981 h 303 h
& Telcom BJICP-x2010M SMP,.,  CP-5245 127.0.0.1:10...  OM video Mormal 102 h 158 h
R Telcom 1 Rjicr-xaes CP-X265 127.0.0.1:10... QM S-ideo Mormal 162 h 1872 h
g Telcom 2 Gy CP-%2010M ) Disconnect
= 72| Second Floor BJIor, Rew CP-%255  CP-%255 127.0.0.1:10...  OM RGE1 Mormal 1342 h 1256 h
=32 3rd Level BivR Cp-za17 CP-%417 127.0.0.1:10... STANDEY  Computerl  Mormal 1312 h 2090 h
g cP-%2010n Dulane §j/Raom G10003 CP-a100 127.0.0.1:10... OM Computer!  Hormal 2947 h 2350h
§j cP-x1250 BjIroom 510004 CP-A100 127.0.0.1:10...  OM S-ideo Mormal #5th 2970 h
. | MR CP-x417 Broom G1o00S CP-a100 127.0.0.1:10,,.  STAMDEY  Computerl Harmal 2470 h 530 h
=22 Building B BjIRoom Hi0D16 CP-a100 127.0.0.1:10... STANDEY  Computerl  Mormal 1130h 2715 h
| cp-x2a108 Bfroom H10017 CP-4100 127.0.0.1:10... STAMDBY  Computerl  Mormal 1589 h 1647 h
—_ @_I;P'XZE‘S Bjlroom H10D15 CP-%2010M  127.0.0.1:10... OM S-ideo Mormal 1057 h 2643 h
Iz B C'Tg CR BRaom 110019 CP-2010M  127.0.0.1:10... STAMDBY  Computerinl  Mormal 2501 h azh
e @asgo;f"; - Bjroom 110020 CP-¥2O1ON  127.0.0.1:10... ON S-viden Normal 1264 h 415 h
@i Room G10004 @Room 110021 CP-%2010M 127.0.0.1:10,,, ©OM Computer inl  Mormal 613 h 1067 h
&) Room G10005 Bjlroom 110022 CP-%2010M  127.0.0.1:10... OM S-ideo Mormal %43 h 1326 h
Room 110023 CP-%2010M  127.0.0.1:10... STAMDBY  Computerini  Morma 357 525
[ Room H10016 ' h b
Qom - L0 LI amputer in armal
Room H10017 Room 110024 CP-¢20l0N  127.0.0.1:10... ON Computer inl  Hormal 1703 h 180 h
B Room H10018 BjlRoom k10025 CP-%2010M  127.0.0.1:10... OM S-ideo Mormal 1104 h 2564 h
@i Room 110019 @Room k10026 CP-x2010M 127.0.0.1:10... ON Computer inl  Mormal 338 h 2605 h
[j) Room 110020 BlRoom k10027 CP-%2010M  127.0.0.1:10... STAMDBY  S-video Mormal 71zh 439 h
B Room 110021 jraom 10028 CP-%2010M  127.0.0.1:10... STAMDBY  S-video Mormal s21h 2367 h
j) Room 110022 BjlRoom L10029 CP-%2010M  127.0.0.1:10... STAMDBY  Yideo Mormal 2730 h 584 h 2
o oo ¢ >
B Room K10025 ~
B Room K10026
B Room K10027 v v
Projector Name --- Displays the projector name.
Model --- Displays the model name.
Connection --- Displays the connection information.
(IP address and MAC address / COM port)
MAC Address --- Displays the MAC address.
Power --- Displays the power status (ON / STANDBY).
Input --- Displays the input source.
Status --- Displays the error status.
Lamp Time --- Displays the current lamp time.
Filter Time --- Displays the current filter time.
Total Run Time --- Displays the total run time.
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(d) Projectors Group View

Shows the list of groups and projectors in the selected group.

41 Projector Management Application

File Edit Wew Control Schedule

) % | *8

Option  Help

» ?

“e

= E Status

e Al Projectors

e ErrorfWWarning

s Search Result
v

EBuilding &

=7 Meeting Rooms
|24 First Floor

@i Telcom
@i Telcom 1
@i Telcom 2

=72 Second Floor
I 2= 3rd Level
g cP-%2010n Dulane
g cr-x1250
) MR CP-r417
|74 Building B
g CP-#2010M
g cr-xzes
—|- 724 Building C
I 7= Class Rooms
1§ Room 510003
B Room G10004
B Room G10005
B Room H10016
1B Room H10017
B Room H10015
B Room 110019
8 Room 110020
B Room 110021
8§ Room 10022
B Room 110023
B Room 10024
B Room K10025
B Room K10026
B Room K10027

¥

= 224

-

Group Mare Projector

Conkains 32 Projectors, 10 Groups

Cornrment Projector Rook

Projector Name IModel Connection | Power Inpuk Status Larnp Tirme Filter Time Tok

e Building &
e Building B
e Building ©
Conference P123  CP-¥2510M  127.0.0.1:1... STANDBY Computer inl  Mormal 1083 h 2296 h ZRE
@CDnFerence P345  CP-X3010M 127.0.0.1:1...  STANDBY S-Video Marmal 1053 h 833h 53E

< *

-

Schedule List 6/9/2009 7:23:0Z PM

Projectorf . . . W

Group Name
Contains
Comment

Projector Name

Model
Connection
MAC Address
Power

Input

Status

Lamp Time
Filter Time

Total Run Time

Displays the group name.
Displays the number of projectors and groups in the group.
Displays the comment.

Displays the projector name.

Displays the model name.

Displays the connection information.

(IP address and MAC address / COM port)
Displays the MAC address.

Displays the power status (ON / STANDBY).
Displays the input source.

Displays the error status.

Displays the current lamp time.

Displays the current filter time.

Displays the total run time.
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(e) Individual Projector View

Shows the status of selected projector.

41+ Projector Management Application

B &8 & B %[ "8 Ge

File Edit W¥iew Control Schedule Option Help

= ﬂ Status A
= Al Projectors
e ErrorfWarning
+-7e Search Result
SR Projector
|- 72s Building &
= a_a_n; Meeting Rooms
|24 Firsk Floor

@i Telcom
@i Telcom 1
@i Telcom 2

=72 Second Floor
7= 3rd

g cp-x1250
B MR CP-x417
| 7= Building B
§j cr-xz010M
g cr-xzes
=724 Building C
I Class Rooms

18 Room G10003
B Room G10004
) Room 510005
[8)) Room H10016
8 Room H10017
) Room H10018
&) Room 110019
§)) Room 110020
) Room 110021
§)) Room 10022
§) Room 110023
§)) Room 10024
[Bj) Room K10025
B Room K10026
B Room K10027
) Room L10028
i) Room L0023 %

> %
Projector Mame CP-%2010n Dulane
Model CP-x2010M
Comment Dukane Demo - Pat's Lnit
| Projector Name | Model | Connection | Pawer Inpuk Status | Filker Time | Total F
@CP-XZDIDH Dulane  CP-x2010M 127.0.0.1:1...  ON S-yideo Mormal 393 h 2930t
< ¥
Schedule Lisk 6/9f2009 7:23:44 PM
Projector/Building AfMeeting RoomsSecond Floor/3rd Level/CP-%2010n Dulane
| Date | Time | Cankral
| A

Projector Name
Model
Comment

Projector Name

Model
Connection
MAC Address
Power

Input

Status

Lamp Time
Filter Time

Total Run Time

Displays the projector name.
Displays the model name.
Displays the comment.

Displays the projector name.

Displays the model name.

Displays the connection information.

(IP address and MAC address / COM port)
Displays the MAC address.

Displays the power status (ON / STANDBY).
Displays the input source.

Displays the error status.

Displays the current lamp time.

Displays the current filter time.

Displays the total run time.
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(4) Schedule View

(a) For a group of projectors

Projector Management Application

File Edit W¥iew Control Schedule Option Help
T N L3 %
=-fB Status -
e Al Projectors Group Mame Class Rooms
ErrorWarning _ | B Eratted &
+- = Search Resulk Contains ’ rojectars, 1 taroups
= 2xn P_r_?]'ECtUF Carmment East Wing
—|- 22s Building A
=8 Efelt:l.ngtilooms | Projector Mame Model Connection | Power Input Status Lamp Time Filter Time Total Run
=l 2xs FIFS (alu]g
@i Telcom @Room G10003 CP-A100 127.0.0.1:1... ON Computerl Mormal 2947 h 2350 h 2007 h
& Telcom 1 Bjiroom G10004 CP-A100 127.0.0.1:1...  ©ON S-Videa Mormal 251h 2970 h 833 h
R Telcom 2 Bjroam G10005 CP-A100 127.0.0.1:1...  STANDBY Computerl  Normal 2470 h sa0h 390 h
./ Second Flaor Broam H10016 CP-A100 127.0.0.1:1...  STANDBY Computerl  Normal 1130h 2715h 2633 h
2 ard Level Bjroam H10017 CP-A100 127.0.0.1:1...  STANDBY Computerl  Normal 1589 h 1647 h 1351 h
§j) CP-%2010n Dulane Bjroam Hi0018 CP-¥2010M  127.0.0.1:1... ON S-Videa Mormal 1057 h 2643 h 445 h
g cp-x1250 Bfjroom 110013 CP-¥2010M  127.0.0.1:1...  STANDBY Computerinl  Normal 2501 h 9zh 788 h
B MR CP-x417 Broom 110020 CP-%2010M  127.0.0.1:1... ON S-Videa Mormal 1264 h 418h 2225 h
=1 2xa) Building B @Room 110021 CP-¥2010M  127.0.0.1:1... ©OM Computer inl  Mormal 615 h 1067 h 2279 h
[§j cp-xz010H Bjroom 110022 CP-¥2010M  127.0.0.1:1... OM S-Yiden Mormal 948 h 1326 h 2058 h
_ @ C_P-X255 Bfroom 110023 CP-xz010M  127.0.0.1:1...  STAMDBY Computerinl  Mormal 387 h 525h 886 h
= Building C Bjroom 110024 CP-%2010M  127.0.0.1:1...  ON Computer inl  MNormal 1703 h 180 h 1121 h
s Bfroom k10025 CP-¥2010M  127.0.0.1:1... ON S-videa Mormal 1104 h 2564 h 234 h
& Emm gigggi Broom k10026 CP-%2010M  127.0.0.1:1... OM Computer inl  Narmal a8 h 2605 h 1063 h
oom
R Room 610005 BPRoom k10027 CP-¥2010M  127.0.0.1:1... STANDBY S-Videa Mormal 712h 483 h 2641 h
&) Room Hioo1s Bjroom L1028 CP-¥2010M  127.0.0.1:1...  STANDEBY S-Videa Mormal 521 h 2367 h 1968 h
&) Room Hio017 BProom L10029 CP-¥2010M  127.0.0.1:1... STANDBY Video Marmal 2730h 534 h 2413h
&) Room H10018 Bjroom L10030 CP-¥2010M  127.0.0.1:1...  STANDEBY S-Videa Mormal 1976 h 2205 h 2167 h
Bj) Room 110019 -
[} Room 110020 |Current Date & T|me|
&y RW“’] Group Path | [ 2
@i Room
&) Room 110023 Schedule List 6/9/2009 7:27:53 FM
@i Raorn 110024 Projector/Building </Class Rooms)
) Room K10025 -
@i Raom K10026 Date | Time | Contral
Daily 15:15 Power OFF
Room K10027
% R°°m 100 Dy 0:00 Fower ON
Qo Daily 05:05 Input RGELCamputerl
% Raom L10023 Daily 05:15 Displary Image-1
Roomn L10030
| 1ea Labs
I8 CP-x2010N SHP1 #03 b
Group Path ---  Shows the full path name of selected group.
Current Time Displays the current date and time.
Date --- Displays the activation date.
Time --- Displays the activation time.
Control --- Displays the execute command.
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(b) For an individual projector

+ Projector Management Application

File Edit Yew Control Schedule Option Help

¥R o$ %8 Gel > ?
|- 723 Building & >
5 7 Meeting Rooms Projector Mame ¢ Room G10003
—|-{ 22 Firsk Floor © o CP-AL00
@i Telcom Madel I )

@i Teleom 1 Comment

@F Telcom 2

)72 Second Floor
=122 3rd Level
g cP-¥2010n Dulane
lgjj) cP-x1250
B MR CP-x417
7= Building B
§j cP-xzo1om
g Cp-xzes
|7 Building C
=724 Class Rooms

| Projector Mame Model Connection | Power Input | Status | Lamp Time | Filter Time | Total Run
@Room 10003 CP-A100 127.0.0.1:1...  ©ON Camputerl Mormal 2947 h 2350 h 2007 h

Room G10003
B Room G10004
B Room G10005
| Room H10016
& Room H10017
) Room H10018
B Room 110019
B Room 110020
B Room 110021
) Room 110022
B Room 110023

) Room 110024 -
Bj) Room k10025 |Current Date & Tlme|

% roo| Projector Path - ?

) Room L10028
8 Room L10029
[ Room L10030
|- 72 Labs
Q) CP-42010N SMPL#D3
8 Dr. Rew CP-x255
B Building D
Conference P123

| Corference P345

Schedule List 6f9/2009 7:31:16 PM
Projector JBuilding C/Class RoomsRoom G10003

Date | Tirmne | Contral

Daily 20:25 Power O

Draily 20:30 Display Image-2
Daily 20:45 Power OFF

¥

Group Path ---  Shows the full path name of selected projector
Current Time Displays the current date and time.

Date --- Displays the activation date.

Time --- Displays the activation time.

Control --- Displays the execute command.
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3.5 Add a group of projectors

You can define a group of projectors into the tree view. Select [Edit] > [Add Group] to add a group.

Group Name --- Enter a group name up to 256 characters.
Comment --- Enter a comment up to 256 characters.

Add Group

Group Mame: |

Camment |

’Tl Cancel
Note: The maximum depth of sub groups is five levels.
3.6  Add an individual projector
You can define an individual projector into the tree view. Select [Edit] > _
[Add Projector] to add a projector. Prapacher his. |
] [mct =l k] Mesded...
Comment [
Connection
e
Phddass | 192 L 6 . 1 . 80 Descoveny.,
Mwa;mn;vaswd [
W ShahiE Chack
Lamp Mam Tine b n
Filter tisrm Trves b~ n
e
Projector Name --- Enter a projector name up to 256 characters.
Model --- Select a model.
Add Model --- Add new User-defined model. Please see the section 3.20 for details.
Comment --- Enter a comment up to 256 characters.
Connection --- Select a connection method.
RS-232C --- Select when using RS-232C, and set COM Port.
NETWORK --- Select when using network, and set IP Address and Port No

> Network Port No. of CP-X443, CP-X445, CP-X1200, CP-X1250, and CP-SX1350 is

23.

> Network Port No. of CPX2, CPX4, CP-DW10N, CP-A100, CP-AW100N, CP-X205,
CP-X206, CP-S245, CP-X255, CP-X256, CP-X265, CP-X268A, CP-X305,
CP-X306, CP-X308, CP-X417, CP-X467, CP-X505, CP-X605, CP-X608, CP-X615,
CP-WX625, CP-SX635, CP-X705, CP-X807, CP-X809, CP-X2010N, CP-X2510N,
CP-X3010N, CP-X10000, CP-WX11000, CP-SX12000, ED-A100, ED-A110,
ED-AW100N, ED-AW110N, ED-D10N, ED-D11N, ED-X8255 is 23 or 9715.

»The authentication of commands is available for CPX2, CPX4, CP-DW10N,
CP-A100, CP-AW100N, CP-X205, CP-X206, CP-S245, CP-X255, CP-X256,
CP-X265, CP-X268A, CP-X305, CP-X306, CP-X308, CP-X417, CP-X467,
CP-X505, CP-X605, CP-X608, CP-X615, CP-SX635, CP-X705, CP-X807,
CP-X809, CP-X2010N, CP-X2510N, CP-X3010N, CP-X10000, CP-WX11000,

CP-SX12000, ED-A100, ED-A110,
ED-D11N and ED-X8255.

ED-AW100N, ED-AW-110N, ED-D10N,

»The authentication of e-SHOT feature is available for CP-DW10N, CP-A100,
CP-AW100N, CP-X205, CP-X206, CP-S245, CP-X255, CP-X256, CP-X265,
CP-X305, CP-X306, CP-X505, CP-X605, CP-X615, CP-WX626, CP-SX635,
CP-X705, CP-X2010N, CP-X2510N, CP-X3010N, CP-X10000, CP-WX11000,

CP-SX12000, ED-A100, ED-A110,
ED-D11N and ED-X8255.

ED-AW100N, ED-AW-110N, ED-D10N,

» The password for the both authentications above is common.



[Discovery]

Status Check

Lamp Alarm Time

Filter Alarm Time

User can search for the projector (CPX2, CPX4, CP-DW10N, CP-A100,
CP-AW100N, CP-X205, CP-X206, CP-S245, CP-X255, CP-X256, CP-X265,
CP-X268A, CP-X305, CP-X306, CP-X308, CP-X417, CP-X467, CP-X505, CP-X605,
CP-X608, CP-X615, CP-WX625, CP-SX635, CP-X705, CP-X807, CP-X809,
CP-X2010N, CP-X2510N, CP-X3010N, CP-X10000, CP-WX11000, CP-SX12000,
ED-A100, ED-A110, ED-AW100N, ED-AW110N, ED-D10N, ED-D11N, ED-X8255)
when it is connected to the network.

Check the check box if you want to enable the status polling. If it is not checked, the
projector is ignored from the status check process and won’'t show up in the status
list. It is registered in PJMan, but it excludes from the current status monitoring list.
Define the lamp alarm / reminder period. The setting is effective for individual
projector. If you don’t want to enable this function, please set 0 hours.

Define the filter alarm / reminder period. The setting is effective for individual
projector. If you don’t want to enable this function, please set 0 hours.

The discovery feature allows you to search projectors on the network automatically. The discovery works when
you are selecting a group or root. Select [Edit] = [Discovery] from the menu. The discovery window is shown below.
Click start button to begin the discovery process.

DiEC owery

3

3]

DiEC owery

1P Addrass | MBC Addrass

[~ Specilfy o acicress range ancd ssanch,

ok e

1P Addrass
192.16R.1.10

| MAC ddrass | Projector Mame |

Oi-0-E7-F3-00-F4

| Projesctar Mg |

[~ Specilfy o acicress range ancd ssanch,
Bt ekl

NENRRNENNRNNENNNRENNENREN]
DISCOVERY Corplete

Erul clhraii Erul sxilress

For searching certain IP address range, please specify the IP address range to enter Start and End address, and
then check the checkbox "Specify an address range and search” and click the [Start] button. It will take several
minutes depending upon the number of IP addresses needed to be scanned.

DiEC owery

3]

3]

DiEC owery

IF Addrass | MAC Address

F Specily o address range and seanch,

ok skbei | 19T | 168 1.1

IF Addrass
192.16R.1.10

| Ma Addrass | Projector M N

| Privjector Mg N

F Specily o address range and seanch,
Bt ekl 192 . 68 i .1

NENRRNENNRNNENNNRENNENREN]
DISCOVERY Corplete

e . Erul sxilress e .

Erul clhraii

= |
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When discovery finds projectors, the list of projectors is
shown and [Register] button becomes available. You can
register multiple projectors at the same time.

When the [Register] button is clicked, the projector is
added under the group or root that you have selected. The
projector name and model is automatically assigned.
Please edit the name and model as needed.
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[NOTE]
Windows Security Alert will be shown on your display when the discovery function activates, if Windows Firewall
is “On” (Windows XP SP2 or later). Please choose “Unblock” to add the software onto the exception list. Other
firewall security software may block the discovery function. In that case, please add the software to the safe list or
disable firewall software when you use discovery function.

3.7  Delete a group or individual projector

You can delete a group of projectors or an individual projector. Click a group or projector in the tree view, select
[Edit] > [Delete]. You can also delete a group or projector by clicking the delete icon on the toolbar. When the
confirmation dialogue appears, select [OK] to delete.

3.8  Change a group or individual projector settings

You can change a group or individual projectors settings. Click a group on the tree view, select [Edit] > [Edit]. Or
Click a projector, select [Edit] = [Edit]. You can also change settings by clicking the edit icon on the toolbar.

- The ‘Edit Group’ or ‘Edit Projector’ screen is shown below. Content to be set is same as ‘Add Group’ or ‘Add
Projector’ screen.

Edit Group Edit Projector E|

Projector Mame | S [ERda)
Group Name )
Model CP-%206 - Add Model,..
Sonpert (Groupt Cormment [serial No. 123456
Caonnection
QK | Cancel |
" R5-232C

+ NETWORK

IPaddress | 127 . 0 . 0 .1 Discovery...
Part Mo, 10000 -
Authentication Passwaord

¥ sStatus Check

Lamp Alarmm Time 0 h
Filter &larm Time u h

Ok | Cancel

3.9 Copy

You can copy the projector from the tree view. Select [Edit] > [Copy] on the menu after choosing a projector from
the tree view. You can paste copied projectors by selecting [Edit] > [Copy] from the menu or click the “Paste” button
on the tool bar.

Also you can copy projectors by drag and drop by holding down Ctrl key. Note that you cannot copy projectors if
the name is the same of the destination projector.

3.10 Move

You can move projectors in the tree view. Select [Edit] - [Cut] on the menu or click “Cut” on the tool bar after
choosing projectors on the tree view. You can paste copied projectors by selecting [Edit] > [Copy] from the menu or
by clicking the “Paste” button on the tool bar.

You can also drag and drop projectors onto another projector group.
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3.11  Applying alarm / reminder settings to projectors in a group

You can set alarm / reminder settings to multiple projectors in a group at the same time. Select the group that you
want to set the alarm / reminder for and then select [Edit] > [Alarm Time Setting] from the menu. The Alarm Time
Settings dialogue will appear. Check the checkbox and enter the hours that the alarm / reminder will be activated.

If you apply new settings to the group, the individual alarm / reminder setting on each projector will be overwritten.

Alarm Time Settings

[ Filker Alarm Time h

ok | Cancel |

3.12 Update Status

Select [View] > [Refresh] to update status of a group or individual projector. This function only works when the
status tab is displayed.

3.13 Search queries (in Status view)
In order to make the search queries, select [View] > [Search] from the menu. The Search dialogue will appear.

Search §|

* Connection; |RS-232C ﬂ

1P Address | - |

" Power ’—_|
7 Status ’—_|
" Lamp Time l— hours or more
" Filcer Time l— hours or more
" Total Run Time l— hours or more

" all or part of the projector name |

Search | Cancel |

Connection --- Search by connection type

IP Address --- Search by IP address range

Power --- Search by projector power status

Status --- Search by error / warning status

Lamp Time --- Search by lamp hours

Filter Time --- Search by filter hours

Total Run Time --- Search by total operation hours

All or part of the projector name --- Search by projector name

The search group will be added to the Search Result tree, when you press [Search] bottom with given query. The
list of projectors that are matched with your search query will be shown in the Status View.
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3.14 Control the projector

Select [Control] - [Projector Control] to control the projector. The controllable functions will be depending upon
what group or projector is selected.

(a) In case of All Projectors selected

Propctor Gantral (A1 Propector s}

Power --- Turn on / off power for a group of projectors.
Input Source --- Change input source.

Whisper --- Change Whisper / Eco mode.

Blank --- Change blank on / off.

Mute --- Change sound mute status.

Freeze --- Change freeze status.

Display Image --- Select e-SHOT / MY IMAGE to display / OFF.
Messenger ---  Select Messenger to display / OFF.

(b) In case of Error/ Warning selected

Propctor Gontral (Error S Warnened

Power --- Turn on / off power for a group of projectors.
Input Source --- Change input source.

Whisper --- Change Whisper / Eco mode.

Blank --- Change blank on / off.

Mute --- Change sound mute status.

Freeze --- Change freeze status.

Display Image --- Select e-SHOT / MY IMAGE to display / OFF.
Messenger --- Select Messenger to display / OFF.

23



(c) In case of Search Result item selected

Peees : [E -
IrgutSource ¢ [RGBY)Comguterl v
Whisper i e |
Elank E Uff—'J
Mus off =l
Fresm Hcrrd =l
Cesplay Image: [ =
i it =l
Power --- Turn on / off power for a group of projectors.
Input Source --- Change input source.
Whisper --- Change Whisper / Eco mode.
Blank --- Change blank on / off.
Mute --- Change sound mute status.
Freeze --- Change freeze status.
Display Image --- Select e-SHOT / MY IMAGE to display / OFF.
Messenger ---  Select Messenger to display / OFF.

(d) In case of a group selected

Propctor Gantrol (roupl

Grings Il ormation

GroupMame @ Frojech

Conkaing 12 Projecions, 5 Goups

e, o Prapechor Foot
Fore : T -|
Ingit Source ¢ [repComgters  w|
Whisper : fea =]
Dark: i fou |
Mute T |
Fresze : fea =]
Dusplay Image lrssuges- CFF =l
Messenoer Ff -

[ ]

Group Information

Group Name Displays the group name.

Contains --- Displays the number of projectors and groups in the group.
Comment --- Displays the comment.

Power --- Turn on / off power for a group of projectors.

Input Source --- Change input source.

Whisper --- Change Whisper / Eco mode.

Blank --- Change blank on / off.

Mute --- Change sound mute status.

Freeze --- Change freeze status.

Display Image --- Select e-SHOT / MY IMAGE to display / OFF.

Messenger --- Select Messenger to display / OFF.
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(e) In case of an individual projector is selected

Propctor Goantrol (Projectar)

Prispection Tidimrmalion

Frojector Name @ Frojechor]

ol 1 CPEEOLON

Commert; : Serial Mo, 156
Pivres W =|  egeness I ;| o+
Treut Source Computer il v Conkrast ~re l.
gt E F Ehaphess IT «|
Ko Mode i [heamal = color -l ]
Merar hormal | L[
Bland CH - Butn Adwet E Execute |
Mute oFF | e Tine Raset Fupide
Frerse ol w|  Filer Timn Reset T Eescute
Cisplay Image Irfudges-Cf - Ahvanuied Control
Meisiger FE - . — I

Projector Information

Projector Name  ---

Displays the projector name.

Model --- Displays the model name.
Comment --—- Displays the comment.
Power --- Turn on / off power for a group of projectors.

Input Source -

Change input source.

Aspect Change aspect ratio.
Whisper --- Change Whisper / Eco mode.
Mirror --- Change mirror status.
Blank --- Change blank on / off.
Mute --- Change sound mute status.
Freeze --- Change freeze status.
Display Image --- Select e-SHOT / MY IMAGE to display / OFF.
Messenger --- Select Messenger to display / OFF.
Brightness --- Change brightness.
[-]: Decrease value.
[*]: Increase value.
Contrast --- Change contrast.
[-]: Decrease value.
[*]: Increase value.
Sharpness --- Change sharpness.
[-]: Decrease value.
[*]: Increase value.
Color --- Change color.
[-]: Decrease value.
[*]: Increase value.
Tint --- Change tint.
[-]: Decrease value.
[*]: Increase value.
Auto Adjust --- Execute auto image adjustment.

Lamp Time Reset  ---
Filter Time Reset  ---
Advanced Control  ---

Reset the lamp time.

Reset the filter time.

Open the projector Advance Control Menu.

(‘Advanced Control’ Screen varies depending on the projector model.)
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The details for each Advance Control screen (for the appropriate projector model types) are described below.

m CP-S210/CP-S235/ CP-X1200 / CP-X1230 / CP-X1250 / CP-SX1350

[STATUS] Tab
Function General Description
Power Status Display the Power Status.
Off / On / Cool down
Input Status Display the Input source status.
CP-S210 / CP-S235
RGB / Video / S-Video / Component
CP-X1200 / CP-X1250 / CP-X1350
M1-D / RGB / BNC / Video / S-Video / Component
CP-X1230
RGB / BNC / Video / S-Video / Component
Error Status Display the Error status.
Normal / Cover Error/ Fan Error / Lamp Error / Temp Error /
Air Flow Error / Lamp Time Error / Cold Error / Filter Error / Other Error
Blank On / Off Display the Blank status.
Off / On
Mute Display the Mute status.
Off / On
Freeze Display the Freeze status.
Normal / Freeze
Lamp Time Display the Lamp Time.
Filter Time Display the Filter Time.
Reset Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.
[MAIN] Tab
Function General Description
Keystone Setting the Keystone.

[-]: Decrease the Keystone value.
[*+]: Increase the Keystone value.
» This Function is not displayed for CP-X1200 / CP-X1230 / CP-X1250 / CP-SX1350.
Brightness Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.
Contrast Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.
Aspect Setting the Aspect
CP-S210/ CP-S235
4:3/16:9/15:9/32:15/ Wide / Zoom
CP-X1200 / CP-X1250
4:3/16:9/ Small / Normal
CP-X1230
4:3/16:9/ Small
CP-SX1350
4:3/16:9/ Small / Real / Normal
Whisper Setting the Whisper Mode
Normal / Whisper
Mirror Setting the Mirror display
Normal / H Inverse / V Inverse / H&V Inverse
Language Setting the Language
English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish
» For CP-SX1350, Turkish / Traditional Chinese is added to above language.
Reset Initialize the selected Function.
CP-S210/ CP-S235
Brightness / Contrast / Keystone
CP-X1200 / CP-X1230 / CP-X1250 / CP-SX1350
Brightness / Contrast
[Execute]: After the confirmation message, the selected Function will be initialized.
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[PICTURE-1] Tab

Function

General Description

Gamma

Setting the Gamma.
Normal / Cinema / Dynamic / Custom

Custom Gamma

Setting the Custom Gamma.
[-]: Decrease the Custom Gamma value.
[+]: Increase the Custom Gamma value.

Color Temp

Setting the Color Temp.
Low / Middle / High / User

Custom User R

Setting the Color Temp (Red).
100/90/80/70/60/50

Custom User G

Setting the Color Temp (Green)
100/90/80/70/60/50

Custom User B

Setting the Color Temp (Blue)
100/90/80/70/60/50

Color Bal R

Setting the Color Balance (Red)
[-]: Decrease the red value.
[+]: Increase the red value.

Color Bal G

Setting the Color Balance (Green)
[-]: Decrease the green value.
[+]: Increase the green value.

Color Bal B

Setting the Color Balance (Blue)
[-]: Decrease the blue value.
[+]: Increase the blue value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value.

Tint

Setting the tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

My Memory

Load / Save My Memory.
Load1/Load2 / Load3 / Load4 / Save1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function.
Color Bal R / Color Bal G / Color Bal B / Sharpness / Color / Tint
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE-2] Tab

Function

General Description

Position

Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[d]: Increase the horizontal position.
[®]: Decrease the horizontal position.

H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[*]: Increase the clock phase value.

H Size

Setting the horizontal size.
[-]: Decrease the horizontal size value.
[*]: Increase the horizontal size value.

Over Scan

Setting the Over Scan.
[-]: Decrease the Over scan value.
[+]: Increase the Over scan value.

Reset

Initialize the selected Function.

V Position / H Position / H Size / Over Scan
[Execute]: After the confirmation message, the selected Function will be
initialized.
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[INPUT] Tab

Function General Description
Color Space Setting the Color Space.

Auto / RGB / SMPTE240 / REC709 / REC601
Component Adjusting the Component Setting

Component / Scart RGB

Video Format

Setting the Video Format
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

Frame Lock

Setting the Frame Lock.
Off / On
» This Function is not displayed for CP-X1200 / CP-X1230 / CP-X1250 / CP-SX1350.

3D-YCS

Setting the 3D-YCS

CP-S210/ CP-S235
Off / Normal / Still Image

CP-X1200 / CP-X1230 / CP-X1250 / CP-SX1350
On / Off

Video NR

Setting the Video NR.
Low / Middle / High

Progressive

Setting the Progressive
Off / TV / FILM
» This Function is not displayed for CP-X1200 / CP-X1230 / CP-X1250 / CP-SX1350.

P.IN P. Input

Setting the P.IN P.
Video / S-Video
» This Function is not displayed for CP-S210 / CP-S235.

P.IN P. Position

Setting the P.IN P. position.
Upper Left / Upper Right / Bottom Left / Bottom Right
» This Function is not displayed for CP-S210 / CP-S235.

P.IN P. Audio

Setting the P.IN P. Audio.
RGB / Video
» This Function is not displayed for CP-S210 / CP-S235.

P.IN P. Size

Setting P.IN P. Size
Off / Large / Small
» This Function is not displayed for CP-S210 / CP-S235.

Power Up Input

Setting which source will be input when power turned on.
Lash CH/M1-D /RGB /BNC / Video / S-Video / Component
» This Function is not displayed for CP-S210 / CP-S235.

S2-Aspect Setting the S2-Aspect
Off / On
» This Function is not displayed for CP-SX1350.
[AUTO] Tab
Function General Description
Auto Adjust Execute Auto Adjust.

Auto Power Off

Setting Auto Power Off.
[-]: Decrease Auto Power Off time.
[+]: Increase Auto Power Off time.

Auto Power On

Setting Auto Power On.

Off / On
» This Function is not displayed for CP-S210 / CP-S235 / CP-SX1350.
Auto Search Setting Auto Search.
Off / On
[SCREEN] Tab
Function General Description
Blank Setting the Blank Color.
CP-S210/ CP-S235
Blue / White / Black
CP-X1200 / CP-X1230 / CP-X1250 / CP-SX1350
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

CP-S210/ CP-S235
On / Off

CP-X1200 / CP-X1230 / CP-X1250 / CP-SX1350
Original / Off / MyScreen

MyScreen Size

Setting MyScreen size.
Full / x1
» This Function is not displayed for CP-S210 / CP-S235 / CP-SX1350.
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MyScreen Lock

Setting MyScreen Lock.
Off / On
» This Function is not displayed for CP-S210 / CP-S235.

Menu Position

Setting the Menu Position

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[d]: Decrease the horizontal menu position.
[P>]: Increase the horizontal menu position.

Message Setting Message
Off / On
Reset Initialize the selected Function.
Menu Position V / Menu Position H
[Execute]: After the confirmation message, the selected Function will be initialized.
[OPTION] Tab
Function General Description
Volume Setting the Volume.
[-]: Decrease the Volume.
[+]: Increase the Volume.
Speaker Setting the speaker.

Off / On
» This Function is not displayed for CP-S210 / CP-S235.

Screen Type

Setting the Screen Type.
4:3/16:9-Top / 16:9-Center / 16:9-Bottom

» This Function is not displayed for CP-X1200 / CP-X1230 / CP-X1250 / CP-SX1350.

IR Remote

Setting the IR Remote.
Front (Off / On)
Rear (Off / On)
Top (Off / On)
» This Function is not displayed for CP-S210 / CP-S235.

IR Remote ID

Setting the IR Remote ID.
All/1/12/3
» This Function is not displayed for CP-S210 / CP-S235 / CP-X1230.

Auto Adjust Enable

Setting the Auto Adjust Enable.
Disable / Enable
» This Function is not displayed for CP-S210 / CP-S235.

Lens Type

Setting the Lens Type.
Auto/1/2/3/4/5
» This Function is not displayed for CP-S210 / CP-S235 / CP-X1230.

Lens Lock

Setting the Lens Lock
Off / On
» This Function is not displayed for CP-S210 / CP-S235.

[OTHER] Tab

Function

General Description

Power

Controlling the Power.
Off / On

Input Source

Setting the Input Source.
CP-S210/ CP-S235
RGB / Video / S-Video / Component
CP-X1200/ CP-X1250 / CP-SX1350
M1-D / RGB / BNC / Video / S-Video / Component
CP-X1230
RGB / BNC / Video / S-Video / Component

Blank On / Off Setting Blank.
Off / On

Mute Setting Mute.
Off / On

Freeze Setting Freeze.
Normal / Freeze

Magnify Setting Magnify

[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.
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Keystone V

Setting the Vertical Keystone.

[-]: Decrease the V Keystone value.

[+]: Increase the V Keystone value.

» This Function is not displayed for CP-S210 / CP-S235.

Keystone H

Setting the Horizontal Keystone.

[-]: Decrease the H Keystone value.

[+]: Increase the H Keystone value.

» This Function is not displayed for CP-S210 / CP-S235.

Reset

Initialize the selected Function.
Keystone V / Keystone H
[Execute]: After the confirmation message, the selected Function will be
initialized.
» This Function is not displayed for CP-S210 / CP-S235.

[STATUS] Tab

m CP-S225/CP-S318/ CP-X328 / CP-X880 / CP-X885 / ED-S3170 / ED-X3270 / ED-X3280

Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Status

Display the Input source status.
CP-S225
RGB / Video / S-Video / Component
CP-S318/ CP-X328
RGB1/RGB2 / Video / S-Video / Component
CP-X880 / CP-X885
DVI/RGB / BNC(RGB) / Video / S-Video / Component / BNC(Component)
ED-S3170/ ED-X3270 / ED-X3280
RGB1 / RGB2 / Video / S-Video

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error
/ Lamp Time Error / Cold Error / Filter Error / Other Error

Blank On / Off Display the Blank status.
Off / On
Mute Display the Mute status.
Off / On
Freeze Display the Freeze status.
Normal / Freeze
Lamp Time Display the Lamp Time.
Filter Time Display the Filter Time.
Reset Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.
[MAIN] Tab
Function General Description
Brightness Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.
Contrast Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.
Aspect Setting the Aspect

4:3/16:9/ Small

Picture Position

Setting the Picture Position when the aspect is 16:9 / Small.
Default / Bottom / Top

Gamma Setting the Gamma.
Normal / Cinema / Dynamic
Mirror Setting the Mirror display

Normal / H Inverse / V Inverse / H&V Inverse
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Language

Setting the Language.
English / French / German / Spanish / Italian / Norwegian / Dutch /
Portuguese / Japanese / Chinese / Korean

Reset

Initialize the selected Function.

Brightness / Contrast
[Execute]: After the confirmation message, the selected Function will be
initialized.

[PICTURE-1] Tab

Function

General Description

Color BalR

Setting the Color Balance (Red)
[-]: Decrease the red value.
[+]: Increase the red value.

Color Bal B

Setting the Color Balance (Blue)
[-]: Decrease the blue value.
[+]: Increase the blue value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value.

Tint

Setting the tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Reset

Initialize the selected Function.
Color Bal R/ Color Bal B / Sharpness / Color / Tint
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE-2] Tab

Function

General Description

POSITION

Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[’]: Decrease the horizontal position.

H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size

Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.

Over Scan

Setting the Over Scan.
Small / Middle / Large
» This Function is not displayed for CP-S225.

Reset

Initialize the selected Function.
V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.

[INPUT] Tab

Function

General Description

BNC

Setting the BNC Signal Type.
RGB / Component

» This Function is not displayed for CP-S225 / CP-S318 / CP-X328 / ED-S3170 /
ED-X3270 / ED-X3280.

Auto Adjust

Execute the Auto Adjust.
» This Function is not displayed for CP-X880 / CP-X885

Video Format

Setting the Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

HDTV Setting the HDTV signal mode.
1080i / 1035i
» This Function is not displayed for ED-S3170 / ED-X3270 / ED-X3280.
Sync On G Setting the Sync On G mode.

Off / On
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P.IN P. Input

Setting the P.IN P. Input.
Video / S-Video

» This Function is not displayed for CP-S225 / CP-S318 / CP-X328 / ED-S3170 /
ED-X3270 / ED-X3280.

P.IN P. Position

Setting the P.IN P. Position.
Upper Left / Upper Right / Bottom Left / Bottom Right

» This Function is not displayed for CP-S225 / CP-S318 / CP-X328 / ED-S3170 /
ED-X3270 / ED-X3280.

P.IN P. Audio

Setting the P.IN P. Audio.
RGB / Video

» This Function is not displayed for CP-S225 / CP-S318 / CP-X328 / ED-S3170 /
ED-X3270 / ED-X3280.

P.IN P. Size

Setting P. IN P. Size.
Off / Large / Small

» This Function is not displayed for CP-S225 / CP-S318 / CP-X328 / ED-S3170 /
ED-X3270 / ED-X3280.

[AUTO] Tab

This tab is displayed for CP-X880 / CP-X885.

Function

General Description

Auto Adjust

Execute Auto Adjust.

Auto Keystone

Execute Auto Keystone.

Auto Power Off

Setting Auto Power Off.

[SCREEN] Tab
Function General Description
Blank Setting the Blank Color
CP-S225
Blue / White / Black
CP-S318 / CP-X328 / CP-X880 / CP-X885 / ED-S3170 / ED-X3270 / ED-X3280
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

CP-S225
On / Off

CP-S318 / CP-X328 / CP-X880 / CP-X885 / ED-S3170 / ED-X3270 / ED-X3280
Original / Off / MyScreen

MyScreen Size

Setting MyScreen size.
Full / x1
» This Function is not displayed for CP-S225.

My Screen Lock

Setting MyScreen Lock.
Off / On
» This Function is not displayed for CP-S225.

[OPTION] Tab
Function General Description
Volume Setting the Volume.

[-]: Decrease the Volume.
[+]: Increase the Volume.

Auto Power Off

Setting Auto Power Off.
» This Function is not displayed for CP-X880 / CP-X885.

Whisper Setting the Whisper Mode
Normal / Whisper
IR Remote Setting the IR Remote.

Front (Off / On)
Rear (Off / On)
Top (Off / On)
» This Function is not displayed for CP-S225 / CP-S318 / CP-X328 / ED-S3170 /
ED-X3270 / ED-X3280.
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[OTHER] Tab

Function General Description
Power Controlling the Power.
Off / On
Input Source Setting the Input Source.
CP-S225

RGB / Video / S-Video / Component
CP-S318/ CP-X328

RGB1/RGB2 / Video / S-Video / Component
CP-X880 / CP-X885

RGB / BNC(RGB) / Video / S-Video / DVI / Component / BNC(Component)
ED-S3170 / ED-X3270 / ED-X3280

RGB1 /RGB2 / Video / S-Video

Blank On / Off

Setting Blank.
Off / On

Mute

Setting Mute.
Off / On

Freeze

Setting Freeze.
Normal /Freeze

Magnify

Setting Magnify
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

Keystone V

Setting the Vertical Keystone.
[-]: Decrease the V Keystone value.
[+]: Increase the V Keystone value.

Keystone H

Setting the Horizontal Keystone.

[-]: Decrease the H Keystone value.

[+]: Increase the H Keystone value.

» This Function is not displayed for CP-S225.

Reset

Initialize the selected Function.

CP-S225
Keystone V

CP-S318 / CP-X328 / CP-X880 / CP-X885 / ED-S3170 / ED-X3270 / ED-X3280
Keystone V / Keystone H

[Execute]: After the confirmation message, the selected Function will be initialized.

[STATUS] Tab

m CP-S220/ CP-S420 / CP-X430 / CP-X990 / CP-X995 / CP-SX5600

Function

General Description

Power Status

Display the Power Status.
Off / On

Input Source

Display the Input source status.

CP-S220
RGB / Video / S-Video

CP-S420 / CP-X430 / CP-X990 / CP-X995 / CP-SX5600
DVI/RGB1/RGB2/ Video / S-Video / Component

Error Status

Display the Blank status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error
/ Lamp Time Error / Other Error

Blank On / Off Display the Blank status.
Off / On

Mute Display the Mute status.
Off / On

Freeze Display the Freeze status.
Normal / Freeze

Reset Initialize the selected Function.

Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.
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[PICTURE] / [SETUP] Tab

Function General Description
Brightness Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.
Contrast Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.
Position Setting the display position.
[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[d: Increase the horizontal position.
[’]: Decrease the horizontal position.
H Phase Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.
H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Sharpness Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.
Color Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value.
Tint Setting the tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.
Color Bal R Setting the Color Balance (Red)
[-]: Decrease the red value.
[+]: Increase the red value.
Color Bal B Setting the Color Balance (Blue)
[-]: Decrease the blue value.
[+]: Increase the blue value.
Aspect Setting the Aspect.
CP-S220 / CP-X990 / CP-X995
4:3/16:9/ Small
CP-S420 / CP-X430
4:3,Full / 16:9 / Small
CP-SX5600
4:3,Full / 16:9 / Small / Real
Reset Initialize the selected Function.
Sharpness / Color / Tint / Color Bal R / Color Bal B
[Execute]: After the confirmation message, the selected Function will be initialized
» The tab name becomes ‘PICTURE’ for CP-X990 / CP-X995 / CP-SX5600, and ‘SETUP’ for CP-S220 /
CP-S420 / CP-X430.

[INPUT] Tab
Function General Description
Auto Adjust Execute Auto Adjust.
Video Format Setting the Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL
Video NR Setting the Video NR.
Off / On
» This Function is not displayed for CP-S220 / CP-S420 / CP-X430 / CP-SX5600.
Progressive Setting the Progressive
Off / TV / FILM
» This Function is not displayed for CP-S220 / CP-S420 / CP-X430.
Black Setting Blank.
Off / On
» This Function is not displayed for CP-S220 / CP-S420 / CP-X430.
HDTV Setting the HDTV signal mode.
1080i / 1035i
» This Function is not displayed for CP-S220.
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[IMAGE] Tab

Function

General Description

Keystone

Setting the Keystone.

[-]: Decrease the Keystone value.

[+]: Increase the Keystone value.

» This Function is not displayed for CP-S420 / CP-X430 / CP-X990 / CP-X995 /
CP-SX5600.

Blank

Setting the Blank Color.
CP-S420 / CP-X430 / CP-X990 / CP-X995

Red / Orange / Green / Blue / Purple / White / Black / MyScreen / Original
CP-S220 / CP-SX5600

Red / Orange / Green / Blue / Purple / White / Black

Startup

Setting the Startup screen.

CP-5S420 / CP-X430 / CP-X990 / CP-X995
Original / Off / MyScreen

CP-S220 / CP-SX5600
On / Off

Mirror

Setting the Mirror display
Normal / H Inverse / V Inverse / H&V Inverse

P.IN P. Input

Setting the P.IN P. Input.
CP-S420 / CP-X430
Video / S-Video
CP-X990 / CP-X995 / CP-SX5600
Video / S-Video / Component
» This Function is not displayed for CP-S220.

P.IN P. Position

Setting the P. IN P. Position.
Upper Left / Upper Right / Bottom Left / Bottom Right
» This Function is not displayed for CP-S220.

P.IN P. Audio

Setting the P.IN P. Audio.
RGB / Video
» This Function is not displayed for CP-S220.

P.IN P. Size

Setting the P. IN P. Size
Off / Large / Small
» This Function is not displayed for CP-S220.

Gamma

Setting the Gamma.
Normal / Cinema / Dynamic
» This Function is not displayed for CP-S220.

Reset

Initialize the selected Function.
Keystone

[Execute]: After the confirmation message, the selected Function will be initialized.

» This Function is not displayed for CP-S420 / CP-X430 / CP-X990 / CP-X995 /
CP-SX5600.

[OPTION] Tab

Function

General Description

Volume

Setting the Volume.
[-]: Decrease the Volume.
[+]: Increase the Volume.

Menu Color

Setting the Menu Color
Red / Orange / Green / Blue / Purple / Transparent / Gray

Language

Setting the Language
English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese

Auto Power Off

Setting Auto Power Off.
[-]: Decrease Auto Power Off time.
[+]: Increase Auto Power Off time.

Sync On G Setting Sync On G
Off / On
Whisper Setting the Whisper mode
Normal / Whisper
» This Function is not displayed for CP-S220.
IR Remote Setting the IR Remote.

Front (Off / On)
Rear (Off / On)
Top (Off / On)
» This Function is not displayed for CP-S220 / CP-X990 / CP-X995 / CP-SX5600.
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[OTHER] Tab

Function General Description
Power Controlling the Power.
Off / On
Input Source Setting the Input Source.
CP-S220

RGB / Video / S-Video
CP-S420 / CP-X430 / CP-X990 / CP-X995 / CP-SX5600
DVI/RGB1/RGB2/ Video / S-Video / Component

Blank On / Off Setting Blank.
Off / On
Mute Setting Mute.
Off / On
Freeze Setting Freeze.
Normal / Freeze
Display Position Setting the Display Position when the aspect is 16:9 / Small
Default / Bottom / Top
» This Function is not displayed for CP-S220.
Keystone V Setting the Vertical Keystone.

[-]: Decrease the V Keystone value.
[+]: Increase the V Keystone value.
» This Function is not displayed for CP-S220.

Keystone H Setting the Horizontal Keystone.

[-]: Decrease the H Keystone value.

[+]: Increase the H Keystone value.

» This Function is not displayed for CP-S220.

Zoom Setting Zoom.

» This Function is not displayed for CP-S220 / CP-S420 / CP-X430 / CP-SX5600.
Focus Setting Focus.

» This Function is not displayed for CP-S220 / CP-S420 / CP-X430 / CP-SX5600.
Reset Initialize the selected Function.

Keystone V / Keystone H
[Execute]: After the confirmation message, the selected Function will be initialized.
» This Function is not displayed for CP-S220.
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m CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 / CP-RX61 / CP-S240 / CP-S245 /| CP-X250 / CP-X255 /
CP-S335 / CP-X340 / CP-X345 /| CP-X440 / CP-X443 | CP-X444 | CP-X445 / ED-S3350 / ED-X3400 /
ED-X3450 / ED-X8255

[STATUS] Tab
Function General Description
Power Status Display the Power Status.
Off / On/Cool down
Input Source Display the Input source status.

CP-RS55 / CP-RS60
RGB / Video / S-Video
CP-RS56 / CP-RS57 / CP-RX61
RGB1 / RGB2 / Video / S-Video
CP-S240 / CP-S245 | CP-X250 / CP-X255 / CP-S335 / CP-X340 / CP-X345
| CP-X440 | CP-X444 | ED-S3350 / ED-X3400 / ED-X3450 / ED-X8250
RGB1/RGB2 / Video / S-Video / Component
CP-X443 | CP-X445
DVI/RGB1/RGB2 / Video / S-Video / Component
Error Status Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error
/ Lamp Time Error / Cold Error / Filter Error / Other Error

Blank On / Off Display the Blank status.
Off / On

Mute Display the Mute status.
Off / On

Freeze Display the Freeze status.
Normal / Freeze

Lamp Time Display the Lamp Time.

Filter Time Display the Filter Time.

Reset Initialize the selected Function.

Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab
Function General Description
Brightness Setting the Brightness

[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.
Contrast Setting the Contrast

[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma Setting the Gamma.

#1-Custom / #2-Custom / #3-Custom / #1-Default / #2-Default / #3-Default
Color Temp Setting the Color Temp.

Low / Middle / High / Custom
Color Setting the color density.

[-]: Decrease the color density value.
[+]: Increase the color density value
Tint Setting the Tint.

[-]: Decrease the tint value.

[+]: Increase the tint value.
Sharpness Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

Progressive Setting the Progressive.
Off / TV / FILM
» This Function is not displayed for CP-X443 / CP-X445.
My Memory Load/Save the My Memory.

Load1/Load2 /Load3 / Load4 / Save1 / Save2 / Save3 / Save4
[Execute]: Load/Save the selected Function.
Reset Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.
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Gamma -Custom-

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.
[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.

User Gamma Point 2

Setting the User Gamma Point 2.
[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.

User Gamma Point 3

Setting the User Gamma Point 3.
[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.
[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.
[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.
[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.
[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.
[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.

Color Temp -Custom-

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.
[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.
[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value

Color Temp Gain B

Setting Color Temp Gain B.
[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value

Color Temp Offset R

Setting Color Temp Offset R.
[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value

Color Temp Offset G

Setting Color Temp Offset G.
[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value

Color Temp Offset B

Setting Color Temp Offset B.
[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 / CP-RX61
4:3/16:9/ Normal
CP-S240 / CP-S245 | CP-X250 / CP-X255 / CP-S335 / CP-X340 / CP-X345 / CP-X440
| CP-X443 | CP-X444 | CP-X445 | ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255
4:3/16:9/ Small / Normal
Over Scan Setting the Over Scan

[-]: Decrease the Over scan value.
[+]: Increase the Over scan value.
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Position

Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[d: Increase the horizontal position.
[’]: Decrease the horizontal position.

H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size

Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.

Auto Adjust

Execute Auto Adjust.

Reset

Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.

[VIDEO QLTY.] Tab

This tab is displayed for CP-X443 / CP-X445.

Function General Description

Progressive Setting the Progressive
Off / TV / FILM

3D-YCS Setting the 3D-YCS
Off / Normal / Still Image

Video NR Setting the Video NR.
Low / Middle / High

[INPUT] Tab

Function General Description

Color Space Setting the Color space.
Auto / RGB / SMPTE240 / REC709 / REC601

Component Setting the Component.

Component / Scart RGB
» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61.

Video Format

Setting the Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

Frame Lock

Setting the Frame Lock.
Off / On
» This Function is not displayed for CP-X440 / CP-X443 /| CP-X444 | CP-X445.

DVI

Setting the DVI Signal Type.
DVD / Computer

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S240 / CP-X245 /| CP-X250 / CP-X255 / CP-S335 / CP-X340 /
CP-X345 /| CP-X440 / CP-X444 |/ ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255.

[SETUP] Tab

Function

General Description

Electric Zoom

Setting the Electric Zoom

[-]: Decrease the Electric Zoom value.

[+]: Increase the Electric Zoom value.

» This Function is not displayed for CP-S240 / CP-S245 / CP-X250 / CP-X255 /
CP-S335 / CP-X340 / CP-X345 /| CP-X440 / CP-X443 /| CP-X444 | CP-X445 /
ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255.

Keystone

Setting the Keystone.

[-]: Decrease the Keystone value.

[+]: Increase the Keystone value.

» This Function is not displayed for CP-X440 / CP-X443 / CP-X444 | CP-X445.

Whisper

Setting the Whisper Mode.
Normal / Whisper

Mirror

Setting the Mirror display.
Normal / H Inverse / V Inverse / H&V Inverse

Volume

Setting the Volume.
[-]: Decrease the Volume.
[+]: Increase the Volume.
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Stereo

Setting the Stereo.
Mono / Stereo

» This Function is not displayed for CP-S240 / CP-S245 /| CP-X250 / CP-X255
/CP-S335 / CP-X340 / CP-X345 / CP-X440 / CP-X443 /| CP-X444 | CP-X445 |/
ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255.

IR Remote

Setting the IR Remote.
Front (Off / On)
Top (Off / On)

» This Function is not displayed for CP-S240 / CP-S245 / CP-X250 / CP-X255 /
CP-S335 / CP-X340 / CP-X345 /| CP-X440 / CP-X443 /| CP-X444 | CP-X445 /
ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255.

Audio-RGB1

Setting the Audio-RGB1
Off / Audio1 / Audio2

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S335 / CP-X340 / CP-X345 /| CP-X443 | CP-X445 |/ ED-S3350 /
ED-X3400 / ED-X3450.

Audio-RGB2

Setting the Audio-RGB2
Off / Audio1 / Audio2

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S335 / CP-X340 / CP-X345 / CP-X443 / CP-X445 |/ ED-S3350 /
ED-X3400 / ED-X3450.

Audio-Video

Setting the Audio-Video
Off / Audio1 / Audio2

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S335 / CP-X340 / CP-X345 /| CP-X443 | CP-X445 | ED-S3350 /
ED-X3400 / ED-X3450.

Audio-S-Video

Setting the Audio-S-Video
Off / Audio1 / Audio2

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S335 / CP-X340 / CP-X345 / CP-X443 / CP-X445 |/ ED-S3350 /
ED-X3400 / ED-X3450.

Audio-Component

Setting the Audio-Component
Off / Audio1 / Audio2

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S335 / CP-X340 / CP-X345 /| CP-X443 | CP-X445 |/ ED-S3350 /
ED-X3400 / ED-X3450.

Reset

Initialize the selected Function.
CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 / CP-RX61
Keystone / Electric Zoom
CP-S240 / CP-S245 |/ CP-X250 / CP-X255 / CP-S335 / CP-X340 / CP-X345 /
ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255
Keystone
[Execute]: After the confirmation message, the selected Function will be initialized.
» This Function is not displayed for CP-X443 / CP-X445.

[SCREEN] Tab

Function

General Description

Language

Setting the Language.

CP-RS55 / CP-RS56 / CP-RS57 /| CP-RX60 / CP-RX61 / CP-S240 / CP-S245 /

CP-X250 / CP-X255 / CP-X440 | CP-X443 | CP-X444 | CP-X445 | ED-X8255
English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese

CP-S335 / CP-X340 / CP-X345 / ED-S3350 / ED-X3400 / ED-X3450
English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[4]: Decrease the horizontal menu position.
[’]: Increase the horizontal menu position.

OSD Bright. Setting the OSD Brightness.
[-]: Decrease the OSD Brightness.
[+]: Increase the OSD Brightness.
Blank Setting the Blank color.

Blue / White / Black / MyScreen / Original

40




Startup

Setting the Startup screen.
Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On
Message Setting Message.

Off / On
Reset Initialize the selected Function.

Menu Position V / Menu Position H

[Execute]: After the confirmation message, the selected Function will be initialized.
[OPTION] Tab

Function General Description
One Touch Setting One Touch.

Auto Keystone V Off / Auto Keystone V On

» This Function is not displayed for CP-S240 / CP-S245 / CP-X250 / CP-X255 /
CP-S335 / CP-X340 / CP-X345 / CP-X440 / CP-X443 /| CP-X444 | CP-X445 |/
ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255.

Auto Search

Setting Auto Search.
Off / On

Auto Power Off

Setting Auto Power Off
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.

Auto Adjust Enable Setting Auto Adjust Enable
Disable / Enable
» This Function is not displayed for CP-S335 / CP-X340 / CP-X345 / ED-S3350 /
ED-X3400 / ED-X3450.
[OTHER] Tab
Function General Description
Power Controlling the Power.

Off / On

Input Source

Setting the Input Source.
CP-RS55 / CP-RX60
RGB / Video / S-Video
CP-RS56 / CP-RS57 / CP-RX61
RGB1 / RGB2 / Video / S-Video
CP-S240 / CP-S245 / CP-X250 / CP-X255 / CP-S335 / CP-X340 / CP-X345 / CP-X440
| CP-X444 | ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255
RGB1/RGB2 / Video / S-Video / Component
CP-X443 | CP-X445
DVI/RGB1/RGB2 / Video / S-Video / Component

Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Custom
» Custom is displayed only. It cannot be set.

Blank On / Off

Setting Blank.
Off / On

Mute

Setting Mute.
Off / On

Freeze

Setting Freeze.
Normal / Freeze

Magnify

Setting Magnify
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

e-SHOT

Setting e-SHOT
Off / Image1 / Image2 / Image3 / Image4

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S240 / CP-X250 / CP-S335 / CP-X340 / CP-X345 / CP-X440 /
CP-X443 /| CP-X444 | CP-X445 | ED-S3350 / ED-X3400 / ED-X3450.

Keystone V

Setting the Vertical Keystone.

[-]: Decrease the V Keystone value.

[+]: Increase the V Keystone value.

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S240 / CP-S245 / CP-X250 / CP-X255 / CP-S335 / CP-X340 /
ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255.
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Keystone H

Setting the Horizontal Keystone.

[-]: Decrease the H Keystone value.

[*+]: Increase the H Keystone value.

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S240 / CP-S245 /| CP-X250 / CP-X255 / CP-S335 / CP-X340 /
CP-X440 / CP-X444 /| ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255.

Auto Keystone V

Execute Auto Keystone V

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S240 / CP-S245 /| CP-X250 / CP-X255 / CP-S335 / CP-X340 /
CP-X440 / CP-X444 | ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255.

Reset

Initialize the selected Function.

CP-X440 /| CP-X444
Keystone V

CP-X443 | CP-X445
Keystone V / Keystone H

[Execute]: After the confirmation message, the selected Function will be initialized.

» This Function is not displayed for CP-RS55 / CP-RS56 / CP-RS57 / CP-RX60 /
CP-RX61 / CP-S240 / CP-S245 /| CP-X250 / CP-X255 / CP-S335 / CP-X340 /
CP-X345 / ED-S3350 / ED-X3400 / ED-X3450 / ED-X8255.
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m CPX2 / CPX4 / CP-A100 / CP-X200 / CP-X201 / CP-X205 / CP-X206 / CP-X251 / CP-X253 / CP-X256 /
CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 /
CP-X401 / CP-WX410 / CP-X417 / CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 /
CP-WX625 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110

[STATUS] Tab
Function General Description
Power Status Display the Power Status.
Off / On / Cool down
Input Source Display the Input source status.
CPX2

Computer / Video / S-Video / MIU
CP-A100 / CP-X200 / CP-X201 / CP-X205 / CP-X206 / CP-X300 / CP-X301 /
CP-X305 / CP-X306 / CP-X400 / CP-X401 / CP-X450 / ED-A100 / ED-A110
Computer1 / Computer2 / Video / S-Video / Component
CP-X251 / CP-X256 / CP-X260 / CP-X265
RGB1/RGB2 / Video / S-Video / Component
CP-X253
Computer1 / Computer2 / Video / S-Video
CP-X268A
RGB1/RGB2 / Video / S-Video / Component / MIU
CP-X308
Computer1 / Computer2 / Video / S-Video / Component / MIU
CP-WX410
Computer1 / Computer2 / HDMI / Video / S-Video / Component
CP-X417
Computer1 / Computer2 / HDMI / Video / S-Video / Component / MIU
CP-X505 / CP-X605
RGB1/RGB2/M1-D / Video / S-Video / Component
CP-X600
RGB1/RGB2 / Video / S-Video / Component
CP-X608
RGB1/RGB2/M1-D / Video / S-Video / Component / MIU
CP-X615 / CP-WX625 / CP-X705
RGB1/RGB2 / HDMI / Video / S-Video / Component
CP-X807 / CP-X809
RGB1/RGB2 / HDMI / Video / S-Video / Component / MIU
Error Status Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error
/ Lamp Time Error / Cold Error / Filter Error / Lens Door Error / Other Error

Blank On / Off Display the Blank status.
Off / On

Mute Display the Mute status.
Off / On

Freeze Display the Freeze status.
Normal / Freeze

Lamp Time Display the Lamp Time.

Filter Time Display the Filter Time.

Reset Initialize the selected Function.

Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab
Function General Description
Brightness Setting the Brightness

[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.
Contrast Setting the Contrast

[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.
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Gamma

Setting the Gamma.
CPX2 | CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X505 /
CP-X600 / CP-X605 / CP-X608
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #1-Default /
#2-Default / #3-Default / #4-Default / #5-Default
CP-A100 / CP-X200 / CP-X201 / CP-X205 / CP-X206 / CP-X300 / CP-X301 /
CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 / CP-X417 |/
CP-X450 / CP-X615 /| CP-WX625 /| CP-X705 / CP-X807 / CP-X809 / ED-A100 /
ED-A110
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
CPX2 / CP-X251 / CP-X253 /| CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X505 /
CP-X600 / CP-X605 / CP-X608
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Custom-Low / Custom-Mid /
Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2
CP-A100 / CP-X200 / CP-X201 / CP-X205 / CP-X206 / CP-X300 / CP-X301 /
CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 / CP-X417 /
CP-X450 / CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809 / ED-A100 /
ED-A110
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low / Custom-Mid /
Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 / Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

Active Iris

Setting the Active Iris.
Off / Theater / Presentation

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 / CP-X450 / ED-A100 / ED-A110.

My Memory

Load/Save My Memory.
Load1/Load2 / Load3 / Load4 / Save1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Gamma -Custom-]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.

User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.

User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.
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User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Color Temp -Custom-]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab

Function

General Description

Aspect

Setting the Aspect.
CPX2 / CP-X200 / CP-X201 / CP-X205 / CP-X206 / CP-X251 / CP-X253 / CP-X256 /
CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X301 / CP-X305 / CP-X306 /
CP-X308 / CP-X400 / CP-X401 / CP-X417 | CP-X450 / CP-X505 / CP-X600 / CP-X605
/ CP-X608 / CP-X615 / CP-X705 / CP-X807 / CP-X809

4:3/16:9/14:9/ Small / Normal
CP-A100/ ED-A100/ ED-A110

4:3/16:9/14:9/ Normal
CP-WX410 / CP-WX625

4:3/16:9/16:10/ 14:9 / Real / Normal

Over Scan

Setting the Over Scan
[-]: Decrease the Over scan value.
[+]: Increase the Over scan value.

Position

Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[’]: Decrease the horizontal position.
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H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV / FILM
Video NR Setting the Video NR.
Low / Mid / High
3D-YCS Setting the 3D-YCS
Off / Movie / Still Image
» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 / CP-X450 / ED-A100 / ED-A110.
Color Space Setting the Color space.
Auto / RGB / SMPTE240 / REC709 / REC601
Component Setting the Component.

Component / Scart RGB
» This Function is not displayed for CPX2 / CP-X253.

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

HDMI Setting the HDMI Signal Type.
Auto / Normal / Enhanced
» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / ED-A100 / ED-A110.
M1-D Setting the M1-D Signal Type.
Normal / Enhanced
» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 | CP-X450 / CP-X600 / CP-X615 / CP-WX625 / CP-X705 /
CP-X807 / CP-X809 / ED-A100 / ED-A110.
Frame Lock Setting the Frame Lock.

Off / On

» This Function is not displayed for CP-A100 / CP-X201 / CP-X206 / CP-X301 /
CP-X306 / CP-X308 / CP-401 / CP-WX410 / CP-X417 /| CP-X450 / CP-X615 /
CP-WX625 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110.

Frame Lock-RGB1

Setting the Frame Lock-RGB1.
Off / On

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 | CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 /
ED-A100 / ED-A110.

Frame Lock-Computer1

Setting the Frame Lock-Computer1.
Off / On

» This Function is not displayed for CPX2 / CP-X200 / CP-X205 / CP-X251 / CP-X253
| CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 / CP-X400 /
CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 / CP-X705 /
CP-X807 / CP-X809.
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Frame Lock-RGB2

Setting the Frame Lock-RGB2.
Off / On

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
| CP-X206 / CP-X251 / CP-X253 /| CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 /| CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 /
ED-A100 / ED-A110.

Frame Lock-Computer2

Setting the Frame Lock-Computer2.
Off / On

» This Function is not displayed for CPX2 / CP-X200 / CP-X205 / CP-X251 / CP-X253
| CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 / CP-X400 /
CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 / CP-X705 /
CP-X807 / CP-X809.

Frame Lock-HDMI

Setting the Frame Lock-HDMI.
Off / On

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / ED-A100 / ED-A110.

RGB IN-1

Setting the RGB IN-1 Signal Type.
CP-X615/ CP-WX625 / CP-X705 / CP-X807 / CP-X809
Sync On G Off / Auto
CP-X251 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X505 / CP-X600 /
CP-X605 / CP-X608
Sync On G Off / Sync On G On
» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X253 / CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 /
CP-X400 / CP-X401 / CP-WX410 / CP-X417 / CP-X450 / ED-A100 / ED-A110.

Computer in-1

Setting the Computer in-1 Signal Type.
CPX2 / CP-X253
Sync On G Off / Auto
CP-A100 / CP-X200 / CP-X201 / CP-X-205 / CP-X206 / CP-X300 / CP-X301 /
CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 / CP-X417 /
CP-X450/ ED-A100/ ED-A110
Sync On G Off / Sync On G On
» This Function is not displayed for CP-X251 / CP-X256 / CP-X260 / CP-X265 /
CP-X268A / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 /
CP-X705 / CP-X807 / CP-X809.

RGB IN-2

Setting the RGB IN-2 / Computer in-2 Signal Type.
CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809
Sync On G Off / Auto
CP-X251 / CP-X256 /| CP-X260 / CP-X265 / CP-X268A / CP-X505 / CP-X600 /
CP-X605 / CP-X608
Sync On G Off / Sync On G On
» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
| CP-X206 / CP-X253 / CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 /
CP-X400 / CP-X401 / CP-WX410 / CP-X417 /| CP-X450 / ED-A100 / ED-A110.

Computer in-2

Setting the Computer in-1 Signal Type.
CP-X253
Sync On G Off / Auto
CP-A100 / CP-X200 / CP-X201 / CP-X-205 / CP-X206 / CP-X300 / CP-X301 /
CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 / CP-X417 /
CP-X450 / ED-A100 / ED-A110
Sync On G Off / Sync On G On
» This Function is not displayed for CPX2 / CP-X251 / CP-X256 / CP-X260 / CP-X265
/ CP-X268A / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 /
CP-X705 / CP-X807 / CP-X809.

[SETUP] Tab

Function

General Description

Auto Keystone

Execute Auto Keystone.
» This Function is not displayed for CP-A100 / ED-A100 / ED-A110.

Keystone V

Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.

47




Keystone H

Setting the Keystone H.

[-]: Decrease the Keystone H value.

[+]: Increase the Keystone H value.

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-X450 / CP-X505 / ED-A100 / ED-A110.

Whisper Setting the Whisper.
Normal / Whisper
Mirror Setting the Mirror display.
Normal / H Inverse / V Inverse / H&V Inverse
Volume Setting the Volume.
[-]: Decrease the Volume.
[+]: Increase the Volume.
» This Function is not displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 /
CP-X401 / CP-WX410 / CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809.
Speaker Setting the Speaker.
Off / On
» This Function is not displayed for CPX2 / CP-X201 / CP-X206 / CP-X251 / CP-X253
/ CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X301 / CP-X306 / CP-X401 /
CP-WX410 / CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 /
CP-WX625 / CP-X705 / CP-X807 / CP-X809.
D-Zoom Setting the D-Zoom.
[-]: Decrease the D-Zoom.
[+]: Increase the D-Zoom.
» This Function is not displayed for CPX2 / CP-X200 / CP-X201 / CP-X205 / CP-X206
/ CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 /
CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 /
CP-X417 /| CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 /
CP-WX625 / CP-X705 / CP-X807 / CP-X809.
D-Shift Setting the D-Shift.
[A]: Increase the D-Shift V.
[V]: Decrease the D-Shift V.
[4]: Decrease the D-Shift H.
[®]: Increase the D-Shift H.
» This Function is not displayed for CPX2 / CP-X200 / CP-X201 / CP-X205 / CP-X206
/ CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 /
CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 /
CP-X417 | CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 /
CP-WX625 / CP-X705 / CP-X807 / CP-X809.
Audio-RGB1 Setting the Audio-RGB1.

Off / Audio1 / Audio2 / Audio3

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X253 / CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 /
CP-X400 / CP-X401 / CP-WX410 / CP-X417 | CP-X450 / CP-X505 / CP-X600 /
CP-X605 / CP-X608 / CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809 /
ED-A100 / ED-A110.

Audio-Computer1

Setting the Audio-Computer1.

CP-A100/ CP-X200 / CP-X205 / CP-X300 / CP-X305 / CP-X308 / CP-X400 / CP-X417

/ ED-A100/ ED-A110
Off / Audio1 / Audio2 / Audio3

CP-X253
Off / Audio1 / Audio2

» This Function is not displayed for CPX2 / CP-X201 / CP-X206 / CP-X251 / CP-X256
| CP-X260 / CP-X265 / CP-X268A / CP-X301 / CP-X306 / CP-X401 / CP-WX410 /
CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 /
CP-X705 / CP-X807 / CP-X809.

Audio-RGB2

Setting the Audio-RGB2.
Off / Audio1 / Audio2 / Audio3

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X253 / CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 /
CP-X400 / CP-X401 / CP-WX410 / CP-X417 | CP-X450 / CP-X505 / CP-X600 /
CP-X605 / CP-X608 / CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809 /
ED-A100 / ED-A110.
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Audio-Computer2

Setting the Audio-Computer2.

CP-A100/ CP-X200 / CP-X205 / CP-X300 / CP-X305 / CP-X308 / CP-X400 / CP-X417

/ ED-A100/ ED-A110
Off / Audio1 / Audio2 / Audio3

CP-X253
Off / Audio1 / Audio2

» This Function is not displayed for CPX2 / P-X201 / CP-X206 / CP-X251 / CP-X256 /
CP-X260 / CP-X265 / CP-X268A / CP-X301 / CP-X306 / CP-X401 / CP-WX410 /
CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 /
CP-X705 / CP-X807 / CP-X809.

Audio-HDMI Setting the Audio HDMI.
Off / Audio1 / Audio2 / Audio3 / Audio HDMI
» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 /
CP-WX625 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110.
Audio-Video Setting the Audio Video.
CP-A100 / CP-X200 / CP-X205 / CP-X251 / CP-X256 / CP-X260 / XP-X265 /
CP-X268A / CP-X300 / CP-X305 / CP-X308 / CP-X400 / CP-X417 /| ED-A100 /
ED-A110
Off / Audio1 / Audio2 / Audio3
CP-X253
Off / Audio1 / Audio2
» This Function is not displayed for CPX2 / CP-X201 / CP-X206 / CP-X253 / CP-X301
/ CP-X306 / CP-X401 / CP-WX410 / CP-X450 / CP-X505 / CP-X600 / CP-X605 /
CP-X608 / CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809.
Audio-S-Video Setting the Audio-Video.

CP-A100 / CP-X200 / CP-X205 / CP-X251 / CP-X256 / CP-X260 / XP-X265 /
CP-X268A / CP-X300 / CP-X305 / CP-X308 / CP-X400 / CP-X417 / ED-A100 /
ED-A110
Off / Audio1 / Audio2 / Audio3
CP-X253
Off / Audio1 / Audio2
» This Function is not displayed for CPX2 / CP-X201 / CP-X206 / CP-X253 / CP-X301
/ CP-X306 / CP-X401 / CP-WX410 / CP-X450 / CP-X505 / CP-X600 / CP-X605 /
CP-X608 / CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809.

Audio-Component

Setting the Audio Component.
Off / Audio1 / Audio2 / Audio3

» This Function is not displayed for CPX2 / CP-X201 / CP-X206 / CP-X253 / CP-X301
/ CP-X306 / CP-X401 / CP-WX410 / CP-X450 / CP-X505 / CP-X600 / CP-X605 /
CP-X608 / CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809.

Audio-MIU

Setting the Audio MIU.

CP-X268A / CP-X308 / CP-X417
Off / Audio1 / Audio2 / Audio3 / Audio MIU

CPX2
Off / Audio in / MIU

» This Function is not displayed for CP-A100 / CP-X200 / CP-X201 / CP-X205 /
CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X300 /
CP-X301 / CP-X305 / CP-X306 / CP-X400 / CP-X401 / CP-WX410 / CP-X450 /
CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 / CP-X705 /
CP-X807 / CP-X809 / ED-A100 / ED-A110.

HDMI Audio

Setting the HDMI Audio.
1/2

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 /
CP-WX625 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110.

Standby Mode

Setting the Standby Mode.
Normal / Saving

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X205 / CP-X251
| CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 /
CP-X308 / CP-X400 / CP-X417 /| CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110.

49




Monitor Out-RGB1

Setting the Monitor Out-RGB1.
Off / RGB1 / RGB2

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
| CP-X206 / CP-X251 / CP-X253 /| CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 /| CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / ED-A100 / ED-A110.

Monitor Out-Computer1

Setting the Monitor Out-Computer.
Off / Computer1

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X205 / CP-X251
/ CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 /
CP-X308 / CP-X400 / CP-X417 /| CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110.

Monitor Out-RGB2

Setting the Monitor Out-RGB2.
Off / RGB1/ RGB2

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 | CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / ED-A100 / ED-A110.

Monitor Out-Computer2

Setting the Monitor Out-Computer2.
Off / Computer2

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X205 / CP-X251
/ CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 /
CP-X308 / CP-X400 / P-X417 | CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110.

Monitor Out-HDMI

Setting the Monitor Out-HDMI.

CP-WX410
Off / Computer1 / Computer2

CP-X809
Off | RGB1/ RGB2

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-X417 /| CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 /
CP-X705 / CP-X807 / ED-A100 / ED-A110.

Monitor Out-Video

Setting the Monitor Out-Video.

CP-WX625 / CP-X809
Off / RGB1 / RGB2

CP-X201 / CP-X206 / CP-X301 / CP-X306 / CP-X401 / CP-WX410 / CP-X450
Off / Computer1 / Computer2

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X205 / CP-X251
| CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 /
CP-X308 / CP-X400 / CP-X417 | CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / ED-A100 / ED-A110.

Monitor Out-S-Video

Setting the Monitor Out-S-Video.

CP-WX625 / CP-X809
Off / RGB1/ RGB2

CP-X201 / CP-X206 / CP-X301 / CP-X306 / CP-X401 / CP-WX410 / CP-X450
Off / Computer1 / Computer2

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X205 / CP-X251
/ CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 /
CP-X308 / CP-X400 / CP-X417 /| CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / ED-A100 / ED-A110.

Monitor Out
-Component

Setting the Monitor Out-Component.

CP-WX625 / CP-X809
Off / RGB1/RGB2

CP-X201 / CP-X206 / CP-X301 / CP-X306 / CP-X401 / CP-WX410 / CP-X450
Off / Computer1 / Computer2

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X205 / CP-X251
/ CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 /
CP-X308 / CP-X400 / CP-X417 /| CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / ED-A100 / ED-A110.
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Monitor Out-MIU Setting the Monitor Out-MIU.
Off / RGB1 / RGB2
» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X205 / CP-X251
/ CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 /
CP-X308 / CP-X400 / CP-WX410 / CP-X417 /| CP-X505 / CP-X600 / CP-X605 /
CP-X608 / CP-X615 / CP-X705 / CP-X807 / ED-A100 / ED-A110.
Monitor Out Standby Setting the Monitor Out Standby.
CP-WX625 / CP-X809
Off / RGB1 / RGB2
CP-X201 / CP-X206 / CP-X301 / CP-X306 / CP-X401 / CP-WX410 / CP-X450
Off / Computer1 / Computer2
» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X205 / CP-X251
/ CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 /
CP-X308 / CP-X400 / CP-X417 /| CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / ED-A100 / ED-A110.
Reset Initialize the selected Function.
CP-A100/ ED-A100/ ED-A110
Keystone V / D-Zoom / D-Shift V / D-Shift H
CPX2 / CP-X200 / CP-X201 / CP-X205 / CP-X206 / CP-X251 / CP-X253 / CP-X256 /
CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X301 / CP-X305 / CP-X306 /
CP-X308 / CP-X400 / CP-X401 / CP-X450
Keystone V
CP-WX410 / CP-X417 | CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 /
CP-WX625 / CP-X705 / CP-X807 / CP-X809
Keystone V / Keystone H
[Execute]: After the confirmation message, the selected Function will be initialized.

[AUDIO] Tab
This tab is displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 / CP-X401 / CP-WX410 / CP-X450 /
CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809.

Function General Description

Volume Setting the Volume.

[-]: Decrease the Volume.

[+]: Increase the Volume.

Treble Setting the Treble.

[-]: Decrease the Treble.

[+]: Increase the Treble.

» This Function is not displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 /
CP-X401 / CP-WX410 / CP-X450 / CP-X600.

Bass Setting the Bass.

[-]: Decrease the Bass.

[+]: Increase the Bass.

» This Function is not displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 /
CP-X401 / CP-WX410 / CP-X450 / CP-X600.

SRS WOW Setting the SRS WOW.
Off / Mid / High

» This Function is not displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 /
CP-X401 / CP-WX410 / CP-X450 / CP-X600.

Speaker Setting the Speaker.
Off / On
Audio-RGB1 Setting the Audio-RGB1.

Off / Audio1 / Audio2 / Audio3 / Audio4

» This Function is not displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 /
CP-X401 / CP-WX410 / CP-X450.

Audio-Computer1 Setting the Audio-Computer1.
Off / Audio1 / Audio2 / Audio3

» This Function is not displayed for CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809.

Audio-RGB2 Setting the Audio-RGB2.
Off / Audio1 / Audio2 / Audio3 / Audio4

» This Function is not displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 /
CP-X401 / CP-WX410 / CP-X450.

Audio-Computer2 Setting the Audio-Computer2.
Off / Audio1 / Audio2 / Audio3

» This Function is not displayed for CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809.
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Audio-M1-D

Setting the Audio-M1-D.
Off / Audio1 / Audio2 / Audio3 / Audio4

» This Function is not displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 /
CP-X401 / CP-WX410 / CP-X450 / CP-X600 / CP-X615 / CP-WX625 / CP-X705 /
CP-X807 / CP-X809.

Audio-HDMI Setting the Audio-HDMI.
CP-WX410
Off / Audio1 / Audio2 / Audio3 / Audio HDMI
CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809
Off / Audio1 / Audio2 / Audio3 / Audio4 / Audio HDMI
» This Function is not displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 /
CP-X401 / CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608.
Audio-Video Setting the Audio Video.
CP-X201 / CP-X206 / CP-X301 / CP-X306 / CP-X401 / CP-WX410 / CP-X450
Off / Audio1 / Audio2 / Audio3
CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 / CP-X705 /
CP-X807 / CP-X809
Off / Audio1 / Audio2 / Audio3 / Audio4
Audio-S-Video Setting the Audio S-Video.

CP-X201 / CP-X206 / CP-X301 / CP-X306 / CP-X401 / CP-WX410 / CP-X450

Off / Audio1 / Audio2 / Audio3
CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 / CP-X705 /
CP-X807 / CP-X809

Off / Audio1 / Audio2 / Audio3 / Audio4

Audio-Component

Setting the Audio-Component.
CP-X201 / CP-X206 / CP-X301 / CP-X306 / CP-X401 / CP-WX410 / CP-X450
Off / Audio1 / Audio2 / Audio3
CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 / CP-X705 /
CP-X807 / CP-X809
Off / Audio1 / Audio2 / Audio3 / Audio4

Audio-MIU

Setting the Audio-MIU.
Off / Audio1 / Audio2 / Audio3 / Audio4 / Audio MIU

» This Function is not displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 /
CP-X401 / CP-WX410 / CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X615 /
CP-WX625 / CP-X705.

Audio Out Standby

Setting the Audio Out Standby.

CP-X201 / CP-X206 / CP-X301 / CP-X306 / CP-X401 / CP-WX410 / CP-X450
Off / Audio1 / Audio2 / Audio3

CP-WX625 / CP-X809
Off / Audio1 / Audio2 / Audio3 / Audio4

» This Function is not displayed for CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807.

HDMI Audio

Setting the HDMI Audio.
1/2

» This Function is not displayed for CP-X201 / CP-X206 / CP-X301 / CP-X306 /
CP-X401 / CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608.

[SCREEN] Tab

Function

General Description

Language

Setting the Language.
English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[4]: Decrease the horizontal menu position.
[’]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.
Off / On

Message

Setting Message.
Off / On
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Template

Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X205 / CP-X251
| CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 /
CP-X306 / CP-X308 / CP-X400 / CP-X417 |/ CP-X505 / CP-X600 / CP-X605 /
CP-X608 / CP-X615 / CP-X705 / CP-X807 / ED-A100 / ED-A110.

PbyP

Setting the PbyP.
Off / On

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 /| CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110.

PbyP Sub Source

Setting the PbyP Sub Source.
RGB1/RGB2 / HDMI / Video / S-Video / Component

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 /| CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110.

PbyP Main Area

Setting the PbyP Main Area.
Left / Right

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
| CP-X206 / CP-X251 / CP-X253 /| CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 /| CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110.

PbyP Main Source

Setting the PbyP Main Source.
RGB1/RGB2 / HDMI / Video / S-Video / Component

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X206 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A /
CP-X300 / CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 /
CP-WX410 / CP-X417 /| CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110.

Reset Initialize the selected Function.

Menu Position V / Menu Position H

[Execute]: After the confirmation message, the selected Function will be initialized.
[OPTION] Tab

Function General Description
Auto Search Setting Auto Search.

Off / On
Auto Keystone Setting Auto Keystone.

Off / On

» This Function is not displayed for CP-A100 / ED-A100 / ED-A100.

Auto On Setting Auto On.
Off / On
Auto Off Setting Auto Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.
My Button-1 Setting My Button-1.

CP-A100/ED-A100/ ED-A110
Computer1 / Computer2 / Video / S-Video / Component / Information / Auto Keystone Execute
/ My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ / Volume- / AV Mute / Other
CPX2
Computer / Video / S-Video / MIU / Information / Auto Keystone Execute / My Memory /
Picture Mode / Filter Reset / e-SHOT / Volume+ / Volume-
CP-X200 / CP-X300 / CP-X400
Computer1 / Computer2 / Video / S-Video / Component / Information / Auto Keystone Execute
/ My Memory / Picture Mode / Filter Reset / Volume+ / Volume-
CP-X201 / CP-X301 / CP-X401 / CP-X450
Computer1 / Computer2 / Video / S-Video / Component / Information / Auto Keystone Execute
/ My Memory / Picture Mode / Filter Reset / AV Mite / Template / Other
CP-X205 / CP-X305
Computer1 / Computer2 / Video / S-Video / Component / Information / Auto Keystone Execute
/ My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ / Volume-
CP-X206 / CP-X306
Computer1 / Computer2 / Video / S-Video / Component / Information / Auto Keystone Execute
/ My Memory / Picture Mode / Filter Reset / My Image / AV Mite / Template / Other
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CP-X251 / CP-X260
RGB1 / RGB2 / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Volume+ / Volume-
CP-X253
Computer1 / Computer2 / Video / S-Video / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Volume+ / Volume-
CP-X256 / CP-X265
RGB1 / RGB2 / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ / Volume-
CP-X268A
RGB1 /RGB2 / Video / S-Video / Component / MIU / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ / Volume-
CP-X308
Computer1 / Computer2 / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ /
Volume- / Live Mode / Thumbnail / Slide Show / Directory / Remove Media
CP-WX410
Computer1 / Computer2 / HDMI / Video / S-Video / Component / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / AV Mute / Template /
Other
CP-X417
Computer1 / Computer2 / HDMI / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ /
Volume- /
Live Mode / Thumbnail / Slide Show / Directory / Remove Media
CP-X505 / CP-X605
RGB1/RGB2 / M1-D / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Active Iris / e-SHOT / Volume+ / Volume-
CP-X600
RGB1 / RGB2 / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Active Iris / Volume+ / Volume-
CP-X608
RGB1/RGB2 / M1-D / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / Active Iris / e-SHOT /
Volume+ / Volume-
CP-X615 / CP-X705
RGB1/RGB2 / HDMI / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Active Iris / e-SHOT / Volume+ / Volume- / AV Mute
CP-WX625
RGB1/RGB2 / HDMI / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Active Iris / My Image / AV Mute / PbyP Swap / Other
CP-X807
RGB1/RGB2 / HDMI / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / Active Iris / e-SHOT /
AV Mute / Template / Live Mode / Thumbnail / Slide Show / Directory / Remove Media
CP-X809
RGB1/RGB2 / HDMI / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / Active Iris / My Image /
AV Mute / Template / Live Mode / Thumbnail / Slide Show / Directory / Remove Media / Other

My Button-2

Setting My Button-2.
CP-A100/ ED-A100/ ED-A110
Computer1 / Computer2 / Video / S-Video / Component / Information / Auto Keystone Execute
/ My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ / Volume- / AV Mute / Other
CPX2
Computer / Video / S-Video / MIU / Information / Auto Keystone Execute / My Memory /
Picture Mode / Filter Reset / e-SHOT / Volume+ / Volume-
CP-X200 / CP-X300 / CP-X400
Computer1 / Computer2 / Video / S-Video / Component / Information / Auto Keystone Execute
/ My Memory / Picture Mode / Filter Reset / Volume+ / Volume-
CP-X201 / CP-X301 / CP-X401 / CP-X450
Computer1 / Computer2 / Video / S-Video / Component / Information / Auto Keystone Execute
/ My Memory / Picture Mode / Filter Reset / AV Mite / Template / Other
CP-X205 / CP-X305
Computer1 / Computer2 / Video / S-Video / Component / Information / Auto Keystone Execute
/ My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ / Volume-
CP-X206 / CP-X306
Computer1 / Computer2 / Video / S-Video / Component / Information / Auto Keystone Execute
/ My Memory / Picture Mode / Filter Reset / My Image / AV Mite / Template / Other
CP-X251 / CP-X260
RGB1/RGB2 / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Volume+ / Volume-
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CP-X253
Computer1 / Computer2 / Video / S-Video / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Volume+ / Volume-
CP-X256 / CP-X265
RGB1 / RGB2 / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ / Volume-
CP-X268A
RGB1 /RGB2 / Video / S-Video / Component / MIU / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ / Volume-
CP-X308
Computer1 / Computer2 / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ /
Volume- / Live Mode / Thumbnail / Slide Show / Directory / Remove Media
CP-WX410
Computer1 / Computer2 / HDMI / Video / S-Video / Component / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / AV Mute / Template /
Other
CP-X417
Computer1 / Computer2 / HDMI / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / e-SHOT / Volume+ /
Volume- / Live Mode / Thumbnail / Slide Show / Directory / Remove Media
CP-X505 / CP-X605
RGB1/RGB2 / M1-D / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Active Iris / e-SHOT / Volume+ / Volume-
CP-X600
RGB1 / RGB2 / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Active Iris / Volume+ / Volume-
CP-X608
RGB1/RGB2 / M1-D / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / Active Iris / e-SHOT /
Volume+ / Volume-
CP-X615 / CP-X705
RGB1 /RGB2 / HDMI / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Active Iris / e-SHOT / Volume+ / Volume- / AV Mute
CP-WX625
RGB1/RGB2 / HDMI / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Active Iris / My Image / AV Mute / PbyP Swap /
Other
CP-X807
RGB1/RGB2 / HDMI / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / Active Iris / e-SHOT /
Volume+ / Volume- / AV Mute / Live Mode / Thumbnail / Slide Show / Directory / Remove
Media
CP-X809
RGB1/RGB2 / HDMI / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / Active Iris / My Image /
AV Mute / Template / Live Mode / Thumbnail / Slide Show / Directory / Remove Media / Other

My Source

Setting the My Source.

CP-X201 / CP-X206 / CP-X301 / CP-X306 / CP-X401 / CP-X450
Computer1 / Computer2 / Video / S-Video / Component

CP-WX410
Computer1 / Computer2 / HDMI / Video / S-Video / Component

CP-WX625
RGB1/RGB2 / HDMI / Video / S-Video / Component

CP-X809
RGB1 /RGB2 / HDMI / Video / S-Video / Component / MIU

» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X205 / CP-X251
| CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X305 /
CP-X308 / CP-X400 / CP-X417 | CP-X505 / CP-X600 / CP-X605 / CP-X608 /
CP-X615 / CP-X705 / CP-X807 / ED-A100 / ED-A110.

C.C. Display

Setting the Closed Caption Display.
Off / On / Auto

» This Function is not displayed for CPX2 / CP-X200 / CP-X251 / CP-X253 / CP-X256
/ CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X400 / CP-X505 / CP-X600 /
CP-X605 / CP-X608 / CP-X615 / CP-X705 / CP-X807.

C.C. Mode

Setting the Closed Caption Mode.
Captions / Text

» This Function is not displayed for CPX2 / CP-X200 / CP-X251 / CP-X253 / CP-X256
/ CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X400 / CP-X505 / CP-X600 /
CP-X605 / CP-X608 / CP-X615 / CP-X705 / CP-X807.
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C.C. Channel

Setting the Closed Caption Channel.
1/2/3/4

» This Function is not displayed for CPX2 / CP-X200 / CP-X251 / CP-X253 / CP-X256
| CP-X260 / CP-X265 / CP-X268A / CP-X300 / CP-X400 / CP-X505 / CP-X600 /
CP-X605 / CP-X608 / CP-X615 / CP-X705 / CP-X807.

[Service]

Function

General Description

Auto Adjust

Setting the Auto Adjust.
CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205 / CP-X206 / CP-X253 / CP-X300 /
CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 /
CP-X417 | CP-X450 /| CP-X615 / CP-WX625 / CP-X705 / CP-X807 / CP-X809 /
ED-A100/ ED-A110

Disable / Fast / Fine
CP-X251 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X505 / CP-X600 /
CP-X605 / CP-X608

Disable / Enable

IR Remote

Setting the IR Remote.

CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-WX625 / CP-X705 /

CP-X807 / CP-X809
Front (Off / On)

Rear (Off / On)
Top (Off / On)

CP-A100/ED-A100/ ED-A110
Front (Off / On)

Top (Off / On)

» This Function is not displayed for CPX2 / CP-X200 / CP-X201 / CP-X205 / CP-X206
| CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 /
CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 /
CP-X417 / CP-X450.

IR Remote
Frequency Normal

Setting the IR Remote Frequency Normal.
Disable / Enable

IR Remote
Frequency High

Setting the IR Remote Frequency High.
Disable / Enable

Focus Lock

Setting the Focus Lock.
Off / On.

» This Function is not displayed for CPX2 / CP-X200 / CP-X201 / CP-X205 / CP-X206
/ CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 /
CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 /
CP-X417 | CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 /
CP-WX625 / CP-X705 / CP-X807 / CP-X809.

[OTHER] Tab

Function

General Description

Power

Controlling the Power.
Off / On
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Input Source

Setting the Input Source.
CPX2
Computer / Video / S-Video / MIU
CP-A100 / CP-X200 / CP-X201 / CP-X205 / CP-X206 / CP-X300 / CP-X301 /
CP-X305 / CP-X306 / CP-X400 / CP-X401 / CP-X450 / ED-A100 / ED-A110
Computer1 / Computer2 / Video / S-Video / Component
CP-X251 / CP-X256 / CP-X260 / CP-X265
RGB1/RGB2 / Video / S-Video / Component
CP-X253
Computer1 / Computer2 / Video / S-Video
CP-X268A
RGB1/RGB2 / Video / S-Video / Component / MIU
CP-X308
Computer1 / Computer2 / Video / S-Video / Component / MIU
CP-WX410
Computer1 / Computer2 / HDMI / Video / S-Video / Component
CP-X417
Computer1 / Computer2 / HDMI / Video / S-Video / Component / MIU
CP-X505 / CP-X605
RGB1/RGB2/M1-D / Video / S-Video / Component
CP-X600
RGB1/RGB2 / Video / S-Video / Component
CP-X608
RGB1/RGB2/M1-D / Video / S-Video / Component / MIU
CP-X615 / CP-WX625 / CP-X705
RGB1/RGB2 / HDMI / Video / S-Video / Component
CP-X807 / CP-X809
RGB1/RGB2 / HDMI / Video / S-Video / Component / MIU

Mode Setting the Picture Mode.
CPX2 / CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X505 /
CP-X600 / CP-X605 / CP-X608
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board / Custom
CP-A100 / CP-X200 / CP-X201 / CP-X205 / CP-X206 / CP-X300 / CP-X301 /
CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 / CP-X417 /
CP-X450 / CP-X615 / CP-X705 / CP-X807 / CP-X809 / ED-A100 / ED-A110
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom
» Custom is displayed only. It cannot be set.
Blank On / Off Setting Blank.
Off / On
Mute Setting Mute.
Off / On
Freeze Setting Freeze.
Normal / Freeze
Magnify Setting Magnify
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.
e-SHOT Setting e-SHOT.
Off / Image1 / Image2 / Image3 / Image4
» This Function is not displayed for CP-X200 / CP-X201 / CP-X206 / CP-X251 /
CP-X253 / CP-X260 / CP-X300 / CP-X301 / CP-X306 / CP-X400 / CP-X401 /
CP-WX410 / CP-X450 / CP-X600 / CP-WX625 / CP-X809.
My Image Setting the My Image.
CP-X206 / CP-X306 / CP-WX625 / CP-X809
Off / Image1 / Image2 / Image3 / Image4
» This Function is not displayed for CPX2 / CP-A100 / CP-X200 / CP-X201 / CP-X205
/ CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 /
CP-X301 / CP-X305 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 / CP-X417 /
CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 / CP-X705 /
CP-X807 / ED-A100 / ED-A110.
Focus Setting Focus.

» This Function is not displayed for CPX2 / CP-X200 / CP-X201 / CP-X205 / CP-X206
| CP-X251 / CP-X253 / CP-X256 / CP-X260 / CP-X265 / CP-X268A / CP-X300 /
CP-X301 / CP-X305 / CP-X306 / CP-X308 / CP-X400 / CP-X401 / CP-WX410 /
CP-X417 | CP-X450 / CP-X505 / CP-X600 / CP-X605 / CP-X608 / CP-X615 /
CP-WX625 / CP-X705 / CP-X807 / CP-X809.
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m CPX4

[STATUS] Tab

Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Source

Display the Input source status.
Computer in / Video / S-Video / MIU

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error
/ Lamp Time Error / Cold Error / Filter Error / Other Error

Blank On/Off

Display the Blank status.
Off / On

Mute

Display the Mute status.
Off / On

Freeze

Display the Freeze status.
Normal / Freeze

Lamp Time

Display the Lamp Time.

Filter Time

Display the Filter Time.

Reset

Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab

Function

General Description

Brightness

Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.

Contrast

Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma

Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

My Memory

Load/Save the My Memory.
Load1/Load2 /Load3 /Load4 / Savel1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Custom - Gamma -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.

User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.
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User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
4:3/16:9/14:9 / Small / Normal
Over Scan Setting the Over Scan
[-]: Decrease the Over scan value.
[+]: Increase the Over scan value.
Position Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[P>]: Decrease the horizontal position.
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H Phase Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.
H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV /FILM
Video NR Setting the Video NR.
Low / Mid / High
Color Space Setting the Color space.

Auto / RGB / SMPTE240 / REC709 / REC601

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

Frame Lock-Computer in

Setting the Frame Lock-Computer in.
Off / On

Computer in Setting the Computer in Signal Type.
Sync On G Off / Auto
[SETUP] Tab
Function General Description

Auto Keystone Execute

Execute Auto Keystone.

Keystone V

Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.

Whisper Setting the Whisper.
Normal / Whisper
Mirror Setting the Mirror display.
Normal / H Inverse / V Inverse / H&V Inverse
Reset Initialize the selected Function.
Keystone V
[AUDIO] Tab
Function General Description
Volume Setting the Volume.

[-]: Decrease the Volume.
[+]: Increase the Volume.

Audio-Computer

Setting the Audio-Computer.
Off / Audio in

Audio-MIU Setting the Audio MIU.
Off / Audio in / Audio MIU
Audio-S-Video Setting the Audio Video.
Off / Audio in
Audio-Video Setting the Audio Video.
Off / Audio in

60




[SCREEN] Tab

Function

General Description

Language

Setting the Language.
English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[4]: Decrease the horizontal menu position.
[V]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On
Message Setting Message.
Off / On
Template Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4
Reset Initialize the selected Function.
Menu Position V / Menu Position H
[Execute]: After the confirmation message, the selected Function will be initialized.
[OPTION] Tab
Function General Description

Auto Search

Setting Auto Search.
Off / On

Auto Keystone

Execute Auto Keystone.

Auto on Setting Auto On.
Off / On

Auto off Setting Auto Off.

[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.

My Button-1 Setting My Button-1.
Computer / Video / S-Video / MIU / Information / Auto Keystone Execute / My Memory /
Picture Mode / Filter Reset / My Image / AV Mute / Volume+ / Volume- / Template /
Live Mode / Thumbnail / Slide Show / Directory / Remove Media / Other

My Button-2 Setting My Button-2.
Computer / Video / S-Video / MIU / Information / Auto Keystone Execute / My Memory /
Picture Mode / Filter Reset / My Image / AV Mute / Volume+ / Volume- / Template /
Live Mode / Thumbnail / Slide Show / Directory / Remove Media / Other

My Source Setting the My Source.
Computer / Video / S-Video / MIU

[Service]

Function General Description

IR Remote Frequency Setting the IR Remote Frequency Normal.

Normal Disable / Enable

IR Remote Frequency Setting the IR Remote Frequency High.

High Disable / Enable

[C.C.]Tab

Function General Description

Display Setting the Closed Caption Display.
Off / On / Auto

Mode Setting the Closed Caption Mode.
Captions / Text

Channel Setting the Closed Caption Channel.
1/2/3/4
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[OTHER] Tab

Function

General Description

Power

Controlling the Power.
Off / On

Input Source

Setting the Input Source.
Computer in / Video / S-Video / MIU

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On
Mute Setting Mute.
Off / On
Freeze Setting Freeze.
Normal / Freeze
Magnify Setting Magnify
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.
Template On/Off Setting Template.
Off / On
My Image Setting the My Image.

Off / Image1 / Image2 / Image3 / Image4

My Image Delete

Deleting the My Image.
Image1 / Image2 / Image3 / Image4
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m CP-A52

[STATUS] Tab

Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Source

Display the Input source status.
Computer1 / Computer2 / Video / S-Video / Component

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error
/ Cold Error / Filter Error / Lens Door Error / Other Error

Blank On/Off

Display the Blank status.
Off / On

Mute

Display the Mute status.
Off / On

Freeze

Display the Freeze status.
Normal / Freeze

Lamp Time

Display the Lamp Time.

Filter Time

Display the Filter Time.

Reset

Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab

Function

General Description

Brightness

Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.

Contrast

Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma

Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

My Memory

Load/Save the My Memory.
Load1/Load2 /Load3 /Load4 / Savel1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Custom - Gamma -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.

User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.
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User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
4:3/16:9/16:10/ 14:9 / Normal
Over Scan Setting the Over Scan
[-]: Decrease the Over scan value.
[+]: Increase the Over scan value.
Position Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[P>]: Decrease the horizontal position.
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H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV / FILM
Video NR Setting the Video NR.
Low / Mid / High
Color Space Setting the Color space.
Auto / RGB / SMPTE240 / REC709 / REC601
Component Setting the Component.

Component / Scart RGB

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

Frame Lock-Computer1

Setting the Frame Lock-Computer1.
Off / On

Frame Lock-Computer2

Setting the Frame Lock-Computer2.
Off / On

Computer in 1

Setting the Computer in-1 Signal Type.
Sync On G Off / Auto

Computer in 2

Setting the Computer in-2 Signal Type.
Sync On G Off / Auto

[SETUP] Tab

Function

General Description

D-Zoom

Setting the D-Zoom.
[-]: Decrease the D-Zoom.
[+]: Increase the D-Zoom.

D-Shift

Setting the D-Shift.

[A]: Increase the D-Shift V.
[V]: Decrease the D-Shift V.
[d]: Decrease the D-Shift H.
[®]: Increase the D-Shift H.

Keystone V

Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.

Keystone H

Setting the Keystone H.
[-]: Decrease the Keystone H value.
[+]: Increase the Keystone H value.

Whisper

Setting the Whisper.
Normal / Whisper

Mirror

Setting the Mirror display.
Normal / H Inverse / V Inverse / H&V Inverse

Standby Mode

Setting the Standby Mode.
Normal / Saving

Monitor Out-Computer1

Setting the Monitor Out-Computer1.
Off / Computer1

Monitor Out-Computer2

Setting the Monitor Out-Computer2.
Off / Computer2

Monitor Out-Component

Setting the Monitor Out-Component.
Off / Computer1 / Computer2

Monitor Out-S-Video

Setting the Monitor Out-Component.
Off / Computer1 / Computer2
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Monitor Out-Video

Setting the Monitor Out-Component.
Off / Computer1 / Computer2

Monitor Out-Standby

Setting the Monitor Out-Component.
Off / Computer1 / Computer2

[Perfect Fit]

Function General Description
Perfect Fit Setting the Perfect Fit.
Off / On
Left Top V Setting the shape of the projected image in Left Top corner.
[-]: Decrease the vertical value.
[+]: Increase the vertical value.
Left Top H Setting the shape of the projected image in Left Top corner.
[-]: Decrease the horizontal value.
[+]: Increase the horizontal value.
Left Bottom V Setting the shape of the projected image in Left Bottom corner.

[-]: Decrease the vertical value.
[+]: Increase the vertical value.

Left Bottom H

Setting the shape of the projected image in Left Bottom corner.
[-]: Decrease the horizontal value.
[+]: Increase the horizontal value.

Right Top V Setting the shape of the projected image in Right Top corner.
[-]: Decrease the vertical value.
[+]: Increase the vertical value.

Right Top H Setting the shape of the projected image in Right Top corner.

[-]: Decrease the horizontal value.
[+]: Increase the horizontal value.

Right Bottom V

Setting the shape of the projected image in Right Bottom corner.
[-]: Decrease the vertical value.
[+]: Increase the vertical value.

Right Bottom H

Setting the shape of the projected image in Right Bottom corner.
[-]: Decrease the horizontal value.
[+]: Increase the horizontal value.

Reset Initialize the selected Function.
Perfect Fit
[Execute]: After the confirmation message, the selected Function will be initialized.
[AUDIO] Tab

Function General Description
Volume Setting the Volume.

[-]: Decrease the Volume.

[+]: Increase the Volume.
Speaker Setting the Speaker.

Off / On

Audio-Computer1

Setting the Audio-Computer1.
Off / Audio1 / Audio2 / Audio3

Audio-Computer2

Setting the Audio-Computer2.
Off / Audio1 / Audio2 / Audio3

Audio-Component

Setting the Audio-Component.
Off / Audio1 / Audio2 / Audio3

Audio-S-Video Setting the Audio-S-Video.

Off / Audio1 / Audio2 / Audio3
Audio-Video Setting the Audio-Video.

Off / Audio1 / Audio2 / Audio3
Audio Out Standby Setting the Audio Out Standby.

Off / Audio1 / Audio2 / Audio3
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[SCREEN] Tab

Function

General Description

Language

Setting the Language.
English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese / Danish / Czech / Hungarian / Romanian /
Slovenian / Croatian / Greek / Lithuanian / Estonian / Latvian / Thai / Arabian /
Persian / Portuguese-Brazil

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[d]: Decrease the horizontal menu position.
[’]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On
Message Setting Message.
Off / On
Template Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4
Reset Initialize the selected Function.
Menu Position V / Menu Position H
[Execute]: After the confirmation message, the selected Function will be initialized.
[OPTION] Tab
Function General Description
Auto Search Setting Auto Search.
Off / On
Auto on Setting Auto On.
Off / On
Auto off Setting Auto Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.
My Button-1 Setting My Button-1.
Computer1 / Computer2 / Video / S-Video / Component / Information / My Memory /
Picture Mode / Filter Reset / AV Mute / Template / Other
My Button-2 Setting My Button-2.
Computer1 / Computer2 / Video / S-Video / Component / Information / My Memory /
Picture Mode / Filter Reset / AV Mute / Template / Other
My Source Setting the My Source.
Computer1 / Computer2 / Video / S-Video / Component
[Service]
Function General Description
IR Remote Frequency Setting the IR Remote Frequency Normal.
Normal Disable / Enable
IR Remote Frequency Setting the IR Remote Frequency High.
High Disable / Enable
[C.C.]Tab
Function General Description
Display Setting the Closed Caption Display.
Off / On / Auto
Mode Setting the Closed Caption Mode.
Captions / Text
Channel Setting the Closed Caption Channel.
1/2/3/4
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[OTHER] Tab

Function

General Description

Power

Controlling the Power.
Off / On

Input Source

Setting the Input Source.
Computer1 / Computer2 / Video / S-Video / Component

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On
Mute Setting Mute.
Off / On
Freeze Setting Freeze.
Normal / Freeze
Magnify Setting Magnify
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.
Template On/Off Setting Template.

Off / On
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Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Status

Display the Input source status.
Computer1 / Computer2 / HDMI / Video / S-Video / Component / MIU

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error
/ Cold Error / Filter Error / Other Error

Blank On/Off

Display the Blank status.
Off / On

Mute

Display the Mute status.
Off / On

Freeze

Display the Freeze status.
Normal / Freeze

Lamp Time

Display the Lamp Time.

Filter Time

Display the Filter Time.

Reset

Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab

Function

General Description

Brightness

Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.

Contrast

Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma

Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

My Memory

Load/Save the My Memory.
Load1/Load2 /Load3 /Load4 / Savel1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Custom - Gamma -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.

User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.
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User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
4:3/16:9/14:9 / Small / Normal
Over Scan Setting the Over Scan
[-]: Decrease the Over scan value.
[+]: Increase the Over scan value.
Position Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[P>]: Decrease the horizontal position.
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H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV / FILM
Video NR Setting the Video NR.
Low / Mid / High
Color Space Setting the Color space.
Auto / RGB / SMPTE240 / REC709 / REC601
Component Setting the Component.

Component / Scart RGB

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

HDMI

Setting the HDMI Signal Type.
Auto / Normal / Enhanced

Frame Lock-Computer1

Setting the Frame Lock-Computer1.

Off / On

Frame Lock-Computer2 Setting the Frame Lock-Computer2.
Off / On

Frame Lock-HDMI Setting the Frame Lock-HDMI.
Off / On

Computer in-1

Setting the Computer in-1 Signal Type.
Sync On G Off / Auto

Computer in-2

Setting the Computer in-2 Signal Type.
Sync On G Off / Auto

[SETUP] Tab

Function

General Description

Auto Keystone Execute

Execute Auto Keystone.

Keystone V

Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.

Keystone H Setting the Keystone H.
[-]: Decrease the Keystone H value.
[+]: Increase the Keystone H value.
Whisper Setting the Whisper.
Normal / Whisper
Mirror Setting the Mirror display.

Normal / H Inverse / V Inverse / H&V Inverse

Standby Mode

Setting the Standby Mode.
Normal / Saving

Monitor Out-Computer1

Setting the Monitor Out-Computer.
Off / Computer1

Monitor Out-Computer2

Setting the Monitor Out-Computer?2.
Off / Computer2

Monitor Out-HDMI

Setting the Monitor Out-HDMI.
Off / Computer1 / Computer2

Monitor Out-MIU

Setting the Monitor Out-MIU.
Off / Computer1 / Computer2

Monitor Out-Component

Setting the Monitor Out-Component.
Off / Computer1 / Computer2

Monitor Out-S-Video

Setting the Monitor Out-S-Video.
Off / Computer1 / Computer2
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Monitor Out-Video

Setting the Monitor Out-Video.
Off / Computer1 / Computer2

Monitor Out-Standby

Setting the Monitor Out Standby.
Off / Computer1 / Computer2

Reset

Initialize the selected Function.
Keystone V / Keystone H
[Execute]: After the confirmation message, the selected Function will be initialized.

[Perfect Fit]

Function General Description
Perfect Fit Setting the Perfect Fit.
Off / On
Left Top V Setting the shape of the projected image in Left Top corner.
[-]: Decrease the vertical value.
[+]: Increase the vertical value.
Left Top H Setting the shape of the projected image in Left Top corner.
[-]: Decrease the horizontal value.
[+]: Increase the horizontal value.
Left Bottom V Setting the shape of the projected image in Left Bottom corner.

[-]: Decrease the vertical value.
[+]: Increase the vertical value.

Left Bottom H

Setting the shape of the projected image in Left Bottom corner.
[-]: Decrease the horizontal value.
[+]: Increase the horizontal value.

Right Top V

Setting the shape of the projected image in Right Top corner.
[-]: Decrease the vertical value.
[+]: Increase the vertical value.

Right Top H

Setting the shape of the projected image in Right Top corner.
[-]: Decrease the horizontal value.
[+]: Increase the horizontal value.

Right Bottom V

Setting the shape of the projected image in Right Bottom corner.
[-]: Decrease the vertical value.
[+]: Increase the vertical value.

Right Bottom H

Setting the shape of the projected image in Right Bottom corner.
[-]: Decrease the horizontal value.
[+]: Increase the horizontal value.

Reset Initialize the selected Function.
Perfect Fit
[Execute]: After the confirmation message, the selected Function will be initialized.
[AUDIO] Tab

Function General Description
Volume Setting the Volume.

[-]: Decrease the Volume.

[+]: Increase the Volume.
Speaker Setting the Speaker.

Off / On

Audio-Computer1

Setting the Audio-Computer1.
Off / Audio1 / Audio2 / Audio3

Audio-Computer2

Setting the Audio-Computer2.
Off / Audio1 / Audio2 / Audio3

Audio-HDMI Setting the Audio-HDMI.
Off / Audio1 / Audio2 / Audio3 / Audio HDMI
Audio-MIU Setting the Audio-MIU.

Off / Audio1 / Audio2 / Audio3 / Audio MIU

Audio-Component

Setting the Audio-Component.
Off / Audio1 / Audio2 / Audio3

Audio-S-Video Setting the Audio-S-Video.

Off / Audio1 / Audio2 / Audio3
Audio-Video Setting the Audio-Video.

Off / Audio1 / Audio2 / Audio3
Audio Out Standby Setting the Audio Out Standby.

Off / Audio1 / Audio2 / Audio3
HDMI Audio Setting the HDMI Audio.

1/2
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[SCREEN] Tab

Function

General Description

Language

Setting the Language.
English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[4]: Decrease the horizontal menu position.
[V]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On
Message Setting Message.
Off / On
Template Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4
[OPTION] Tab
Function General Description
Auto Search Setting Auto Search.
Off / On
Auto Keystone Setting Auto Keystone.
Off / On
Auto on Setting Auto On.
Off / On
Auto off Setting Auto Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.
My Button-1 Setting My Button-1.
Computer1 / Computer2 / HDMI / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / AV Mute / Template /
My Image / Live Mode / Thumbnail / Slide Show / Directory / Remove Media / Other
My Button-2 Setting My Button-2.
Computer1 / Computer2 / HDMI / Video / S-Video / Component / MIU / Information /
Auto Keystone Execute / My Memory / Picture Mode / Filter Reset / AV Mute / Template /
My Image / Live Mode / Thumbnail / Slide Show / Directory / Remove Media / Other
My Source Setting the My Source.
Computer1 / Computer2 / HDMI / Video / S-Video / Component / MIU
[Service]
Function General Description
IR Remote Setting the IR Remote Frequency Normal.
Frequency Normal Disable / Enable
IR Remote Setting the IR Remote Frequency High.
Frequency High Disable / Enable
[C.C.] Tab
Function General Description
Display Setting the Closed Caption Display.
Off / On / Auto
Mode Setting the Closed Caption Mode.
Captions / Text
Channel Setting the Closed Caption Channel.
1/2/3/4
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[OTHER] Tab

Function

General Description

Power

Controlling the Power.
Off / On

Input Source

Setting the Input Source.
Computer1 / Computer2 / HDMI / Video / S-Video / Component / MIU

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On
Mute Setting Mute.
Off / On
Freeze Setting Freeze.
Normal / Freeze
Template On/Off Setting Template.
Off / On
Magnify Setting Magnify
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.
My Image Setting the My Image.

Off / Image1 / Image2 / Image3 / Image4

My Image Delete

Deleting the My Image.
Image1 / Image2 / Image3 / Image4
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[STATUS] Tab

Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Source

Display the Input source status.
RGB1/RGB2 / HDMI / Video / S-Video / Component

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error
/ Cold Error / Filter Error / Other Error

Blank On/Off

Display the Blank status.
Off / On

Mute

Display the Mute status.
Off / On

Freeze

Display the Freeze status.
Normal / Freeze

Lamp Time

Display the Lamp Time.

Filter Time

Display the Filter Time.

Reset

Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab

Function

General Description

Brightness

Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.

Contrast

Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma

Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

Active Iris

Setting the Active lIris.
Off / Theater / Presentation

My Memory

Load/Save the My Memory.
Load1/Load2 /Load3 /Load4 / Save1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Custom - Gamma -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.
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User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.

User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 6

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 7

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 8

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
4:3/16:9/16:10/ 14:9 / Real / Normal

Over Scan Setting the Over Scan

[-]: Decrease the Over scan value.

[+]: Increase the Over scan value.
Position Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[P>]: Decrease the horizontal position.
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H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV / FILM
Video NR Setting the Video NR.
Low / Mid / High
3D-YCS Setting the 3D-YCS
Off / Movie / Still Image
Color Space Setting the Color space.
Auto / RGB / SMPTE240 / REC709 / REC601
Component Setting the Component.

Component / Scart RGB

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

HDMI

Setting the HDMI Signal Type.
Auto / Normal / Enhanced

Frame Lock-RGB1

Setting the Frame Lock-RGB1.

Off / On

Frame Lock-RGB2 Setting the Frame Lock-RGB2.
Off / On

Frame Lock-HDMI Setting the Frame Lock-HDMI.
Off / On

RGB in-1 Setting the RGB IN-1 Signal Type.
Sync On G Off / Auto

RGB in-2 Setting the RGB IN-2 Signal Type.
Sync On G Off / Auto

[SETUP] Tab
Function General Description

Auto Keystone Execute

Execute Auto Keystone.

Keystone V

Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.

Keystone H

Setting the Keystone H.
[-]: Decrease the Keystone H value.
[+]: Increase the Keystone H value.

Whisper

Setting the Whisper.
Normal / Whisper

Mirror

Setting the Mirror display.
Normal / H Inverse / V Inverse / H&V Inverse

Monitor Out-RGB1

Setting the Monitor Out-RGB1.
Off / RGB1

Monitor Out-RGB2

Setting the Monitor Out-RGB2.
Off  RGB2

Monitor Out-HDMI

Setting the Monitor Out-HDMI.
Off / RGB1/RGB2

Monitor Out-Component

Setting the Monitor Out-Component.
Off / RGB1/RGB2

Monitor Out-S-Video

Setting the Monitor Out-S-Video.
Off / RGB1/RGB2

Monitor Out-Video

Setting the Monitor Out-Video.
Off / RGB1/ RGB2
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Monitor Out-Standby

Setting the Monitor Out Standby.
Off / RGB1/RGB2

Reset Initialize the selected Function.
Keystone V / Keystone H
[Execute]: After the confirmation message, the selected Function will be initialized.
[AUDIO] Tab
Function General Description
Volume Setting the Volume.
[-]: Decrease the Volume.
[+]: Increase the Volume.
Treble Setting the Treble.
[-]: Decrease the Treble.
[+]: Increase the Treble.
Bass Setting the Bass.
[-]: Decrease the Bass.
[+]: Increase the Bass.
Speaker Setting the Speaker.
Off / On
Audio-RGB1 Setting the Audio-RGB1.
Off / Audio1 / Audio2 / Audio3 / Audio4
Audio-RGB2 Setting the Audio-RGB2.
Off / Audio1 / Audio2 / Audio3 / Audio4
Audi-HDMI Setting the Audio-HDMI.

Off / Audio?1 / Audio2 / Audio3 / Audio4 / Audio HDMI

Audio-Component

Setting the Audio-Component.
Off / Audio1 / Audio2 / Audio3 / Audio4

Audio-S-Video Setting the Audio-S-Video.

Off / Audio1 / Audio2 / Audio3 / Audio4
Audio-Video Setting the Audio-Video.

Off / Audio1 / Audio2 / Audio3 / Audio4
Audio Out Standby Setting the Audio Out Standby.

Off / Audio1 / Audio2 / Audio3 / Audio4
HDMI Audio Setting the HDMI Audio.

1/2

[SCREEN] Tab

Function General Description
Language Setting the Language.

English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[d]: Decrease the horizontal menu position.
[’]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On
Message Setting Message.

Off / On
Template Setting the Template.

Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4
Reset Initialize the selected Function.

Menu Position V / Menu Position H
[Execute]: After the confirmation message, the selected Function will be initialized.
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[OPTION] Tab

Function

General Description

Auto Search Setting Auto Search.
Off / On
Auto Keystone Setting Auto Keystone.
Off / On
Auto On Setting Auto On.
Off / On
Auto Off Setting Auto Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.
My Button-1 Setting My Button-1.
RGB1/RGB2 / HDMI / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Active Iris / My Image / AV Mute / Template / Other
My Button-2 Setting My Button-2.
RGB1/RGB2 / HDMI / Video / S-Video / Component / Information / Auto Keystone Execute /
My Memory / Picture Mode / Filter Reset / Active Iris / My Image / AV Mute / Template / Other
My Source Setting the My Source.
RGB1/RGB2 / HDMI / Video / S-Video / Component
[Service]
Function General Description
IR Remote Setting the IR Remote.
Front (Off / On)
Rear (Off / On)
Top (Off / On)
IR Remote Setting the IR Remote Frequency Normal.
Frequency Normal Disable / Enable
IR Remote Setting the IR Remote Frequency High.
Frequency High Disable / Enable
[C.C.]Tab
Function General Description
Display Setting the Closed Caption Display.
Off / On / Auto
Mode Setting the Closed Caption Mode.
Captions / Text
Channel Setting the Closed Caption Channel.
1/2/3/4
[OTHER] Tab
Function General Description
Power Controlling the Power.

Off / On

Input Source

Setting the Input Source.
RGB1/RGB2 / HDMI / Video / S-Video / Component

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On
Mute Setting Mute.
Off / On
Freeze Setting Freeze.
Normal / Freeze
Template On/Off Setting Template.
Off / On
Magnify Setting Magnify
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.
My Image Setting the My Image.

Off / Image1 / Image2 / Image3 / Image4

My Image Delete

Deleting the My Image.
Image1 / Image2 / Image3 / Image4
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m CP-X2010/CP-X2010N / CP-X2510 / CP-X2510N / CP-X3010 / CP-X3010N

[STATUS] Tab

Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Source

Display the Input source status.
Computer in1 / Computer in2 / Video / S-Video / Component

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error
/ Cold Error / Filter Error / Other Error

Blank On/Off

Display the Blank status.
Off / On

Mute

Display the Mute status.
Off / On

Freeze

Display the Freeze status.
Normal / Freeze

Lamp Time

Display the Lamp Time.

Filter Time

Display the Filter Time.

Reset

Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab

Function

General Description

Brightness

Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.

Contrast

Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma

Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

Active Iris

Setting the Active lIris.
Off / Theater / Presentation
» This Function is not displayed for CP-X2010 / CP-X2010N.

My Memory

Load/Save the My Memory.
Load1 /Load2 / Load3 / Load4 / Save1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Custom - Gamma -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.
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User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.

User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.
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[IMAGE] Tab

Function General Description
Aspect Setting the Aspect.
4:3/16:9/16:10/ 14:9 / Normal
Over Scan Setting the Over Scan
[-]: Decrease the Over scan value.
[+]: Increase the Over scan value.
Position Setting the display position.
[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[P>]: Decrease the horizontal position.
H Phase Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.
H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off /| TV /FILM
Video NR Setting the Video NR.
Low / Mid / High
Color Space Setting the Color space.
Auto / RGB / SMPTE240 / REC709 / REC601
Component Setting the Component.

Component / Scart RGB

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

Computer in1

Setting the Computer in-1 Signal Type.
Sync On G Off / Auto

Computer in2

Setting the Computer in-2 Signal Type.
Sync On G Off / Auto

Frame Lock - Computer

Setting the Frame Lock-Computer in1.

in1 Off / On
Frame Lock - Computer | Setting the Frame Lock-Computer in2.
in2 Off / On
[SETUP] Tab
Function General Description

Auto Keystone Execute

Execute Auto Keystone.

Keystone V

Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.

Eco Mode Setting the Eco Mode.
Normal / Eco
Mirror Setting the Mirror display.

Normal / H Inverse / V Inverse / H&V Inverse

Standby Mode

Setting the Standby Mode.
Normal / Saving

Monitor Out - Computer
in1

Setting the Monitor Out-Computer in1.
Off / Computer in1

Monitor Out - Computer
in2

Setting the Monitor Out-Computer in2.
Off / Computer in2

Monitor Out - Component

Setting the Monitor Out-Component.
Off / Computer in1 / Computer in2

Monitor Out - S-Video

Setting the Monitor Out-S-Video.
Off / Computer in1 / Computer in2
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Monitor Out - Video

Setting the Monitor Out-Video.
Off / Computer in1 / Computer in2

Monitor Out - Standby

Setting the Monitor Out Standby.
Off / Computer in1 / Computer in2

Reset Initialize the selected Function.
Keystone V
[Execute]: After the confirmation message, the selected Function will be initialized.
[AUDIO] Tab

Function General Description
Volume Setting the Volume.

[-]: Decrease the Volume.

[+]: Increase the Volume.
Speaker Setting the Speaker.

Off / On

Audio Source -
Computer in1

Setting the Audio-Computer in1.
Off / Audio1 / Audio2 / Audio3

Audio Source -
Computer in2

Setting the Audio-Computer in2.
Off / Audio1 / Audio2 / Audio3

Audio Source -
Component

Setting the Audio-Component.
Off / Audio1 / Audio2 / Audio3

Audio Source - S-Video

Setting the Audio-S-Video.
Off / Audio1 / Audio2 / Audio3

Audio Source - Video

Setting the Audio-Video.
Off / Audio1 / Audio2 / Audio3

Audio Out Standby Setting the Audio Out Standby.
Off / Audio1 / Audio2 / Audio3
[SCREEN] Tab
Function General Description
Language Setting the Language.

English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese / Danish / Czech / Hungarian / Romanian /

Slovenian / Croatian / Greek / Lithuanian / Estonian / Latvian / Thai / Arabian /
Persian / Portuguese-Brazil

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[4]: Decrease the horizontal menu position.
[’]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On

Message Setting Message.
Off / On

Template Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4

C.C. - Display Setting the Closed Caption Display.
Off / On / Auto

C.C. - Mode Setting the Closed Caption Mode.
Captions / Text

C.C. - Channel Setting the Closed Caption Channel.
1/2/3/4

Reset Initialize the selected Function.

Menu Position V / Menu Position H
[Execute]: After the confirmation message, the selected Function will be initialized.
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[OPTION] Tab

Function

General Description

Auto Search

Setting Auto Search.
Off / On

Auto Keystone

Execute Auto Keystone.

Direct On

Setting Direct On.
Off / On

Auto Off

Setting Auto Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.

My Button-1

Setting My Button-1.
Computer in1 / Computer in2 / Video / S-Video / Component / Information /
Auto Keystone Execute / My Memory / Active Iris / Picture Mode / Filter Reset / AV Mute /
Template / My Image / Messenger

» Active Iris is not displayed for CP-X2010 / CP-X2010N.

My Button-2

Setting My Button-2.
Computer in1 / Computer in2 / Video / S-Video / Component / Information /
Auto Keystone Execute / My Memory / Active Iris / Picture Mode / Filter Reset / AV Mute /
Template / My Image / Messenger

» Active Iris is not displayed for CP-X2010 / CP-X2010N.

My Source

Setting the My Source.
Computer in1 / Computer in2 / Video / S-Video / Component

[Service]

Function

General Description

IR Remote Frequency

Setting the IR Remote Frequency Normal.

Normal Disable / Enable
IR Remote Frequency Setting the IR Remote Frequency High.
High Disable / Enable
[OTHER] Tab
Function General Description
Power Controlling the Power.

Off / On

Input Source

Setting the Input Source.
Computer in1 / Computer in2 / Video / S-Video / Component

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On
Mute Setting Mute.
Off / On
Freeze Setting Freeze.
Normal / Freeze
Template On/Off Setting Template.
Off / On
Magnify Setting Magnify
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.
My Image Setting the My Image.

Off / Image1 / Image2 / Image3 / Image4

My Image Delete

Deleting the My Image.
Image1 / Image2 / Image3 / Image4
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m CP-X10000 / CP-WX11000 / CP-SX12000

[STATUS] Tab
Function General Description
Power Status Display the Power Status.
Off / On / Cool down
Input Source Display the Input source status.
Computer in1 / Computer in2 / HDMI / Video1 / Video 2 / S-Video / Component /
BNC /DVI-D
Error Status Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error
/ Cold Error / Filter Error / Shutter Error / Other Error
Blank On/Off Display the Blank status.
Off / On
Freeze Display the Freeze status.
Normal / Freeze
Lamp Time Display the Lamp Time.
Filter Time Display the Filter Time.
Reset Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.
[PICTURE] Tab
Function General Description
Brightness Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.
Contrast Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.
Gamma Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default
Color Temp Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3
Color Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value
Tint Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.
Sharpness Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.
Active Iris Setting the Active Iris.
Manual / Theater / Presentation
My Memory Load/Save the My Memory.
Load1 /Load2 / Load3 / Load4 / Save1 / Save2 /| Save3 / Save4
[Execute]: Load / Save the selected Function.
Reset Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.
[Custom - Gamma -]
Function General Description
User Gamma Pattern Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp
User Gamma Point 1 Setting the User Gamma Point 1.
[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.
User Gamma Point 2 Setting the User Gamma Point 2.
[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.
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User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
4:3/16:9/16:10/ 14:9 / Normal / Small / Native / Full
» Small is not displayed for CP-WX11000.
» Native is not displayed for CP-X10000.
» Full is not displayed for CP-X10000 and CP-SX12000.
Over Scan Setting the Over Scan

[-]: Decrease the Over scan value.
[+]: Increase the Over scan value.
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Position Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[d: Increase the horizontal position.
[’]: Decrease the horizontal position.

H Phase Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.

Auto Adjust Execute Auto Adjust.

Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.

[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV / FILM
Video NR Setting the Video NR.
Low / Mid / High
3D-YCS Setting the 3D-YCS
Off / Movie / Still Image
Color Space Setting the Color space.
Auto / RGB / SMPTE240 / REC709 / REC601
Component Setting the Component.
Component / Scart RGB
S-Video Format Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL
Video 1 Format Setting the Video 1 Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL
Video 2 Format Setting the Video 2 Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL
HDMI Format Setting the HDMI Format.
Auto / Video / Computer
DVI-D Format Setting the DVI-D Format.
Auto / Video / Computer
HDMI Range Setting the HDMI Range.
Auto / Normal / Enhanced
DVI-D Range Setting the DVI-D Range.
Auto / Normal / Enhanced
Computer in 1 Setting the Computer in-1 Signal Type.
Sync On G Off / Auto
Computer in 2 Setting the Computer in-2 Signal Type.
Sync On G Off / Auto
BNC Setting the BNC Signal Type.

Sync On G Off / Auto

Frame Lock - Computer | Setting the Frame Lock-Computer in1.

in 1 Off / On

Frame Lock - Computer | Setting the Frame Lock-Computer in2.

in 2 Off / On

Frame Lock - BNC Setting the Frame Lock-BNC.
Off / On

Frame Lock - HDMI Setting the Frame Lock-HDMI.
Off / On

Frame Lock - DVI-D Setting the Frame Lock-DVI-D.
Off / On

[SETUP] Tab

Function General Description

Auto Keystone Execute Execute Auto Keystone.

Keystone V Setting the Keystone V.

[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.
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Keystone H

Setting the Keystone H.
[-]: Decrease the Keystone H value.
[+]: Increase the Keystone H value.

Eco Mode Setting the Eco Mode.
Normal / Eco
Mirror Setting the Mirror display.

Normal / H Inverse / V Inverse / H&V Inverse

Monitor Out - Computer
in1

Setting the Monitor Out-Computer in1.
Off / Computer on1 // Computer in2 / BNC

Monitor Out - Computer
in 2

Setting the Monitor Out-Computer in2.
Off / Computer on1 // Computer in2 / BNC

Monitor Out - BNC

Setting the Monitor Out-BNC.
Off / Computer on1 // Computer in2 / BNC

Monitor Out - HDMI

Setting the Monitor Out-HDMI.
Off / Computer on1 // Computer in2 / BNC

Monitor Out - DVI-D

Setting the Monitor Out-DVI-D.
Off / Computer on1 // Computer in2 / BNC

Monitor Out - Component

Setting the Monitor Out-Component.
Off / Computer on1 // Computer in2 / BNC

Monitor Out - S-Video

Setting the Monitor Out-S-Video.
Off / Computer on1 // Computer in2 / BNC

Monitor Out - Video 1

Setting the Monitor Out-Video 1.
Off / Computer on1 // Computer in2 / BNC

Monitor Out - Video 2

Setting the Monitor Out-Video 2.
Off / Computer on1 // Computer in2 / BNC

Monitor Out - Standby

Setting the Monitor Out Standby.
Off / Computer on1 // Computer in2 / BNC

Reset Initialize the selected Function.
Keystone V / Keystone H
[Execute]: After the confirmation message, the selected Function will be initialized.
[SCREEN] Tab
Function General Description
Language Setting the Language.

English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese / Danish / Czech / Arabian / Persian

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[d]: Decrease the horizontal menu position.
[’]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On

Message Setting Message.
Off / On

Template Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4

C.C. - Display Setting the Closed Caption Display.
Off / On / Auto

C.C. - Mode Setting the Closed Caption Mode.
Captions / Text

C.C. - Channel Setting the Closed Caption Channel.
1/2/3/4

Reset Initialize the selected Function.

Menu Position V / Menu Position H
[Execute]: After the confirmation message, the selected Function will be initialized.

88




[OPTION] Tab

Function

General Description

Source Skip - Computer

Setting the Source Skip-Computer in1.

in 1 Normal / Skip
Source Skip - Computer | Setting the Source Skip-Computer in2.
in 2 Normal / Skip
Source Skip - BNC Setting the Source Skip-BNC.
Normal / Skip
Source Skip - HDMI Setting the Source Skip-HDMI.
Normal / Skip
Source Skip - DVI-D Setting the Source Skip-DVI-D.
Normal / Skip
Source Skip - Component | Setting the Source Skip-Component.
Normal / Skip
Source Skip - S-Video Setting the Source Skip-S-Video.
Normal / Skip
Source Skip - Video 1 Setting the Source Skip-Video 1.
Normal / Skip
Source Skip - Video 2 Setting the Source Skip-Video 2.
Normal / Skip
Auto Search Setting Auto Search.
Off / On
Auto Keystone Setting Auto Keystone.
Off / On
Direct On Setting Direct On.
Off / On
Auto Off Setting Auto Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.
Shutter Timer Setting Shutter Timer.
1h/3h/6h
My Button-1 Setting My Button-1.
Computer in1 / Computer in2 / BNC / HDMI / DVI-D / Video1 / Video2 / S-Video / Component /
Information / Auto Keystone Execute / My Memory / Active Iris / Picture Mode / Filter Reset /
Template / PbyP Swap / Lens Memory-1/ Lens Memory-2 / Lens Memory-3 / My Image
My Button-2 Setting My Button-2.
Computer in1 / Computer in2 / BNC / HDMI / DVI-D / Video1 / Video2 / S-Video / Component /
Information / Auto Keystone Execute / My Memory / Active Iris / Picture Mode / Filter Reset /
Template / PbyP Swap / Lens Memory-1/ Lens Memory-2 / Lens Memory-3 / My Image
My Button-3 Setting My Button-3.
Computer in1 / Computer in2 / BNC / HDMI / DVI-D / Video1 / Video2 / S-Video / Component /
Information / Auto Keystone Execute / My Memory / Active Iris / Picture Mode / Filter Reset /
Template / PbyP Swap / Lens Memory-1 / Lens Memory-2 / Lens Memory-3 / My Image
My Button-4 Setting My Button-4.
Computer in1 / Computer in2 / BNC / HDMI / DVI-D / Video1 / Video2 / S-Video / Component /
Information / Auto Keystone Execute / My Memory / Active Iris / Picture Mode / Filter Reset /
Template / PbyP Swap / Lens Memory-1/ Lens Memory-2 / Lens Memory-3 / My Image
My Source Setting the My Source.
Computer in1 / Computer in2 / HDMI / Video1 / Video 2 / S-Video / Component /
BNC / DVI-D
[Service]
Function General Description
IR Remote Setting the IR Remote.

Front (Off / On)
Rear (Off / On)
Top (Off / On)

IR Remote Frequency

Setting the IR Remote Frequency Normal.

Normal Disable / Enable

IR Remote Frequency Setting the IR Remote Frequency High.

High Disable / Enable

Remote ID Setting the IR Remote ID.
All/1/2/3/4
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[OTHER] Tab

Function

General Description

Power

Controlling the Power.
Off / On

Input Source

Setting the Input Source.
Computer in1 / Computer in2 / HDMI / Video1 / Video 2 / S-Video / Component /
BNC /DVI-D

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On
Freeze Setting Freeze.
Normal / Freeze
Magnify Setting Magnify
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.
Template On/Off Setting Template.
Off / On
Shutter Setting Shutter.
Off / On
Zoom Setting the Zoom.
[-]: Decrease the Zoom.
[+]: Increase the Zoom.
Focus Setting Focus.
Lens Shift Setting the Lens Shift.

[A]: Increase the Lens Shift V.
[V]: Decrease the Lens Shift V.
[4]: Decrease the Lens Shift H.
[’]: Increase the Lens Shift H.

Lens Memory

Load/Save the Lens Memory data.
Load-1/Load-2 / Load-3 / Save-1 / Save-2 / Save-3 / Clear-1/ Clear-2 / Clear-3
[Execute]: Load / Save the selected Function.

PbyP

Setting PbyP.
Off / On

PbyP Left Source

Setting PbyP Left Source.
Computer in1 / Computer in2 / HDMI / Video1 / Video 2 / S-Video / Component /
BNC / DVI-D

PbyP Right Source

Setting PbyP Right Source.
Computer in1 / Computer in2 / HDMI / Video1 / Video 2 / S-Video / Component /
BNC / DVI-D

PbyP Main Area

Setting PbyP Main Area.
Left / Right

My Image

Setting the My Image.
Off / Image1 / Image2 / Image3 / Image4

My Image Delete

Deleting the My Image.
Image1 / Image2 / Image3 / Image4
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[STATUS] Tab

Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Source

Display the Input source status.
Computer in1 / Computer in2 / Video / S-Video / Component

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error /
Cold Error / Filter Error / Other Error

Blank On/Off

Display the Blank status.
Off / On

Mute

Display the Mute status.
Off / On

Freeze

Display the Freeze status.
Normal / Freeze

Lamp Time

Display the Lamp Time.

Filter Time

Display the Filter Time.

Reset

Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab

Function

General Description

Brightness

Setting the Brightness.
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.

Contrast

Setting the Contrast.
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma

Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

Active Iris

Setting the Active lIris.
Off / Theater / Presentation

My Memory

Load/Save the My Memory.
Load1/Load2 /Load3 /Load4 / Save1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Custom - Gamma -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.

User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.
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User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
4:3/16:9/16:10/ 14:9 / Normal
Over Scan Setting the Over Scan
[-]: Decrease the Over scan value.
[+]: Increase the Over scan value.
Position Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[P>]: Decrease the horizontal position.
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H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV / FILM
Video NR Setting the Video NR.
Low / Mid / High
Color Space Setting the Color space.
Auto / RGB / SMPTE240 / REC709 / REC601
Component Setting the Component.

Component / Scart RGB

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

Computer in1

Setting the Computer in-1 Signal Type.
Sync On G Off / Auto

Computer in2

Setting the Computer in-2 Signal Type.
Sync On G Off / Auto

Frame Lock - Computer

Setting the Frame Lock-Computer in1.

in1 Off / On
Frame Lock - Computer | Setting the Frame Lock-Computer in2.
in2 Off / On
[SETUP] Tab
Function General Description

Auto Keystone Execute

Execute Auto Keystone.

Keystone V

Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.

Eco Mode Setting the Eco Mode.
Normal / Eco
Mirror Setting the Mirror display.

Normal / H:Invert / V:Invert / H&V:Invert

Standby Mode

Setting the Standby Mode.
Normal / Saving

Monitor Out - Computer
in1

Setting the Monitor Out-Computer in1.
Off / Computer in1

Monitor Out - Computer
in2

Setting the Monitor Out-Computer in2.
Off / Computer in2

Monitor Out - Component

Setting the Monitor Out-Component.
Off / Computer in1 / Computer in2

Monitor Out - S-Video

Setting the Monitor Out-S-Video.
Off / Computer in1 / Computer in2

Monitor Out - Video

Setting the Monitor Out-Video.
Off / Computer in1 / Computer in2

Monitor Out - Standby

Setting the Monitor Out Standby.
Off / Computer in1 / Computer in2

Reset

Initialize the selected Function.
Keystone V
[Execute]: After the confirmation message, the selected Function will be initialized.
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[AUDIO] Tab

Function General Description
Volume Setting the Volume.
[-]: Decrease the Volume.
[+]: Increase the Volume.
Speaker Setting the Speaker.

Off / On

Audio Source -
Computer in1

Setting the Audio-Computer in1.
Off / Audio1 / Audio2 / Audio3

Audio Source -
Computer in2

Setting the Audio-Computer in2.
Off / Audio1 / Audio2 / Audio3

Audio Source -
Component

Setting the Audio-Component.
Off / Audio1 / Audio2 / Audio3

Audio Source - S-Video

Setting the Audio-S-Video.
Off / Audio1 / Audio2 / Audio3

Audio Source - Video

Setting the Audio-Video.
Off / Audio1 / Audio2 / Audio3

Audio Out Standby Setting the Audio Out Standby.
Off / Audio1 / Audio2 / Audio3
[SCREEN] Tab
Function General Description
Language Setting the Language.

English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese / Danish / Czech / Hungarian / Romanian /
Slovenian / Croatian / Greek / Lithuanian / Estonian / Latvian / Thai / Arabian /
Persian / Portuguese -Brazil

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[4]: Decrease the horizontal menu position.
[P>]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On
Message Setting Message.
Off / On
Template Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4
C.C. - Display Setting the Closed Caption Display.
Off / On / Auto
C.C. - Mode Setting the Closed Caption Mode.
Captions / Text
C.C. - Channel Setting the Closed Caption Channel.
1/2/3/4
Reset Initialize the selected Function.
Menu Position V / Menu Position H
[Execute]: After the confirmation message, the selected Function will be initialized.
[OPTION] Tab
Function General Description
Auto Search Setting Auto Search.
Off / On
Auto Keystone Setting Auto Keystone.
Off / On
Direct On Setting Direct On.
Off / On
Auto Off Setting Auto Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.
My Button-1 Setting My Button-1.

Computer in1 / Computer in2 / Video / S-Video / Component / Information /
Auto Keystone Execute / My Memory / Active Iris / Picture Mode / Filter Reset /
AV Mute / Template
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My Button-2

Setting My Button-2.
Computer in1 / Computer in2 / Video / S-Video / Component / Information /
Auto Keystone Execute / My Memory / Active Iris / Picture Mode / Filter Reset /
AV Mute / Template

My Source Setting the My Source.
Computer in1 / Computer in2 / Video / S-Video / Component
[Service]
Function General Description

IR Remote Frequency

Setting the IR Remote Frequency Normal.

Normal Off / On
IR Remote Frequency Setting the IR Remote Frequency High.
High Off / On
[OTHER] Tab
Function General Description
Power Controlling the Power.

Off / On

Input Source

Setting the Input Source.
Computer in1 / Computer in2 / Video / S-Video / Component

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On

Mute Setting Mute.
Off / On

Freeze Setting Freeze.
Normal / Freeze

Template On/Off Setting Template.
Off / On

Magnify Setting Magnify.

[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.
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[STATUS] Tab

Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Source

Display the Input source status.
Computer in1 / Computer in2 / Video / S-Video

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error /
Cold Error / Filter Error / Other Error

Blank On/Off

Display the Blank status.
Off / On

Mute

Display the Mute status.
Off / On

Freeze

Display the Freeze status.
Normal / Freeze

Lamp Time

Display the Lamp Time.

Filter Time

Display the Filter Time.

Reset

Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab

Function

General Description

Brightness

Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.

Contrast

Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma

Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

My Memory

Load/Save the My Memory.
Load1/Load2 /Load3 /Load4 / Savel1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Custom - Gamma -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.

User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.
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User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
4:3/16:9/16:10/ 14:9 / Native / Normal

Over Scan Setting the Over Scan

[-]: Decrease the Over scan value.

[+]: Increase the Over scan value.
Position Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[P>]: Decrease the horizontal position.
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H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV /FILM
Video NR Setting the Video NR.
Low / Mid / High
Color Space Setting the Color space.

Auto / RGB / SMPTE240 / REC709 / REC601

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

Computer in1

Setting the Computer in-1 Signal Type.
Sync On G Off / Auto

Computer in2

Setting the Computer in-2 Signal Type.
Sync On G Off / Auto

Frame Lock - Computer

Setting the Frame Lock-Computer in1.

in1 Off / On
Frame Lock - Computer | Setting the Frame Lock-Computer in2.
in2 Off / On
[SETUP] Tab
Function General Description
D-Zoom Setting the D-Zoom.
[-]: Decrease the D-Zoom.
[+]: Increase the D-Zoom.
D-Shift Setting the D-Shift.

[A]: Increase the D-Shift V.
[V]: Decrease the D-Shift V.
[4): Decrease the D-Shift H.
[P]: Increase the D-Shift H.

Picture Position

Setting the Picture Position.
Top / Mid / Bottom

Keystone V Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.
Eco Mode Setting the Eco Mode.
Normal / Eco
Mirror Setting the Mirror display.

Normal / H:Invert / V:Invert / H&V:Invert

Standby Mode

Setting the Standby Mode.
Normal / Saving

Monitor Out - Computer
in1

Setting the Monitor Out-Computer in1.
Off / Computer in1

Monitor Out - Computer
in2

Setting the Monitor Out-Computer in2.
Off / Computer in2

Monitor Out - S-Video

Setting the Monitor Out-S-Video.
Off / Computer in1 / Computer in2

Monitor Out - Video

Setting the Monitor Out-Video.
Off / Computer in1 / Computer in2

Monitor Out - Standby

Setting the Monitor Out Standby.
Off / Computer in1 / Computer in2

Reset

Initialize the selected Function.
D-Zoom / D-Shift V / D-Shift H / Keystone V
[Execute]: After the confirmation message, the selected Function will be initialized.
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[AUDIO] Tab

Function General Description
Volume Setting the Volume.
[-]: Decrease the Volume.
[+]: Increase the Volume.
Speaker Setting the Speaker.

Off / On

Audio Source -
Computer in1

Setting the Audio-Computer in1.
Off / Audio1 / Audio2 / Audio3

Audio Source -
Computer in2

Setting the Audio-Computer in2.
Off / Audio1 / Audio2 / Audio3

Audio Source - S-Video

Setting the Audio-S-Video.
Off / Audio1 / Audio2 / Audio3

Audio Source - Video

Setting the Audio-Video.
Off / Audio1 / Audio2 / Audio3

Audio Out Standby Setting the Audio Out Standby.
Off / Audio1 / Audio2 / Audio3
[SCREEN] Tab
Function General Description
Language Setting the Language.

English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese / Danish / Czech / Hungarian / Romanian /
Slovenian / Croatian / Greek / Lithuanian / Estonian / Latvian / Thai / Arabian /
Persian / Portuguese-Brazil

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[4]: Decrease the horizontal menu position.
[’]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On

Message Setting Message.
Off / On

Template Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4 / Circle1 / Circle2 /
Map1 / Map2

C.C. - Display Setting the Closed Caption Display.
Off / On / Auto

C.C. - Mode Setting the Closed Caption Mode.
Captions / Text

C.C. - Channel Setting the Closed Caption Channel.
1/2/3/4

Reset Initialize the selected Function.
Menu Position V / Menu Position H

[Execute]: After the confirmation message, the selected Function will be initialized.
[OPTION] Tab

Function General Description

Auto Search Setting Auto Search.
Off / On

Direct Power On Setting Direct Power On.
Off / On

Auto Power Off

Setting Auto Power Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.

My Button-1 Setting My Button-1.

Computer in1/ Computer in2 / Video / S-Video / Information / My Memory /

Picture Mode / Filter Reset / AV Mute / Template / D-Zoom / D-Shift / Resolution / Other
My Button-2 Setting My Button-2.

Computer in1 / Computer in2 / Video / S-Video / Information / My Memory /
Picture Mode / Filter Reset / AV Mute / Template / D-Zoom / D-Shift / Resolution / Other
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My Source Setting the My Source.
Computer in1 / Computer in2 / Video / S-Video

[Service]

Function General Description

IR Remote Frequency Setting the IR Remote Frequency Normal.

Normal Off / On

IR Remote Frequency Setting the IR Remote Frequency High.

High Off / On
[OTHER] Tab

Function General Description

Power Controlling the Power.

Off / On

Input Source

Setting the Input Source.
Computer in1 / Computer in2 / Video / S-Video

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On

Mute Setting Mute.
Off / On

Freeze Setting Freeze.
Normal / Freeze

Template On/Off Setting Template.
Off / On

Magnify Setting Magnify

[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

Magnify Position V

Setting Magnify Position V.
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

Magnify Position H

Setting Magnify Position H.
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.
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m CP-DW10N

[STATUS] Tab

Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Source

Display the Input source status.
Computer in1 / Computer in2 / HDMI / Video / S-Video

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error /
Cold Error / Filter Error / Other Error

Blank On/Off

Display the Blank status.
Off / On

Mute

Display the Mute status.
Off / On

Freeze

Display the Freeze status.
Normal / Freeze

Lamp Time

Display the Lamp Time.

Filter Time

Display the Filter Time.

Reset

Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab

Function

General Description

Brightness

Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.

Contrast

Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma

Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

My Memory

Load/Save the My Memory.
Load1/Load2 /Load3 /Load4 / Savel1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Custom - Gamma -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.

User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.
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User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
4:3/16:9/16:10/ 14:9 / Native / Normal

Over Scan Setting the Over Scan

[-]: Decrease the Over scan value.

[+]: Increase the Over scan value.
Position Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[P>]: Decrease the horizontal position.
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H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV /FILM
Video NR Setting the Video NR.
Low / Mid / High
Color Space Setting the Color space.

Auto / RGB / SMPTE240 / REC709 / REC601

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

HDMI Format Setting the HDMI Format.
Auto / Video / Computer
HDMI Range Setting the HDMI Range.

Auto / Normal / Enhanced

Computer in1

Setting the Computer in-1 Signal Type.
Sync On G Off / Auto

Computer in2

Setting the Computer in-2 Signal Type.
Sync On G Off / Auto

Frame Lock - Computer

Setting the Frame Lock-Computer in1.

in1 Off / On
Frame Lock - Computer | Setting the Frame Lock-Computer in2.
in2 Off / On
Frame Lock - HDMI Setting the Frame Lock-HDMI.
Off / On
[SETUP] Tab
Function General Description
D-Zoom Setting the D-Zoom.
[-]: Decrease the D-Zoom.
[+]: Increase the D-Zoom.
D-Shift Setting the D-Shift.
[A]: Increase the D-Shift V.
[V]: Decrease the D-Shift V.
[4]: Decrease the D-Shift H.
[’]: Increase the D-Shift H.
Pict. Posit. H Setting the Picture Position H.
Left / Mid / Right
Keystone V Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.
Eco Mode Setting the Eco Mode.
Normal / Eco
Mirror Setting the Mirror display.

Normal / H:Invert / V:Invert / H&V:Invert

Standby Mode

Setting the Standby Mode.
Normal / Saving

Monitor Out - Computer
in1

Setting the Monitor Out-Computer in1.
Off / Computer in1

Monitor Out - Computer
in2

Setting the Monitor Out-Computer in2.
Off / Computer in2

Monitor Out - HDMI

Setting the Monitor Out-HDMI.
Off / Computer in1 / Computer in2

Monitor Out - S-Video

Setting the Monitor Out-S-Video.
Off / Computer in1 / Computer in2
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Monitor Out - Video

Setting the Monitor Out-Video.
Off / Computer in1 / Computer in2

Monitor Out - Standby

Setting the Monitor Out Standby.
Off / Computer in1 / Computer in2

Reset Initialize the selected Function.
D-Zoom / D-Shift V / D-Shift H / Keystone V
[Execute]: After the confirmation message, the selected Function will be initialized.
[AUDIO] Tab

Function General Description
Volume Setting the Volume.

[-]: Decrease the Volume.

[+]: Increase the Volume.
Speaker Setting the Speaker.

Off / On

Audio Source -
Computer in1

Setting the Audio Source-Computer in1.
Off / Audio1 / Audio2 / Audio3

Audio Source -
Computer in2

Setting the Audio Source-Computer in2.
Off / Audio1 / Audio2 / Audio3

Audio Source - HDMI

Setting the Audio Source-HDMI.
Off / Audio1 / Audio2 / Audio3 / Audio HDMI

Audio Source - S-Video

Setting the Audio Source-S-Video.
Off / Audio1 / Audio2 / Audio3

Audio Source - Video

Setting the Audio Source-Video.
Off / Audio1 / Audio2 / Audio3

Audio Out Standby Setting the Audio Out Standby.
Off / Audio1 / Audio2 / Audio3
HDMI Audio Setting the HDMI Audio.
1/2
[SCREEN] Tab
Function General Description
Language Setting the Language.

English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese / Danish / Czech / Hungarian / Romanian /
Slovenian / Croatian / Greek / Lithuanian / Estonian / Latvian / Thai / Arabian /
Persian / Portuguese-Brazil

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[d]: Decrease the horizontal menu position.
[’]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On

Message Setting Message.
Off / On

Template Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4 / Circle1 / Circle2 /
Map1 / Map2

C.C. - Display Setting the Closed Caption Display.
Off / On / Auto

C.C. - Mode Setting the Closed Caption Mode.
Captions / Text

C.C. - Channel Setting the Closed Caption Channel.
1/2/3/4

Reset Initialize the selected Function.

Menu Position V / Menu Position H
[Execute]: After the confirmation message, the selected Function will be initialized.
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[OPTION] Tab

Function

General Description

Auto Search Setting Auto Search.
Off / On

Direct Power On Setting Direct Power On.
Off / On

Auto Power Off

Setting Auto Power Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.

My Button-1 Setting My Button-1.
Computer in1 / Computer in2 / HDMI / Video / S-Video / My Image / Messenger /
Information / My Memory / Picture Mode / Filter Reset / Template / AV Mute /
D-Zoom / D-Shift / Resolution / Other

My Button-2 Setting My Button-2.
Computer in1 / Computer in2 / HDMI / Video / S-Video / My Image / Messenger /
Information / My Memory / Picture Mode / Filter Reset / Template / AV Mute /
D-Zoom / D-Shift / Resolution / Other

My Source Setting the My Source.
Computer in1 / Computer in2 / HDMI / Video / S-Video

[Service]
Function General Description

IR Remote Frequency

Setting the IR Remote Frequency Normal.

Normal Off / On
IR Remote Frequency Setting the IR Remote Frequency High.
High Off / On
[OTHER] Tab
Function General Description
Power Controlling the Power.

Off / On

Input Source

Setting the Input Source.
Computer in1 / Computer in2 / HDMI / Video / S-Video

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On

Mute Setting Mute.
Off / On

Freeze Setting Freeze.
Normal / Freeze

Template On/Off Setting Template.
Off / On

Magnify Setting Magnify

[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

Magnify Position V

Setting Magnify Position V.
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

Magnify Position H

Setting Magnify Position H.
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

My Image

Setting the My Image.
Off / Image1 / Image2 / Image3 / Image4

My Image Delete

Deleting the My Image.
Image1 / Image2 / Image3 / Image4

Messenger

Setting the Messenger.
Off / Temporary / Message-1 / Message-2 / Message-3 / Message-4 / Message-5 /
Message-6 / Message-7 / Message-8 / Message-9 / Message-10 / Message-11/
Message-12
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[STATUS] Tab

m CP-AW100N / ED-AW100N / ED-AW110

Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Source

Display the Input source status.
Computer in1 / Computer in2 / HDMI / Video / S-Video

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error /
Cold Error / Filter Error / Lens Door Error / Other Error

Blank On/Off

Display the Blank status.
Off / On

Mute

Display the Mute status.
Off / On

Freeze

Display the Freeze status.
Normal / Freeze

Lamp Time

Display the Lamp Time.

Filter Time

Display the Filter Time.

Reset

Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab

Function

General Description

Brightness

Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.

Contrast

Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma

Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

My Memory

Load/Save the My Memory.
Load1/Load2 /Load3 /Load4 / Savel1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Custom - Gamma -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.

User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.
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User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
4:3/16:9/16:10/ 14:9 / Native / Normal

Over Scan Setting the Over Scan

[-]: Decrease the Over scan value.

[+]: Increase the Over scan value.
Position Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[P>]: Decrease the horizontal position.
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H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV /FILM
Video NR Setting the Video NR.
Low / Mid / High
Color Space Setting the Color space.

Auto / RGB / SMPTE240 / REC709 / REC601

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

HDMI Format Setting the HDMI Format.
Auto / Video / Computer
HDMI Range Setting the HDMI Range.

Auto / Normal / Enhanced

Computer in1

Setting the Computer in-1 Signal Type.
Sync On G Off / Auto

Computer in2

Setting the Computer in-2 Signal Type.
Sync On G Off / Auto

Frame Lock - Computer

Setting the Frame Lock-Computer in1.

in1 Off / On
Frame Lock - Computer | Setting the Frame Lock-Computer in2.
in2 Off / On
Frame Lock - HDMI Setting the Frame Lock-HDMI.
Off / On
[SETUP] Tab
Function General Description
D-Zoom Setting the D-Zoom.
[-]: Decrease the D-Zoom.
[+]: Increase the D-Zoom.
D-Shift Setting the D-Shift.
[A]: Increase the D-Shift V.
[V]: Decrease the D-Shift V.
[4]: Decrease the D-Shift H.
[’]: Increase the D-Shift H.
Pict. Posit. H Setting the Picture Position H.
Left / Mid / Right
Keystone V Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.
Eco Mode Setting the Eco Mode.
CP-AW100N
Normal / Eco
ED-AW100N / ED-AW110N
Bright / Normal
Mirror Setting the Mirror display.

Normal / H:Invert / V:Invert / H&V:Invert

Standby Mode

Setting the Standby Mode.
Normal / Saving

Monitor Out - Computer
in1

Setting the Monitor Out-Computer in1.
Off / Computer in1

Monitor Out - Computer
in2

Setting the Monitor Out-Computer in2.
Off / Computer in2

108




Monitor Out - HDMI

Setting the Monitor Out-HDMI.
Off / Computer in1 / Computer in2

Monitor Out - S-Video

Setting the Monitor Out-S-Video.
Off / Computer in1 / Computer in2

Monitor Out - Video

Setting the Monitor Out-Video.
Off / Computer in1 / Computer in2

Monitor Out - Standby

Setting the Monitor Out Standby.
Off / Computer in1 / Computer in2

Reset Initialize the selected Function.
D-Zoom / D-Shift V / D-Shift H / Keystone V
[Execute]: After the confirmation message, the selected Function will be initialized.
[AUDIO] Tab

Function General Description
Volume Setting the Volume.

[-]: Decrease the Volume.

[+]: Increase the Volume.
Speaker Setting the Speaker.

Off / On

Audio Source -
Computer in1

Setting the Audio Source-Computer in1.
Off / Audio1 / Audio2 / Audio3

Audio Source -
Computer in2

Setting the Audio Source-Computer in2.
Off / Audio1 / Audio2 / Audio3

Audio Source - HDMI

Setting the Audio Source-HDMI.
Off / Audio1 / Audio2 / Audio3 / Audio HDMI

Audio Source - S-Video

Setting the Audio Source-S-Video.
Off / Audio1 / Audio2 / Audio3

Audio Source - Video

Setting the Audio Source-Video.
Off / Audio1 / Audio2 / Audio3

Audio Out Standby Setting the Audio Out Standby.
Off / Audio1 / Audio2 / Audio3
HDMI Audio Setting the HDMI Audio.
1/2
[SCREEN] Tab
Function General Description
Language Setting the Language.

English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese / Danish / Czech / Hungarian / Romanian /
Slovenian / Croatian / Greek / Lithuanian / Estonian / Latvian / Thai / Arabian /
Persian / Portuguese-Brazil

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[d]: Decrease the horizontal menu position.
[’]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On

Message Setting Message.
Off / On

Template Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4 / Circle1 / Circle2 /
Map1 / Map2

C.C. - Display Setting the Closed Caption Display.
Off / On / Auto

C.C. - Mode Setting the Closed Caption Mode.
Captions / Text

C.C. - Channel Setting the Closed Caption Channel.
1/2/3/4

Reset Initialize the selected Function.

Menu Position V / Menu Position H
[Execute]: After the confirmation message, the selected Function will be initialized.
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[OPTION] Tab

Function

General Description

Auto Search Setting Auto Search.
Off / On

Direct Power On Setting Direct Power On.
Off / On

Auto Power Off

Setting Auto Power Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.

My Button-1 Setting My Button-1.
Computer in1 / Computer in2 / HDMI / Video / S-Video / My Image / Messenger /
Information / My Memory / Picture Mode / Filter Reset / Template / AV Mute /
D-Zoom / D-Shift / Resolution / Other

My Button-2 Setting My Button-2.
Computer in1 / Computer in2 / HDMI / Video / S-Video / My Image / Messenger /
Information / My Memory / Picture Mode / Filter Reset / Template / AV Mute /
D-Zoom / D-Shift / Resolution / Other

My Source Setting the My Source.
Computer in1 / Computer in2 / HDMI / Video / S-Video

[Service]
Function General Description

IR Remote Frequency

Setting the IR Remote Frequency Normal.

Normal Off / On
IR Remote Frequency Setting the IR Remote Frequency High.
High Off / On
Remote Receive Setting the Remote Receive.
Front (Off / On)
Top (Off / On)
[OTHER] Tab
Function General Description
Power Controlling the Power.

Off / On

Input Source

Setting the Input Source.
Computer in1 / Computer in2 / HDMI / Video / S-Video

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On

Mute Setting Mute.
Off / On

Freeze Setting Freeze.
Normal / Freeze

Template On/Off Setting Template.
Off / On

Magnify Setting Magnify

[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

Magnify Position V

Setting Magnify Position V.
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

Magnify Position H

Setting Magnify Position H.
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

My Image

Setting the My Image.
Off / Image1 / Image2 / Image3 / Image4

My Image Delete

Deleting the My Image.
Image1 / Image2 / Image3 / Image4

Messenger

Setting the Messenger.

Off / Temporary / Message-1 / Message-2 / Message-3 / Message-4 / Message-5 /
Message-6 / Message-7 / Message-8 / Message-9 / Message-10 / Message-11 /

Message-12
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m CP-ED10N/ED-ED11N

[STATUS] Tab

Function

General Description

Power Status

Display the Power Status.
Off / On / Cool down

Input Source

Display the Input source status.
Computer in1 / Computer in2 / HDMI / Video / S-Video

Error Status

Display the Error status.
Normal / Cover Error / Fan Error / Lamp Error / Temp Error / Air Flow Error /
Cold Error / Filter Error / Other Error

Blank On/Off

Display the Blank status.
Off / On

Mute

Display the Mute status.
Off / On

Freeze

Display the Freeze status.
Normal / Freeze

Lamp Time

Display the Lamp Time.

Filter Time

Display the Filter Time.

Reset

Initialize the selected Function.
Lamp Time / Filter Time
[Execute]: After the confirmation message, the selected Function will be initialized.

[PICTURE] Tab

Function

General Description

Brightness

Setting the Brightness
[-]: Decrease the Brightness value.
[+]: Increase the Brightness value.

Contrast

Setting the Contrast
[-]: Decrease the Contrast value.
[+]: Increase the Contrast value.

Gamma

Setting the Gamma.
#1-Custom / #2-Custom / #3-Custom / #4-Custom / #5-Custom / #6-Custom /
#1-Default / #2-Default / #3-Default / #4-Default / #5-Default / #6-Default

Color Temp

Setting the Color Temp.
Low / Mid / High / Hi-Bright-1 / Hi-Bright-2 / Hi-Bright-3 / Custom-Low /
Custom-Mid / Custom-High / Custom-Hi-Bright-1 / Custom-Hi-Bright-2 /
Custom-Hi-Bright-3

Color

Setting the color density.
[-]: Decrease the color density value.
[+]: Increase the color density value

Tint

Setting the Tint.
[-]: Decrease the tint value.
[+]: Increase the tint value.

Sharpness

Setting the sharpness of the picture.
[-]: Decrease the color density value.
[+]: Increase the color density value.

My Memory

Load/Save the My Memory.
Load1/Load2 /Load3 /Load4 / Savel1 / Save2 / Save3 / Save4
[Execute]: Load / Save the selected Function.

Reset

Initialize the selected Function
Brightness / Contrast / Color / Tint / Sharpness
[Execute]: After the confirmation message, the selected Function will be initialized.

[Custom - Gamma -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

User Gamma Point 1

Setting the User Gamma Point 1.

[-]: Decrease the User Gamma Point 1 value.
[+]: Increase the User Gamma Point 1 value.
[Reset]: Initialize the User Gamma Point 1 value.

User Gamma Point 2

Setting the User Gamma Point 2.

[-]: Decrease the User Gamma Point 2 value.
[+]: Increase the User Gamma Point 2 value.
[Reset]: Initialize the User Gamma Point 2 value.
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User Gamma Point 3

Setting the User Gamma Point 3.

[-]: Decrease the User Gamma Point 3 value.
[+]: Increase the User Gamma Point 3 value.
[Reset]: Initialize the User Gamma Point 3 value.

User Gamma Point 4

Setting the User Gamma Point 4.

[-]: Decrease the User Gamma Point 4 value.
[+]: Increase the User Gamma Point 4 value.
[Reset]: Initialize the User Gamma Point 4 value.

User Gamma Point 5

Setting the User Gamma Point 5.

[-]: Decrease the User Gamma Point 5 value.
[+]: Increase the User Gamma Point 5 value.
[Reset]: Initialize the User Gamma Point 5 value.

User Gamma Point 6

Setting the User Gamma Point 6.

[-]: Decrease the User Gamma Point 6 value.
[+]: Increase the User Gamma Point 6 value.
[Reset]: Initialize the User Gamma Point 6 value.

User Gamma Point 7

Setting the User Gamma Point 7.

[-]: Decrease the User Gamma Point 7 value.
[+]: Increase the User Gamma Point 7 value.
[Reset]: Initialize the User Gamma Point 7 value.

User Gamma Point 8

Setting the User Gamma Point 8.

[-]: Decrease the User Gamma Point 8 value.
[+]: Increase the User Gamma Point 8 value.
[Reset]: Initialize the User Gamma Point 8 value.

[Custom - Color Temp -]

Function

General Description

User Gamma Pattern

Setting the test pattern.
Off / 9step Gray Scale / 15step Gray Scale / Ramp

Color Temp Gain R

Setting Color Temp Gain R.

[-]: Decrease the Color Temp Gain R value.
[+]: Increase the Color Temp Gain R value.
[Reset]: Initialize the Color Temp Gain R value.

Color Temp Gain G

Setting Color Temp Gain G.

[-]: Decrease the Color Temp Gain G value.
[+]: Increase the Color Temp Gain G value.
[Reset]: Initialize the Color Temp Gain G value.

Color Temp Gain B

Setting Color Temp Gain B.

[-]: Decrease the Color Temp Gain B value.
[+]: Increase the Color Temp Gain B value.
[Reset]: Initialize the Color Temp Gain B value.

Color Temp Offset R

Setting Color Temp Offset R.

[-]: Decrease the Color Temp Offset R value.
[+]: Increase the Color Temp Offset R value.
[Reset]: Initialize the Color Temp Offset R value.

Color Temp Offset G

Setting Color Temp Offset G.

[-]: Decrease the Color Temp Offset G value.
[+]: Increase the Color Temp Offset G value.
[Reset]: Initialize the Color Temp Offset G value.

Color Temp Offset B

Setting Color Temp Offset B.

[-]: Decrease the Color Temp Offset B value.
[+]: Increase the Color Temp Offset B value.
[Reset]: Initialize the Color Temp Offset B value.

[IMAGE] Tab
Function General Description
Aspect Setting the Aspect.
4:3/16:9/16:10/ 14:9 / Native / Normal

Over Scan Setting the Over Scan

[-]: Decrease the Over scan value.

[+]: Increase the Over scan value.
Position Setting the display position.

[A]: Increase the vertical position.
[V]: Decrease the vertical position.
[4]: Increase the horizontal position.
[P>]: Decrease the horizontal position.
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H Phase

Setting the clock phase.
[-]: Decrease the clock phase value.
[+]: Increase the clock phase value.

H Size Setting the horizontal size.
[-]: Decrease the horizontal size value.
[+]: Increase the horizontal size value.
Auto Adjust Execute Auto Adjust.
Reset Initialize the selected Function.
Over Scan / V Position / H Position / H Size
[Execute]: After the confirmation message, the selected Function will be initialized.
[INPUT] Tab
Function General Description
Progressive Setting the Progressive.
Off / TV /FILM
Video NR Setting the Video NR.
Low / Mid / High
Color Space Setting the Color space.

Auto / RGB / SMPTE240 / REC709 / REC601

S-Video Format

Setting the S-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

C-Video Format

Setting the C-Video Format.
Auto / NTSC / PAL / SECAM / NTSC4.43 / M-PAL / N-PAL

HDMI Format Setting the HDMI Format.
Auto / Video / Computer
HDMI Range Setting the HDMI Range.

Auto / Normal / Enhanced

Computer in1

Setting the Computer in-1 Signal Type.
Sync On G Off / Auto

Computer in2

Setting the Computer in-2 Signal Type.
Sync On G Off / Auto

Frame Lock - Computer

Setting the Frame Lock-Computer in1.

in1 Off / On
Frame Lock - Computer | Setting the Frame Lock-Computer in2.
in2 Off / On
Frame Lock - HDMI Setting the Frame Lock-HDMI.
Off / On
[SETUP] Tab
Function General Description
D-Zoom Setting the D-Zoom.
[-]: Decrease the D-Zoom.
[+]: Increase the D-Zoom.
D-Shift Setting the D-Shift.

[A]: Increase the D-Shift V.
[V]: Decrease the D-Shift V.
[d]: Decrease the D-Shift H.
[®]: Increase the D-Shift H.

Picture Position

Setting the Picture Position H.
Top / Mid / Bottom

Keystone V Setting the Keystone V.
[-]: Decrease the Keystone V value.
[+]: Increase the Keystone V value.
Eco Mode Setting the Eco Mode.
Bright / Normal
Mirror Setting the Mirror display.

Normal / H:Invert / V:Invert / H&V:Invert

Standby Mode

Setting the Standby Mode.
Normal / Saving

Monitor Out - Computer
in1

Setting the Monitor Out-Computer in1.
Off / Computer in1

Monitor Out - Computer
in2

Setting the Monitor Out-Computer in2.
Off / Computer in2

Monitor Out - HDMI

Setting the Monitor Out-HDMI.
Off / Computer in1 / Computer in2

Monitor Out - S-Video

Setting the Monitor Out-S-Video.
Off / Computer in1 / Computer in2
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Monitor Out - Video

Setting the Monitor Out-Video.
Off / Computer in1 / Computer in2

Monitor Out - Standby

Setting the Monitor Out Standby.
Off / Computer in1 / Computer in2

Reset Initialize the selected Function.
D-Zoom / D-Shift V / D-Shift H / Keystone V
[Execute]: After the confirmation message, the selected Function will be initialized.
[AUDIO] Tab

Function General Description
Volume Setting the Volume.

[-]: Decrease the Volume.

[+]: Increase the Volume.
Speaker Setting the Speaker.

Off / On

Audio Source -
Computer in1

Setting the Audio Source-Computer in1.
Off / Audio1 / Audio2 / Audio3

Audio Source -
Computer in2

Setting the Audio Source-Computer in2.
Off / Audio1 / Audio2 / Audio3

Audio Source - HDMI

Setting the Audio Source-HDMI.
Off / Audio1 / Audio2 / Audio3 / Audio HDMI

Audio Source - S-Video

Setting the Audio Source-S-Video.
Off / Audio1 / Audio2 / Audio3

Audio Source - Video

Setting the Audio Source-Video.
Off / Audio1 / Audio2 / Audio3

Audio Out Standby Setting the Audio Out Standby.
Off / Audio1 / Audio2 / Audio3
HDMI Audio Setting the HDMI Audio.
1/2
[SCREEN] Tab
Function General Description
Language Setting the Language.

English / French / German / Spanish / Italian / Norwegian / Dutch / Portuguese /
Japanese / Simplified Chinese / Korean / Swedish / Russian / Finnish / Polish /
Turkish / Traditional Chinese / Danish / Czech / Hungarian / Romanian /
Slovenian / Croatian / Greek / Lithuanian / Estonian / Latvian / Thai / Arabian /
Persian / Portuguese-Brazil

Menu Position

Setting the Menu Position.

[A]: Increase the vertical menu position.
[V]: Decrease the vertical menu position.
[d]: Decrease the horizontal menu position.
[’]: Increase the horizontal menu position.

Blank Setting the Blank color.
Blue / White / Black / MyScreen / Original
Startup Setting the Startup screen.

Original / Off / MyScreen

MyScreen Lock

Setting MyScreen Lock.

Off / On

Message Setting Message.
Off / On

Template Setting the Template.
Test Pattern / Dot-Line1 / Dot-Line2 / Dot-Line3 / Dot-Line4 / Circle1 / Circle2 /
Map1 / Map2

C.C. - Display Setting the Closed Caption Display.
Off / On / Auto

C.C. - Mode Setting the Closed Caption Mode.
Captions / Text

C.C. - Channel Setting the Closed Caption Channel.
1/2/3/4

Reset Initialize the selected Function.

Menu Position V / Menu Position H
[Execute]: After the confirmation message, the selected Function will be initialized.
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[OPTION] Tab

Function

General Description

Auto Search Setting Auto Search.
Off / On

Direct Power On Setting Direct Power On.
Off / On

Auto Power Off

Setting Auto Power Off.
[-]: Decrease the Auto Power off time.
[+]: Increase the Auto Power off time.

My Button-1 Setting My Button-1.
Computer in1 / Computer in2 / HDMI / Video / S-Video / My Image / Messenger /
Information / My Memory / Picture Mode / Filter Reset / Template / AV Mute /
D-Zoom / D-Shift / Resolution / Other

My Button-2 Setting My Button-2.
Computer in1 / Computer in2 / HDMI / Video / S-Video / My Image / Messenger /
Information / My Memory / Picture Mode / Filter Reset / Template / AV Mute /
D-Zoom / D-Shift / Resolution / Other

My Source Setting the My Source.
Computer in1 / Computer in2 / HDMI / Video / S-Video

[Service]
Function General Description

IR Remote Frequency

Setting the IR Remote Frequency Normal.

Normal Off / On
IR Remote Frequency Setting the IR Remote Frequency High.
High Off / On
[OTHER] Tab
Function General Description
Power Controlling the Power.

Off / On

Input Source

Setting the Input Source.
Computer in1 / Computer in2 / HDMI / Video / S-Video

Picture Mode

Setting the Picture Mode.
Normal / Cinema / Dynamic / Board(Black) / Board(Green) / White Board /
Daytime / Custom

» Custom is displayed only. It cannot be set.

Blank On/Off Setting Blank.
Off / On

Mute Setting Mute.
Off / On

Freeze Setting Freeze.
Normal / Freeze

Template On/Off Setting Template.
Off / On

Magnify Setting Magnify

[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

Magnify Position V

Setting Magnify Position V.
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

Magnify Position H

Setting Magnify Position H.
[-]: Decrease the Magnify value.
[+]: Increase the Magnify value.

My Image

Setting the My Image.
Off / Image1 / Image2 / Image3 / Image4

My Image Delete

Deleting the My Image.
Image1 / Image2 / Image3 / Image4

Messenger

Setting the Messenger.
Off / Temporary / Message-1 / Message-2 / Message-3 / Message-4 / Message-5 /
Message-6 / Message-7 / Message-8 / Message-9 / Message-10 / Message-11/
Message-12
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3.15 Turn on the power

Select [Control] > [Power ON] to turn on the power. You can also turn on the power by clicking the power on icon
on the toolbar. If you select a group of projectors, all projectors in the group are powered on.

3.16 Turn off the power

Select [Control] > [Power OFF] to turn off the power. You can also turn off the power by clicking the power off
icon on the toolbar. If you select a group of projectors, all projectors in the group are powered off.

3.17 Display e-SHOT / MY MAGE

You can display e-SHOT / MY IMAGE on projectors that supports e-SHOT / MY IMAGE feature. The e-SHOT /
MY IMAGE is available for the following models, CPX2, CPX4, CP-DW10N, CP-A100, CP-AW100N, CP-X205,
CP-X206, CP-S245, CP-X255, CP-X256, CP-X265, CP-X268A, CP-X305, CP-X306, CP-X308, CP-X417, CP-X467,
CP-X505, CP-X605, CP-X608, CP-X615, CP-WX625, CP-SX635, CP-X705, CP-X807, CP-X809, CP-X2010N,
CP-X2510N, CP-X3010N, CP-X10000, CP-WX11000, CP-SX12000, ED-A100, ED-A110, ED-AW100N,
ED-AW110N, ED-D10N, ED-D11N and ED-X8255. Select [Control] > [Display Image] and the image number, when
you display e-SHOT / MY IMAGE. Select [Control] = [Display Image] - [Off], when you exit e-SHOT / MY IMAGE. If
you choose projector group, e-SHOT / MY IMAGE command is sent to the all projectors in the group.

3.18 Change Filter Message

You can configure the interval of Filter Message (cleaning reminder interval) from the menu. Select [Control]
- [Filter Message] to display the configuration dialog window.

Ghanee Filter Message

off v

Select the desired interval period and press [OK]. If you are selecting a group in the tree view, all of projectors
setting under the selected group will be changed. Please note that the change may not affect if the projector models
are mixed in the group. In other words, the projector is not supported the selected interval, it will be ignored.
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3.19 Schedule Events

In order to schedule events, select [Schedule] - [Edit] from the menu. The Edit Schedule dialogue will appear.

Edit Schoduls K| Edit Schoduls

Frongs rdurmation Prispretonr Trdvemaln

o Mame = hass Booms Frojector Mame = Ropom GLOGH3

Conkmns = 10 Projectons, 0 Groups Podel © PeALDO

Comment, : Eagl Wing Comment,
Date Teses | Cowtral Date Teses | cortral
(e ] 15:15 Poswsr OFF (e ] 20:30 Corpday Imesge-2
Doy LI Dbl Iruige-1 Doy 20:2% Powrir 0N
Dy 0605 Ingnt BGE| {Compuber] Dy 20:45 [——
[y 0&:00 P ON

bat. | .| |

&

Group selected

Group Information

Group Name -
Contains --
Comment

Projector Information
Projector Name ---

Displays the group name.

Displays the number of projectors and groups in the group.

Displays the comment.

Displays the projector name.

Model
Comment

Schedule List

[Add]
[Delete]
[Close]

Displays the model name.
Displays the comment.

Show the list of scheduled events
Add a new event

Delete a selected event

Close the dialogue

Projector selected

The Add Schedule dialogue will appear when you are adding a new event.

Add Schedule

Schedule Kind

Diate

Time:

Control

&
Daily -
oo =]
15:43 =
|P0wer QFF j
Cancel |

Schedule Kind ~ ---

Date
Time
Control
[OK]

Select a following schedule type.

Daily / Sunday / Monday / Tuesday / Wednesday / Thursday / Friday / Saturday /

Specific date
Specify the event time

Specify the event
Add the event and close the dialogue
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3.20 Activate monitoring scheduled events

Select [Schedule] - [Start]. You can also activate monitoring events by clicking the schedule start icon on the
toolbar. You cannot add, delete or edit an event during while the event monitoring process is active. Please see the
chapter 5 for the details.

3.21 Stop monitoring scheduled events

Select [Schedule] - [Stop]. You can also stop the monitoring events by clicking [schedule stop] icon on the
toolbar. Please see the chapter 5 for the details.

3.22 Polling Interval Period

Select [Option] - [Status Check Interval], enter the polling interval time in seconds. & s v i X

The polling interval time must be within the range from 10 to 3600 seconds.
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3.23 Mail Setting

A notification mail will be sent when any error or selected condition occurs. Select [Option] = [Mail Settings] to
open the mail settings dialogue.

(1) Mail Settings

Mail Settings dialog is as follows. Mail Settines

Send Mail

SMTP Server
From Address
Send Address

Subject
Mail Text
Attach File

Mail Send Test

(2) Mail Address Settings

Mail Address Setting dialogue is as follows. Mail Address Settings

Mail Address --- Enter the mail address to be sent, up to mail Address |
256 characters. 10 Ccc ¢ oBCC
[TO][CC][BCC]: Select TO/ CC / BCC.

. . . W Caver Errar [w Fan Errar I Lamp Errar
Notification  --- Chose the Error / Alarm to send the mail. ——_ e N
Emp Errar IF Flow Errar amp lime Error
[Select Alll: ~ Turn all the check box ON.  cads [ =
[Release All]:  Turn all the check box OFF. e e e
|¥ Disconnect Iv Lamp Time Alarm v Filter Time Alarm

X

SMTP Server |

From Address |

Send Address Address | TOMCCIBCC | Mokification Add...

i

Subject

Mail Text M

Aktach File
Mail Send Test
oK | Cancel

Browse, ..

Enable / Disable send mail function

Enter the SMTP Server

Enter the sender’s mail address

Enter the receiver's mail addresses up to 10 addresses

[Add]: Add a receiver's mail address
[Delete]: Delete a receiver's mail address
[Edit]: Edit receiver’'s mail address

Enter the subject
Mail Text Setting screen appears to set the mail message
Enter the file name of attached file (optional)

[Browse] File dialogue appears

Send a test mail

X

Matification

I¥ Lens Door Error [¥ Shutter Error

Select &l | Release Al

[0]4 | Cancel |
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(3) Mail Text Settings
Mail Text Settings

Mail Text Settings

Cover Errar

Fan Errar

Larnp Error
Temp Error

Air Flow Error
Lamp Time Errar
Cold Errar

Filker Error
Cther Error
Disconnect
Lamp Time Alarm
Filter Time Alarm
Lens Doar Error

Shutter Error

dialogue is as follows.

|C0ver Errar 111

|Fan Error 111

|Lam|3 Error 111

|Tem|:| Error 111

|nir Flow Errar 111

|Lamp Time Error 111

|Cold Errar 111

[Filter Error 111

|Other Error 111

|Disconnected mn

|Lamp Time Alarm 11

[Filter Time Alarm 111

|Lens Croor Error M1

|Shutter Errar 111

o]

Cancel |

Cover Error

Fan Error

Lamp Error
Temp Error

Air Flow Error
Lamp Time Error
Cold Error

Filter Error
Other Error
Disconnect
Lamp Time Alarm
Filter Time Alarm
Lens Door Error
Shutter Error

Enter the text message, which is sent when Cover Error occurs
Enter the text message, which is sent when Fan Error occurs
Enter the text message, which is sent when Lamp Error occurs
Enter the text message, which is sent when Temp Error occurs
Enter the text message, which is sent when Air Flow Error occurs

Enter the text message, which is sent when Cold Error occurs
Enter the text message, which is sent when Filter Error occurs
Enter the text message, which is sent when Other Error occurs

Enter the text message, which is sent when Lamp Time Error occurs

Enter the text message, which is sent when connection is disconnected
Enter the text message, which is sent when Lamp Alarm Time comes
Enter the text message, which is sent when Filter Alarm Time comes
Enter the text message, which is sent when Lens Door Error occurs
Enter the text message, which is sent when Shutter Error occurs
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3.24 e-SHOT / MY IMAGE transfer

You can send an e-SHOT / MY IMAGE fie to a
projector that supports e-SHOT / MY IMAGE feature. | wosudne o Sebcto et ) _ _
This function is available for the following models, o s e e Mime I =

CP-DW10N, CP-A100, CP-AW100N, CP-X205,
CP-X206, CP-S245, CP-X255, CP-X256, CP-X265,
CP-X305, CP-X306, CP-X505, CP-X605, CP-X615,
CP-WX625, CP-SX635, CP-X705, CP-X2010N,
CP-X2510N, CP-X3010N, CP-X10000, CP-WX11000,
CP-SX12000, ED-A100, ED-A110, ED-AW100N, Sorttle |

ED-AW110N, ED-D10N, ED-D11N and ED-X8255. =] nt_ |

| =22
The CPX2, CPX4, CP-X268A, CP-X308, CP-X417,
CP-X467, CP-X608, CP-X807 and CP-X809 support e-SHOT / MY IMAGE also, but this tool is not supported those
models due to transfer mechanism difference. Please refer to the Projector Transfer Application which supports this
feature for these models.

Select [Option] = [Image Send] to display the window “Send Image file to projector(s)” as shown next.

In order to add projectors on the list, please mark the Il it

projector group on the tree view. AlISO you Can | woswnss s Skt e ) ) _
unselect projector individually. ; B=. TR e r——
AN (Group B] Projechor 2 O0<D0-B0-08EC...  1R2.100.1.20
o Fie
T Mo i
- Ll 1]

Once you select the image file and store location number, the “Send” button becomes available. The compatible
image file is only PJ1 format file that can be created by Projector Image Tool (PJImg).And then, click the Send
button to transfer image. The maximum size of transferred file is depending on the model. Please check the
following list.

CP-S245 / CP-X255 / ED-X8255
Less than equal 65, 280 byte

CP-DW10N / CP-A100 / CP-AW100N / CP-X205 / CP-X206 / CP-X256 /| CP-X265 / CP-X305 / CP-X306 /
CP-X505 / CP-X605 / CP-X615 / CP-WX625 / CP-SX635 / CP-X705 / CP-X2010N / CP-X2510N / CP-X3010N /
CP-X10000 / CP-WX11000 / CP-SX12000 / ED-A100 / ED-A110 / ED-AW100N / ED-AW110N / ED-D10N /
ED-D11N

Less than equal 130,816byte

The status is shown during transfer. The status will change “Completed” if it succeeds.

Send image #le in penjecsar(s) | send image e o penjecsar(n) 4
- Srea e b S it e b
. - =T W daden | P adeen e
Sl + O= ST 1 il ———
s | -
A T i e . T e —ry
am -
et et
e

Note
Please verify the port setting on the projector and the port / authentication setting on the application.
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3.25 User-defined Model
3.25.1 Add an User-defined Model

You can create your own projector definition and add it as User-defined model. In order to add new User-defined
model, click [Add Model...] button on the Add Projector window. Once you have added a User-defined model, the
new model is added in the standard model list.

(1) General Settings

User-defined Model E|
General Settings lCommunication Settings ] Cornmand Definitions 1 ] Cornrnand Definitions 2 ]
Madel Mame: |
Command Type: (% Binary 7 Text
Power On Command: |
Power OFf Command: |
| Cancel |

Model Name --- Enter the name of User-defined model
Command Type ---  Select command type wither Binary or Text (ASCII)
Power On Command --- Define Power On command. Up to 32 ASCII character length.

Binary type command

Ex: BEEF030600BAD2010000600100

* Only 0-9, a-f and A-F are available to enter.
Text type command

Ex: POWER ONI[CR]

* Control characters are defined as below.

Power Off Command --- Define Power Off command. Up to 32 ASCII character length.

Binary type command

Ex: BEEF0306002AD3010000600000

* Only 0-9, a-f and A-F are available to enter.
Text type command

Ex: POWER OFF[CR]

* Control characters are defined as below.

Control Characters

Control Character | Notation Control Character | Notation Control Character | Notation
NUL 0x00 [NUL] VT 0x0b [VT] SYN 0x16 [SYN]
SOH 0x01 [SOH] NP 0x0c [NP] ETB 0x17 [ETB]
STX 0x02 [STX] CR 0x0d [CR] CAN 0x18 [CAN]
ETX 0x03 [ETX] SO 0x0e [SO] EM 0x19 [EM]
EOT 0x04 [EOT] Sl 0xOf [S]] SUB Ox1a [SUB]
ENQ 0x05 [ENQ] DLE 0x10 [DLE] ESC 0x1b [ESC]
ACK 0x06 [ACK] DC1 0x11 [DCA1] FS 0x1c [FS]
BEL 0x07 [BEL] DC2 0x12 [DC2] GS Ox1d [GS]
BS 0x08 [BS] DC3 0x13 [DC3] RS Ox1e [RS]
HT 0x09 [HT] DC4 0x14 [DC4] us Ox1f [US]
LF 0x0a [LF] NAK 0x15 [NAK] DEL 0x7f [DEL]
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(2) Communication Settings

User-defined Model [‘S__<|
General Settings  Communication Settings ] Cammand Definitions 1 ] Cammand Definitions 2 ]
RS-232C Metwark
bitsfs: 9600 = ' TCP " UDP
Data bits: g hd
Patity: Mone =
Stop bit: 1 -
Flow Contral: Mone A
| Cancel |
RS-232C ---  COM port parameter setting (if RS232C uses)
bits/s --- Baud rate
Data bits --- Data bit
Parity --—- Parity bit
Stop bit ---  Stop bit
Flow Control ---  Flow control
Network ---  Select network protocol (TCP or UDP)
(3) Command Definitions 1
User-defined Model [‘5__(|
General Settings ] Communication Settings  Command Definitions 1 lCommand Definitions 2 ]
Command 1
Mame: | Command: |
Command 2
Mame: | Command:l
Command 3
Mame: | Command: |
Command 4
Mame: | Command:l
Command 5
Mame: | Command:l
oK | Cancel |
Name --- Enter the name of command, up to 32 ASCII characters.
Command --- Define the command up to 32 ASCII characters.

The allowed characters are depending on the command type selection (binary or Text)
on the General Setting TAB.
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(4) Command Definitions 2

User-defined Model Fz|
General Settings ] Cammunication Settings ] Command Definitions 1 Command Definitions 2 l
Comnmand &
Mame: | Command:|
Command 7
Mame: | Command:|
Command &
Mame: | Command:|
Command 9
Mame: Command: |
Command 10
Mamme: | Command:|
| Cancel |
Name --- Enter the name of command, up to 32 ASCII characters.
Command --- Define the command up to 32 ASCII characters. The allowed characters are depending

on the command type selection (binary or Text) on the General Setting TAB.

3.25.2 Edit User-defined Model

In order to edit User-defined model, select [Option] = [Edit User-defined Model]. The following window will
appear.

Edit User-defined Model X

Model Data list

Edit...
Delete

(1) Edit
Choose a User-defined Model form the list, and then click [Edit...] button.

(2) Delete

Choose a User-defined model from the list, and then click [Delete...] button. The confirmation message will be

appeared. The deleted model on the projector tree will be removed when the User-defined Model definition is
deleted.
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3.25.3 Control User-defined Model

(1) Power On
Select [Control] - [Power ON] to turn on the power. You can also turn on the power by clicking the power on
icon on the toolbar. If you select a group of projectors, all projectors in the group are powered on.

(2) Power Off
Select [Control] > [Power OFF] to turn off the power. You can also turn off the power by clicking the power off
icon on the toolbar. If you select a group of projectors, all projectors in the group are powered off.

(3) Command No.1-10
Select [Control] = [Execute Command] to execute a command.

(4) Schedule
Only Power On / Off commands are allowed as the schedule event for User-defined model.

3.26 Open the built-in HTML page of the projector

You can access the projector built-in HTML page from PJMan directly. Select the projector from the tree view, and
then go to [Option] > [Open with] from the menu. The default browser on your computer will launch automatically
and access the selected projector HTML page. This function supports embedded network projector models only.
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3.27 Setup PJMessage to Projector
3.27.1 From PJMessenger file

For projectors that support Messenge function, PJMan allows you to setup PJMessenger message from
PJMessenger file (pjm file), that is exported from another application software - Projector Messenger Tool
(PJMessenger).

Select projector(s) from the tree view, then go [Option] > [Send Messenger data]. The following dialog will be
displayed. It will populate only the projectors that supports PdJMessenger function.

Send Messengar data to prajector]z)

| Progector ame | Moddl IF iddress MAC diddress Stabus |
| ] P00 Flerat 1IN L =007 -F 1 -6 749
B Pacsimctind CRATERINN 192.16A.1.750 =037 5 wli-

Sand Pl | J _|
st i <]

Mark the checkbox in the Projector name field to select the projectors that you want to upload the PJMessage file.
Send button will be enabled when you choose PJMessenger file and store location number.

Send Messengar data to prajector]z)

| Progector ame | Moddl IF iddress MAC diddress Stabus |
| ] P00 Flerat 1IN L =007 -F 1 -6 749
B Pacsimctind CRATERINN 192.16A.1.750 =037 5 wli-

st Fibes |i¢-sle1e-:tor ToaksWPraasctor Messengsr TooliMesagelntainescagsl o . Zand

st o

Press [Send] button to start the pload process. The status field will be shown as “Completed” when the process is
done.

Send Messengar data to prajector]z)

| Progector ame | Moddl 1P dddress s Address | Statuss |
EP‘W! CP-C0I0N Flerm OO0 -F 1 T 43 Complsted
Epml;ll:ll:.'? CRTRIDN 192.16R.1.350 D0-D0-A7«S-mli-fla  Corjated

st Fibes |i¢-sle1e-:tor ToaksWPraasctor Messengsr TooliMesagelntainescagsl o . Zand

st o
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3.27.2 Drag and Drop PJMessage from PJMessengerLite

PJMan also supports drag and drop the PJMessage from the application software called PJMessengerLite.
PJMessenger is the trim down version of PJMessenger, that is designed to handle a single projector for testing
PJMessage function. But if you use both PJMan and PJMessengerLite, it gives you ability to manage PJMessage
function for the large scale of projectors.

Simplify the select PJMessage from PJMessengerLite and drag and drop it to the tree view in PJMan. After
installation of PJMessengerLite, you can launch the application from [Option] - [Run PJMessengerLite].

Pragecinr bansprmn & fphoatien

e LW ves Cotvgl ki EGT]
TwEB LW 3| Status Check Interval .,
Mail Settings...
Send Image ...
Edit User-defined Model..
Send Messenger data...
Run PN ite
T I
Clamtn [ i1 & g o
ENEE . - x| Ny [Ty & | MmseagnDl
Duiste | [rew—
— — =
Ha gl Frrma = T Hamie e
v Il - = e - Tiwd TRR—Y
i ol W Tap = i = ! [T
Bowdl  # ep o o = iwd el
| food W fop C ] C in gt
L] ol W Mop = lrw & Vi Taroged
1 fod & 1op = How = it Thar gt
¥ Gl W o o i = i R
Bl M Tap % Hew = Tiwl Merm!
fual o g o M - Tiasd [re—
i B W Tag o - Tl [ Y
m Bamd @ T o - i [ TRt
1 Sl W lop # i = Tastl iaisagall
1 Sl & Top ¥ How = liw! hubeage 10
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Example of drag and drop fearure for a single PJMessage:
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1 Sl & Top ¥ How ~ liwl] a1l
L

127



Example of drag and drop feature for multiple PJMessage:

e i g Cmral ebagie Open el
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- If e
E-Hl-w-c.-n [r—— -
él'::':r_f [r— Pt G
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el e 2B L
Cramrn [ vodgram L wseg s
BEER-150 1EE1 W - B iy | Ty CHETTT
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|_I'-’wv"n W Rz | omli |
[ B Fumion e i Humie Mg
T fmd ¥l W Hew - Tiwd Maiaaps
= [ - ™ -
& " g- 0 - 5
g- 8 g=
g- & [~
= B- B [- =
= B B B
e g- g- 8-
= - [~ i
= 5. B [~ i
B g B
0 B O B
i

The following dialog window will be displayed when you drag and drop PJMessage as same as uploading from
PJMessenger file (pjm file).

Send Messenger Data

Frofector Mame | Moddd | 17 Address [ Mt addrass [ ot I
EHW! P00 192 U0, 1.5 O0-00-07-F1-67-49
HPM:{.:“:J‘ TR0 193 IAH.1.350 (=8 7 o by

Send Mescengar Data

Frofector Hame | Model | 17 Address [ Mt addrass [ ot I
EHW! P00 192 U0, 1.5 O0-00-07-F1-67-45 Complstad
HPM:{.:“:J‘ TR0 193 IAH.1.350 [ B B e ] Carrged e

=] o= |

Please refer to the PJMessengerLite manual for the details.
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3.28 About Dialogue

Select [Help] > [AbOUt] to open the about dialogue. About Projector Management Application

=@ Projector Management Application Yersion 7,11
=91z

Copyright {C) 2003-2002 Hitachi Consumer Electronics Ca., Lkd, Al rights reserved.
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4 Mail Feature

4.1 Mail Format

The Projector Management Application sends an e-mail by following format.

Time : YYYY / MM/ DD hh:nn:ss

Projector Name : xxxxxx

Connection: XXxxxx

Message: xxxxxxxxxxxxxxxxxx (Typed in text on Message Setting screen)

(Sample 1)

Time: 2003 /11 /11 23:12:22

Projector Name: Projector1

Connection: 192.168.1.10 (00-00-87-16-8E-90)
Message: Fan Error!!!

(Sample 2)

Time: 2003/11/12 20:00:17
Projector Name: Projector2
Connection: COM1
Message: Lamp Error!!!

4.2 Others

The e-mail sending process is triggered by the transition from normal status to error (or event) mode. When an
error happens at the startup, this Projector Management Software application will not send e-mail.
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5 Status

The projector status is classified with colored label.

Status Display

Normal g Projector 1 (Black text with white background)
Warning & Projector 1 (Black text on yellow background)
Error Projector 1 (White text on brown background)
Disconnect

F'r'lijel:tl:lr' 1

(White text on red background)

All of projectors are normal

I Graup &

(Black text on white background)

At least one projector is in the warning state and the
rest of projectors are either warning or normal state.

Z2s ErOUP A

(Black text on yellow background)

At least one projector is in the error state and the rest
of projectors are either warning or normal state.

i Bz

(White text on brown background)

At least one projector is in the disconnect state, and
rest of projectors are error, warning or normal.

B ST

(White text on red background)

Each projector is classified by the colored label on the list of the projector when the user selects a group.

Status Display
Normal Prajector MName Connection MAC Address Power | I H i
Projector 1 192,168.1.10:23 00-00-57-56-ac-92 CFF F (BlaCk teXt Wlth Whlte
Projectar 2 comi OFF F backg rou nd)
Warnlng Projector Mame Connection MAC Address Power | 1 BI k ”
Prajector 1 19z.1668.1.10:23 00-00-57-56-3c-92 CFF F ( ac teXt on ye ow
Projectar 2 com1 OFF F backg rou nd)
E rror Projector Mame Connection MAC Address Power 1 .
192,168.1,10:23 (Whlte teXt on brown
Projectar 2 comi OFF F backg rou nd)
D isconnect Projector Mame Connection MAC Address Power I .
192,168.1,10:23 7 (Whlte teXt on red
Projector 2 oML OFF F background)

The priority of colored label is; 1% Disconnect, 2" Error and 3™ Warning.
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6 Output Log

In order to enable logging status data, please enable log setting through [File] = [Log]. It does not record log data
when it is unchecked.

Output folder : (PJman installed folder)\Log\
Filename :
TCP /IP network --- (IP address)_(Port No.).log (ex: 192.168.1.10_23.log)
Serial (RS232C) --- COMM_(Port No.).log (ex: COMM_1.log)
Format:
Command log
[Cmd ], [Date], [Action code], [Operation ID], [Operation Name], [Setting Value], [Result], [Return Value]

Status log (only status is changed)
[Stat], [Date], [Status Name], [Status]

Example

[Stat], 2008/11/07 20:06:16, Power Status, ON

[Stat], 2008/11/07 20:06:16, Lamp Time, O

[Stat], 2008/11/07 20:06:16, Filter Time, 0

[Stat], 2008/11/07 21:06:16, Lamp Time, 1

[Stat], 2008/11/07 21:06:16, Filter Time, 1

[Cmd ], 2008/11/07 21:10:35, Set, 0x2000, Input Source, 1, OK, 0
[Cmd ], 2008/11/07 21:15:27, Get, 0x6000, Power, 0, OK, 0

[Cmd ], 2008/11/07 21:15:27, Set, 0x6000, Power, 0, OK, 0
[Stat], 2008/11/07 21:15:30, Error Status, Disconnect
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7 Create Log Report

In order to create Log Report, choose a projector or group that you want to create Report from the tree view. Ands
then, select [File] > [Log Report]. The following dialogue appears.

Log Report

Period

start: [zo08 | f |11~ 1|07 -]
End: Jeoos x| f11 x| f o7 =]

Qutput Folder

Period --- The reporting period.
Start : Start Date
End : End Date

Output folder --- Output folder

X

The Log Report will create in the output folder when OK button is
pressed. The folder contains individual Log Report of each

Cancel

o]

]

projector separately. The individual log life is provided as csv
format with projector name (“projector name.csv”)

The format of Log Report is shown below.

Projector Name: Projector 1
Model: CP-X265

Period: 2008/04/01 - 2008/04/30
Use Information
2008/04/01,5,5,145,145,0
2008/04/02,3,3,148,148,1
20.08/04/30,1 ,1,193,193,0

Error Information

[Date], [Time], [Error Info]
2008/04/02,17:43:36,Disconnect

Connection: 192.168.1.10:23 (00-00-87-16-2c-ae)

[Date],[Power On Count],[Power Off Count],[Lamp Time],[Filter Time],[Error Count]

ltem Description Note
Projector Name Projector name
Model Model name
Connection Connection type Serial (RS232C):

COM Port number

Network:

IP Address:Portnumber (MAC address)
Period Log data period yyyy/mm/dd
Use Information Usage information

Date

Date

yyyy/mm/dd

Power On Count

Sum of power status change from OFF
to ON

Power Off Count Sum of power status change from ON

to OFF
Lamp Time Lamp hours The lamp hours when the report is generated.
Filter Time Filter hours The filter hours when the report is generated.

Error Count

Sum of Error / Warnings

Error Information

Error Information

Date Date of Error yyyy/mm/dd
Time Time of Error hh:nn:ss
Error Info Error type
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8 Create Status Report

You can create the status report as HTML format. The report shows a current snapshot of projector status in a
particular group, searched group or groups. In order to show the status report, select the group or projector. And

then go to [File] > [Output Report] from the menu. The status report will be shown in the web browser.
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The status report will be given by group as shown below.
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